Managing Your Business with Outlook® 2003

Develop sales strategies, marketing plans, and telemarketing techniques

A Reference for the Rest of Us!

FREE eTips at dummies.com

Marcelo Thalenberg
Microsoft® Outlook consultant and trainer
Managing Your Business with Outlook® 2003
FOR DUMMIES®
About the Author

Marcelo Thalenberg is an entrepreneur in the technology industry. During the last decade, two of his startups included what today is the Avnet branch in Brazil (a components distributor) and B. I. Tecnologia, a computer telephony integrator that introduced new hardware and software developments into Latin America. Today, Marcelo is a consultant focusing on behavior and technology.

Just as cars were a new technology in the beginning of the 20th century without the benefit of traffic rules or drivers licenses, Marcelo believes that e-mail and instant messaging traffic are driving people crazy — yet almost nobody learns how to deal with them. With very little training, you find out how to shrink the number of messages you deal with and to eliminate many before anyone even writes them. When you analyze the messages you receive and classify them by behavior, you notice why people are sending you messages and why most of the messages arriving in your Inbox are unwanted. In this book, Marcelo applies his work with behavior styles to Outlook to help his readers take control of their office environments and their e-mail Inboxes.

Marcelo writes articles about technology and behavior as applied to different segments of business, such as sales, marketing, and working women. In 2002, he wrote a book about time management with Outlook in Portuguese, called Socorro roubaram meu tempo (Help, Who Has Stolen My Time), published by Editora Érica.
Author’s Acknowledgments

Since the end of last century, I intended to write a book about my entrepreneur experience. It turns out that this book is part of my experience in driving hundreds of small daily problems into solutions. I’d like to thank all my former coworkers, partners, and students for their part in developing this knowledge with me. My special thanks goes to Christopher Van Buren for helping me with so many good questions during his editing of the early drafts. Thanks to Helio Fittipaldi, the editor of Saber Eletronica magazine, who introduced me to my literary agent: Waterside Productions, Inc. and David Fugate. Thanks also go to Greg Croy, for the book title, and to Greg, Kelly Ewing, and Kezia Endsley at Wiley for their support in making this book useful to every reader.
Publisher’s Acknowledgments

We’re proud of this book; please send us your comments through our online registration form located at www.dummies.com/register/.

Some of the people who helped bring this book to market include the following:

**Acquisitions, Editorial, and Media Development**

*Project Editor:* Kelly Ewing  
*Acquisitions Editor:* Greg Croy  
*Copy Editor:* Kezia Endsley  
*Technical Editor:* Michael Zulich  
*Editorial Manager:* Jodi Jensen  
*Media Development Coordinator:* Laura Atkinson  
*Media Project Supervisor:* Laura Moss  
*Media Development Manager:* Laura VanWinkle  
*Editorial Assistant:* Amanda Foxworth  
*Cartoons:* Rich Tennant  
(www.the5thwave.com)

**Composition Services**

*Project Coordinator:* Bill Ramsey  
*Layout and Graphics:* Carl Byers, Andrea Dahl, Mary J. Gillot, Denny Hager, Stephanie D. Jumper, Barbara Moore, Lynsey Osborn  
*Proofreaders:* Jessica Kramer, TECHBOOKS Production Services  
*Indexer:* TECHBOOKS Production Services

---

**Publishing and Editorial for Technology Dummies**

*Richard Swadley,* Vice President and Executive Group Publisher  
*Andy Cummings,* Vice President and Publisher  
*Mary Bednarek,* Executive Acquisitions Director  
*Mary C. Corder,* Editorial Director

**Publishing for Consumer Dummies**

*Diane Graves Steele,* Vice President and Publisher  
*Joyce Pepple,* Acquisitions Director

**Composition Services**

*Gerry Fahey,* Vice President of Production Services  
*Debbie Stailey,* Director of Composition Services
## Contents at a Glance

### Introduction ................................................................. 1

### Part I: Managing Any Business .............................................. 5

- Chapter 1: Changing Your Outlook on Managing Business .................. 7
- Chapter 2: Organizing Yourself with Outlook ........................................ 15
- Chapter 3: Automating with Outlook .................................................... 33

### Part II: Managing Contact Information ..................................... 45

- Chapter 4: Creating an Awesome Customers and Suppliers Database .......... 47
- Chapter 5: Building Customer Profiles with Forms .................................... 69
- Chapter 6: Kicking It Up a Notch with the Business Contact Manager .......... 81
- Chapter 7: Working with BCM Reports .................................................... 99

### Part III: Handling Communication and Collaboration ......................... 119

- Chapter 8: Surfing Over the E-mail High Tide ........................................ 121
- Chapter 9: Managing E-Mail Cleanup ...................................................... 135
- Chapter 10: Facilitating Teamwork ......................................................... 143
- Chapter 11: Applying Teamwork .............................................................. 161
- Chapter 12: Shrinking the Meeting Time .................................................. 175
- Chapter 13: Working with Outlook on the Road ........................................ 191

### Part IV: Controlling Business Processes ...................................... 203

- Chapter 14: Tracking Sales Activities ....................................................... 205
- Chapter 15: Planning, Prospecting, and Visiting Customers ......................... 223
- Chapter 16: Minding Your Marketing Methods .......................................... 237

### Part V: The Part of Tens .......................................................... 257

- Chapter 17: Ten Tips for Keeping Time on Your Side ................................. 259
- Chapter 18: Ten Sales and Marketing Tips ................................................ 267
- Chapter 19: Ten Technical Tips for Safeguarding and Mobility ..................... 275
Part VI: Appendixes ................................................................. 283
Appendix A: Calendar Basics ............................................................. 285
Appendix B: Tasks Basics ................................................................. 293
Appendix C: Contact Basics .............................................................. 299
Appendix D: Journal Basics ............................................................ 309
Appendix E: Shifting from Outlook Express to Outlook 2003 .......... 315

Index ....................................................................................... 319
# Table of Contents

**Introduction** .................................................................................. 1  
  - About This Book ........................................................................... 1  
  - Foolish Assumptions ..................................................................... 2  
  - How This Book Is Organized ......................................................... 2  
    - Part I: Managing Any Business .................................................... 2  
    - Part II: Managing Contact Information ....................................... 2  
    - Part III: Handling Communication and Collaboration ............... 3  
    - Part IV: Controlling Business Processes ................................... 3  
    - Part V: The Part of Tens ............................................................. 3  
    - Part VI: Appendixes .................................................................. 3  
  - Conventions Used in This Book ................................................... 4  
  - Icons Used in This Book ............................................................... 4  
  - Where to Go from Here ................................................................. 4

**Part I: Managing Any Business .................................................... 5**

**Chapter 1: Changing Your Outlook on Managing Business ........ 7**
  - Going Above and Beyond with Outlook ....................................... 7  
  - Looking Out for All Parts of Your Business .................................. 9  
    - Customers .................................................................................. 9  
    - Marketing and sales .................................................................. 10  
    - Innovation ................................................................................ 10  
    - Business goals and objectives .................................................. 11  
    - Customer contact and education .............................................. 12  
    - Sales and fulfillment activities .................................................. 12  
    - Procurement ............................................................................ 12  
    - Financial and organizational control ....................................... 12  
  - Making Outlook Your Control Panel .......................................... 13  
    - Planning your goals and activities ............................................ 13  
    - Downloading your memory ..................................................... 14

**Chapter 2: Organizing Yourself with Outlook ......................... 15**
  - Planning Your Day with Outlook’s Today Options ....................... 15  
  - Customizing Outlook Today ....................................................... 16  
  - Working with Dates in Your Calendar ....................................... 17  
  - Organizing Your Priorities with Your Tasks List ......................... 21  
    - Yikes, what should I do first? ................................................... 22  
    - Knowing what’s urgent versus what’s important ....................... 22  
    - Scheduling a Task ................................................................... 23  
    - Estimating your completion time ............................................. 24  
    - Viewing all your fields in the same list .................................... 25
**Chapter 6: Kicking It Up a Notch with the Business Contact Manager** .................................................. 81

- Introducing BCM ................................................................. 83
- Getting Information into BCM ............................................ 84
  - Entering Account information ......................................... 85
  - Entering the Business Contact information ....................... 88
- Tracking Business Opportunities ........................................... 90
- Listing Your Products and Services ....................................... 92
  - Importing an existing list .................................................. 93
  - Linking your proposal ....................................................... 95
- Overcoming BCM Limitations .................................................. 96

**Chapter 7: Working with BCM Reports** ................................................. 99

- Getting Familiar with Your Report Options .......................... 99
  - Accounts reports ............................................................... 100
  - Business Contacts reports .............................................. 102
  - Other reports .................................................................. 104
  - Opportunities reports .................................................... 105
- Squeezing the Report to Get Action Information .................... 107
- Filtering the Opportunities Reports ...................................... 109
- Using Views Rather than Reports ....................................... 110
  - Using the Opportunity By Funnel report ......................... 110
  - Refining your views ........................................................ 111
- Working with BCM Reports in Excel .................................... 115
  - Saving reports as Excel files ............................................. 115
  - Designing BCM charts with Excel ................................... 115

**Part III: Handling Communication and Collaboration** ................................................................. 119

**Chapter 8: Surfing Over the E-mail High Tide** .................................................. 121

- Understanding Why People Send Messages
  - (And How to Respond to Them) ......................................... 121
  - Separating the wheat from the chaff .................................. 122
  - Dealing with unwanted e-mails ........................................ 122
  - Classifying wanted messages .......................................... 125
- Introducing Outlook Rules ................................................... 125
  - Beginning to organize your e-mails .................................. 126
  - Using rules to eliminate e-mails ....................................... 127
  - Attaching previous messages .......................................... 131
- The Zen of Inbox Management ............................................. 132
- The Art of Sending Messages .............................................. 133
Chapter 9: Managing E-Mail Cleanup ................................. 135
   Eliminating Trash ................................................................. 135
   Filing valuable information ................................................. 135
   Stomping out junk e-mail, the computer plague ................. 136
   Helping you out: The e-nanny ............................................... 138
   Maintaining with the e-office cleaner ................................. 138
   Avoiding Fraud: Never Send Personal Data by E-Mail .......... 140

Chapter 10: Facilitating Teamwork ................................. 143
   Maintaining Team Commitment ........................................... 143
   Using E-Mail Tips to Promote the Calendar ....................... 145
   Sharing Your Work with the SharePoint Server .................. 147
   Taking Advantage of Outlook Collaborative Tools .............. 151
      The agreement game (Tasks) ........................................... 151
      Supervising ................................................................. 154
      Delegating ..................................................................... 156
      The goal is sharing ....................................................... 157

Chapter 11: Applying Teamwork ................................. 161
   Creating a Uniform Customers and Suppliers List ............ 161
   Following Up on Requests ................................................. 163
      Flagging ....................................................................... 163
      The e-mail confirmation request .................................... 165
   Conducting Surveys .......................................................... 165
   Organizing Customer Support ........................................... 168
   Controlling Projects .......................................................... 169
   Working with your Team's Calendars ................................. 171
   Leading Your Team ............................................................ 173
   Requesting and Planning a Vacation .................................. 174

Chapter 12: Shrinking the Meeting Time ................................. 175
   Identifying Meeting Cultures ............................................. 176
   Taking Advantage of Categories ........................................ 176
   Planning Productive Meetings .......................................... 178
      Preparing for meetings .................................................. 178
      Developing a meeting checklist ..................................... 179
   Scheduling Meetings .......................................................... 179
      Checking available time with the Free/Busy option .......... 182
      Finalizing the invitation time ........................................ 183
      Getting the confirmation list ........................................... 184
   Reserving Resources .......................................................... 185
   Managing Time through Agendas and Minutes ................. 186
   Conducting Video and Web Conferences ......................... 189
Chapter 13: Working with Outlook on the Road ................. 191
   Developing a Travel Checklist .................................................. 191
   Using Cell Phones Abroad .......................................................... 193
   Technology Works Almost Anywhere ........................................... 193
      Opening your file from a memory card or CD-ROM ............... 193
      Connecting through Outlook Web Access (OWA) .................. 194
      Connecting through Outlook Mobile Access (OMA) .............. 195
   Remembering Expiration Dates .................................................. 196
   Coordinating Time Zones .......................................................... 197
   Finding You Anywhere Easily .................................................... 199
   Keeping in Contact with Your Family ......................................... 199
      Publishing your agenda on the family home computer .......... 200
      Publishing your agenda online .......................................... 201
      Giving access to your Calendar folder .................................. 201
   Adding Foreign Holidays to Outlook .......................................... 202

Part IV: Controlling Business Processes ......................... 203

Chapter 14: Tracking Sales Activities .............................. 205
   Keeping a Client ........................................................................ 205
      Scheduling customer contact frequency ................................ 207
      Flagging a contact ................................................................. 208
      Tracking your customer history .......................................... 211
   Creating Sales Targets .............................................................. 213
   Analyzing Quotes to Help Close Orders .................................... 215
   Classifying Messages ................................................................. 216
      Coloring messages ................................................................. 216
      Selecting arriving messages by subject ................................ 218
      Receiving Outlook messages on your cell phone ................. 221

Chapter 15: Planning, Prospecting, and Visiting Customers .... 223
   Loading a New Customer Profile ............................................... 223
   Mapping Your Client’s Location ............................................... 225
   Working on a Customer’s Request ............................................. 226
      Requesting internal support ............................................... 227
      Sending a proposal ............................................................... 228
      Following up on the proposal .............................................. 229
      Recording and reading the entire customer history ............... 230
   Using BCM to Prospect a New Customer ................................. 231
      Recording customer information ........................................... 231
      Linking appointments ......................................................... 231
      Working on a customer’s request by using BCM .................... 232
Assigning internal support ................................................................. 233
Updating the opportunity ................................................................. 234
Following up on the proposal by using BCM ............................. 234

Chapter 16: Minding Your Marketing Methods  ..................... 237

Know Your Audience .................................................................. 237
Direct-Mail Marketing ................................................................. 238
  Planning direct mail ................................................................. 238
  Printing direct mail ................................................................. 241
  Labeling the mailing .............................................................. 245
  Selecting customers by using filters ..................................... 248
E-Mailing Marketing .................................................................. 249
Planning Events ......................................................................... 250
  Thinking about the event’s content ........................................ 250
  Convincing the customers to come ...................................... 252
  Mingling during the event ...................................................... 253
  Following up the next day ...................................................... 253
Ensuring Telemarketing Success .............................................. 253
  Telemarketing forms ............................................................. 254
  Creating a view title ............................................................... 254
  Adding a script to your telemarketing operation .................. 255
  Telemarketing reports ............................................................ 256

Part V: The Part of Tens ............................................................... 257

Chapter 17: Ten Tips for Keeping Time on Your Side .............. 259

Self-Imposed Time Commitments .............................................. 259
  Starting your day ................................................................. 260
  Focusing on the current activity .......................................... 260
  Recording your goals as tasks with reminders .................... 260
  Taking a break ................................................................... 261
  Avoiding high anxiety (or “I don’t work
  in the emergency room” syndrome) ................................... 261
Boss-Imposed Time Commitments ............................................ 261
  Shrinking supervision time ..................................................... 261
  Delegating .......................................................................... 262
  Sharing your Tasks list and your Calendar ......................... 262
Time Commitments Imposed by the System ......................... 263
  Turn off the interruption killer ............................................. 263
  Streamline technical support ............................................... 264

Chapter 18: Ten Sales and Marketing Tips ................................. 267

Understand Your Customer’s Vision First ............................... 268
Track Opportunities with Tasks ............................................... 268
Keep Tabs on Your Customers .................................................. 268
<table>
<thead>
<tr>
<th>Chapter 19: Ten Technical Tips for Safeguarding and Mobility</th>
<th>275</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receive Reminders via Your Cell Phone</td>
<td>275</td>
</tr>
<tr>
<td>Synchronize Your Reminders Anywhere</td>
<td>276</td>
</tr>
<tr>
<td>Protect Your Data</td>
<td>276</td>
</tr>
<tr>
<td>Protect Your Cell Phone Contacts</td>
<td>277</td>
</tr>
<tr>
<td>Use Training as a Protection Tool</td>
<td>277</td>
</tr>
<tr>
<td>Avoid Mail Before Writing It</td>
<td>278</td>
</tr>
<tr>
<td>Increase Your Password Security</td>
<td>278</td>
</tr>
<tr>
<td>Recover a Permanently Deleted Item</td>
<td>278</td>
</tr>
<tr>
<td>Create a Message with Restricted Reading Permission</td>
<td>279</td>
</tr>
<tr>
<td>Protect the Addressee’s Mail Address</td>
<td>281</td>
</tr>
</tbody>
</table>

**Part VI: Appendixes** ................................................................. 283

**Appendix A: Calendar Basics** .................................................... 285

- Creating an Appointment Entry .................................................. 285
- Setting Up a Recurring Appointment ............................................ 287
- Collaborating on Time Commitments ... ....................................... 288
  - Free/Busy scheduling ............................................................. 288
  - Meeting invitations ............................................................. 289
  - Meeting commitment ............................................................ 290
  - Sharing Calendars .................................................................. 290
  - Viewing the Calendar ............................................................ 291

**Appendix B: Tasks Basics** ............................................................ 293

- Creating a New Task ................................................................. 293
- Viewing the Tasks List ............................................................. 295
- Requesting and Supervising Tasks .............................................. 296
  - Requesting and confirming tasks ........................................... 296
  - Accepting or declining tasks .................................................. 297
  - Supervising a task ............................................................... 298
  - Sharing your tasks ............................................................... 298

**Appendix C: Contact Basics** ........................................................ 299

- Exploring a Contact ................................................................. 299
  - Exploring the Details page ...................................................... 302
  - Exploring the Activities page ................................................. 302
Managing Your Business with Outlook 2003 For Dummies

Automating Actions .................................................................303
Flagging for follow-up..........................................................303
Displaying maps ..................................................................304
Sending e-mails ....................................................................304
Autodialing phone calls .......................................................304
More automation actions ......................................................305
Using a vCard as your message signature .........................305

Appendix D: Journal Basics ..................................................309
Introducing the Journal .......................................................309
Creating a Contact History ..................................................310
Linking items to a contact manually .................................310
Retrieving the linked information ......................................311
Linking Items Automatically ..............................................312
Retrieving Journals ..............................................................313
Viewing the Journal list by contact .................................313
Using the Journal views ......................................................314

Appendix E: Shifting from Outlook Express to Outlook 2003 ....315
Moving from Outlook Express to Outlook 2003 ..................315
Importing Internet Mail account settings ..........................316
Importing mail folders and other data ...............................316
Changing your default mail system .................................317
Copying Outlook Express Data from Another PC ............318

Index ..................................................................................319
Introduction

At the risk of seeming like Charles Dickens’s Ebenezer Scrooge, I must say that software can be expensive when you don’t know how to get results with it. Likewise, it can be a real bargain regardless of cost if it solves an important problem. In the past, I wasn’t getting the most of Microsoft Outlook because the software instructions and the available literature taught me how to use the product rather than how to solve my problems with it.

When I analyzed my business procedures and other people’s behavior, I had one question: “How can I use Outlook to solve my business and productivity problems?” To ensure that weekly reports were always delivered on time, I asked each salesperson to open a recurrent task with a reminder set for the day before the reports were due. The reports started to arrive on time. After creating a workshop checklist, the procedures — using Outlook Contacts — became fast and easy. The receptionist started creating invitations during downtime. This book is the result of my practical experience while building hundreds of applications and training and developing procedures. You paid for Outlook; you can now increase your productivity by using Outlook more efficiently.

About This Book

In this book, I show you how to organize yourself, your team, and your business by creating procedures for goals control, communication through e-mail, sales control, marketing activities, tasks, and information sharing. You discover how to use Outlook to help you change attitudes and achieve balance in your life.

How can software solve attitude problems, you ask? Well, using the Reminder feature can help employees remember to deliver a task on time. Sharing a task folder with your boss paves the way to negotiating the tasks you should do first. Using e-mail rules to filter out and expose behaviors helps to eliminate unnecessary messages before they’re even written. All these actions can reduce your anxiety and improve your attitude toward your goals.
Foolish Assumptions

During the course of this book, I assume that you know how to turn your computer on, get around in Windows, create a simple a letter with Word, and use Outlook Express to send and receive e-mail. I also assume that you want to increase your personal productivity by using Outlook features you may not have used or seen, in order to improve your daily work or life. If you need an Outlook book only, I suggest reading *Outlook 2003 For Dummies* (Wiley Publishing, Inc.) by Bill Dyszel.

How This Book Is Organized

This book is organized into six parts. The chapters within each part cover specific topics in detail. You can read each chapter without having to read the chapters before it, which is helpful if you have better things to do with your time. You can even just read sections within a chapter without reading the entire chapter. I may occasionally refer you to somewhere else in the book for more detail or background information on a particular subject.

Each part covers a major area of managing your business by using Outlook. The following sections summarize what you find in each part:

Part I: Managing Any Business

Managing a business includes simple things that make it successful, not including the sales and financial aspects. Businesses of all kinds share common issues revolving around employee relations, planning, and training. But before you organize your business, you have to organize yourself. Remembering to accomplish your tasks by their deadlines, arriving at meetings on time, supervising your team, and defining and achieving your goals are all areas in which Outlook can help you get organized.

Part II: Managing Contact Information

Some people think that all you need to know about a customer is a name, phone number, and e-mail address. The Outlook Contacts list allows you to fill in the most complete contact record ever imagined. These records can become your customer profiles. You can easily customize Outlook forms and contacts according to your business needs.

In addition, the Business Contact Manager (BCM) is a free add-in that comes with the Office Small Business and Professional edition. BCM includes Account
and Business Contact forms designed to control your sales and marketing activities. You can use BCM without any customization. Version 2.0 allows you to share the same customer base among your team members and custom create reports and lists.

**Part III: Handling Communication and Collaboration**

Are you tired of receiving so many joke messages? The Zen of Inbox Management shows you how to change your Inbox parking lot into a tollgate. The e-nanny helps you organize your Inbox fast, and the e-office cleaner helps you automate a daily deep-cleaning routine. Avoiding fraud and junk mail is not only a matter of building a firewall, but also involves becoming wise.

Collaborative work becomes smooth when everybody uses the Calendar’s invitation feature and task requests. Sharing the Calendar and Tasks list helps the team work with fewer interruptions. You can also easily shorten meeting setup time, without additional e-mail and phone calls, when your team uses the Calendar and you check the Next Available Time in the team’s schedule. Other tips in this part can change your concept of meeting planning and traveling and working externally.

**Part IV: Controlling Business Processes**

In this part, you find out how to create a telemarketing campaign, including how to configure the Contacts list for automatic dialing. You also discover how to refine your customer list by using filters and create direct-mail campaigns with a handy direct-mail checklist. In addition, you use Outlook’s mapping and Journal features.

**Part V: The Part of Tens**

Here, you find tips for increasing your free time and managing your sales and marketing activities. You also find ways to streamline and safeguard your data.

**Part VI: Appendixes**

Because this book explains how to configure Outlook specifically for business purposes, it includes instructions for using the Calendar, Tasks list, Contacts list, and the Journal. Appendix E even shows you how to move from Outlook Express to Outlook 2003.
Conventions Used in This Book

This book is intended for Windows and Office users. Whenever I want you to choose a sequence of commands from the pull-down menus at the top of a program, I use the phrasing, “Choose File➪Save.”

Icons Used in This Book

Throughout the margins of this book, you see little pictures that highlight text you’ll want to pay special attention to:

This icon flags helpful information to make things easier for you.

This icon draws your attention to common problems and common mistakes that may require technical support.

This icon highlights important details you won’t want to forget.

This icon marks advanced information that you may want to skip or ask a techie guru to help you with.

Where to Go from Here

If you’re an experienced Outlook user, you can just jump straight into the application you need. If you’re a newcomer to Outlook, you can start reading the basics in the Appendixes. If you work in sales or marketing, try Chapter 4 before going to Chapters 14, 15, and 16. Enjoy the book in whatever order you need it and increase your productivity!
Part I
Managing Any Business

The 5th Wave
By Rich Tennant

“It's your wife, Mr. Dinker. Shall I have her take a seat in the closet, or do you want to schedule a meeting in the kitchen for later this afternoon?”
In this part . . .

What’s the first thing you think of when you hear the word business? For many people, the first thing that comes to mind is money, gained from the practice of buying and selling goods and services. But what about a nonprofit organization, a church, or even your family? Are these businesses that deserve attention and goals? Of course, they are.

Running any business — whether you’re a fortune teller, a work-at-home consultant, a financial or insurance advisor, a personal trainer, or even a corporation — is about one main objective: serving the customer’s needs by people motivated to do so. In this part, I show you how to use Outlook so that you don’t feel like you’re drowning in millions of tasks. I also show you how to choose the key issues on which to focus and how to download your brain and organize your issues so that you can hit your goals one by one.
Managing any business is about doing your job better, not harder. It’s about mastering your business, not being a slave to it. That’s where Outlook comes in. You can write down and achieve your goals with Outlook. You can create simple and effective solutions to your daily problems.

Businesses of all kinds share common issues revolving around employee relations, planning, and training. Using Outlook as a dashboard or control panel, you can improve the way you confront and manage these issues. With Outlook, you can shrink unnecessary demands and even downsize your anxiety and preoccupation to a realistic level, thus balancing your business and your life.

In this chapter, I cover what you need to know to organize and keep track of your goals.

Going Above and Beyond with Outlook

Outlook can increase your productivity by helping you control your objectives, actions, tasks, time commitments, and team workflow. Other Enterprise Resource Planning (ERP) systems — computer software that help you manage
your business — typically only include accounting, invoicing, financial management, and inventory control and don’t delve into organizing personal activities, team relationships, or communications skills. ERP systems range from inexpensive and effective tools like Peachtree to multimillion-dollar corporate systems, such as SAP or Oracle. Some of the things that Outlook can do for you include the following:

✔ The Calendar’s collaborative tools can increase your company’s productivity by providing tools for working in teams. Teams can share commitments, schedule activities in unison, and track participation. Read more in Chapter 10.

✔ You can assign tasks to increase commitments and reduce quarrels by allowing people to accept and respond to automated task requests via e-mail. (See Chapter 10.)

✔ The Tasks list helps you organize all your pending actions and select list them by priority or due date. Read more in Chapter 2.

✔ The Recurrence tool can remind you again and again of anything you need as often as you need it. For example, you can set reminders for weekly reports, monthly payments, or daily tasks. Read more in Chapter 2.

✔ The Contacts list lets you record any information about your relationships and even create a customer profile. Read more in Chapter 4.

✔ The Outlook automation works to save you time when you make your phone calls, send faxes, or organize and clean your messages. Read more in Chapter 3.

✔ You can use e-mail rules to surf over the e-mail tides, eliminating unwanted e-mails and automatically filing e-mails in the right folder for you. Read more in Chapter 8.

✔ Mail merge between Contacts list and Word can turn any campaign from impersonal to very personal form letters to electronic messages. Read more in Chapter 16.

✔ Dialup properties, used with the Contacts list, allow you to customize your own telemarketing center and increase the productivity of your campaigns. Read more in Chapter 16.

✔ The Business Communication Manager (BCM), a free add-in for Office Small Business and Professional versions, allows you to control your customers’ and prospects’ activities from the first point of contact to the close of a deal. Read more in Chapters 7 and 8.

✔ Customizing forms to suit your business can improve your company’s workflow. Chapter 5 explains how to customize and create forms.
The most powerful Outlook tool is the on-screen reminder. The alarm produces on-screen messages, which reminds you to take action. Whether it’s reaching your quarterly business forecast or simply reminding you, year after year, to order your spouse an anniversary gift, this feature makes life much more manageable.

Looking Out for All Parts of Your Business

The purpose of business is to create and keep customers. Without customers, there is no business. But without profit to recover your investment and pay expenses, no business can survive. Marketing, sales, and financial control are all key issues, but you also need to innovate — not only in the product or service but also in the general procedures of your business. Outlook is an additional tool for your current sales and accounting systems that can help you achieve your goals and objectives with innovative solutions.

Customers

No business exists without customers, and you create customers through relationships. Therefore, relationships are perhaps the most important part of any business. Unfortunately, companies all too often think about their products or services, but forget how to develop customer relationships or understand and solve their customers’ problems.

You can develop your customer relationships one by one if your business allows you to do so. But people in businesses that have thousands of customers who don’t require daily attention often forget that they can still develop relationships with their customers. They can take actions and communicate with customers in groups. Outlook categories allow you to group your customers for various needs. (Read more about categories in Chapter 4.)

Businesses that work with customers in large groups, such as credit-card companies, newspapers, and the phone company, know customer addresses and names. You may have the intelligence to sell mass products, but the customers are still just names in your databases. While you have an understanding about what it takes to work with groups of people, rather than single individuals, you still don’t know your customers’ wishes or desires to fulfill one by one. You can use Outlook Categories to classify your customer base and work by company type, territory, or vertical markets (see Chapter 4).
Likewise, businesses that work with individual customers must develop a personal and continuous relationship. In order to understand their wishes and desires, you must know these people well and understand their preferences, tastes, and moods. You may forget or neglect information written in a notepad or stored in your head. Outlook contacts can help you collect, record, and organize any information about your customers. Recording customer wishes can be a good way to improve your product or service and increase your customer satisfaction. Customer care and attention is the successful key to any personal business relationship (see Chapter 4).

Do you want to send a compliment to your customers when their baseball or basketball team wins a game? Just select your contact by team and send them an e-mail. Classify them by importance, like Platinum, Gold, and Silver, and set up the reminder to touch base twice a week or once a month. Read more in Chapter 14.

**Marketing and sales**

*Marketing* is the strategies, tactics, and activities involved in getting your message to intended target markets. The focus is usually on selling or facilitating the introduction of a product or service. Can you send, in a few clicks, a Happy New Year card to your customer base? With your customer base updated with Outlook Contacts, not only can you send a card, but you can also group customers by categories and take different actions for each group. You can even design a telemarketing program that includes automatic dialup from your PC. Chapter 16 explains the use of checklists for marketing programs, events, and communications.

When it comes to the sales side of things, “Hey, where is my order?” is an oft-dreaded follow-up question for many salespeople. If the customer has to ask this question, it can create an unpleasant feeling in the customer or even cause him to send his order to a competitor. The successful salesman focuses not on the customer but on what the customer is looking at and makes that the common starting point for building a relationship. Not only can Outlook help you get to know your customers and their goals better, but it can also help you take the proper actions on time. For more on what to do when, see Chapter 14.

**Innovation**

Innovation is not only about new products or services. It’s also about improving the way you work — better, easier, faster. It’s even about shrinking your costs. Using Outlook, you can increase your productivity with less stress by using the applications explained throughout this book.
If your entire team uses Outlook’s collaborative tools and reminders, your company can be more productive, and you can build a stronger and closer team. Collaborative tools and reminders can improve the way you work in several key areas:

**Personnel and productivity:** Using Outlook Tasks and Calendars can increase your staff’s productivity. Sending Tasks or Invitations can help decrease internal quarrels and solidify commitments. For more on facilitating teamwork, see Chapter 10.

**Financial and material resources:** You may think that an ERP would take care of the whole business, and if you’re concerned with only the financial numbers, you’re probably correct. But Outlook can help eliminate those painful phone calls asking for forgotten payments. It can also help you avoid sending your own collection notices to your customers. The Reminders alarm prompts you to take the right action, on time, and avoid disorganization and unwanted phone calls. For more on minding these important details, see Chapter 17.

**Profit:** The result of improving relationships with your customers and teams with Outlook will be increased productivity by a stressfree team of professionals.

**Business goals and objectives**

Management by objective works — if you know the objectives. What is your business objective in five years? Write the objective and steps to achieve your goal, even if you’re not sure about them. Write them in an Outlook Tasks because you may forget about a piece of paper in your drawer. Turn on the task alarm to pop up in your face as scheduled, check the steps completed, and then start the next ones. Did you change your goals? Rewrite them. No matter what kind of objective you want to achieve, the Outlook Tasks feature is ready to accept any goal, like doubling your company income in five years, closing the best order of the week, planning for a baby, receiving your master’s degree or Ph.D., increasing your customer base, moving to a new house, moving your office, changing your profession, receiving a deserved promotion, launching a new product, losing weight, winning the Olympic games, taking your next vacation . . . whatever you want!

Writing your objectives for next month, next year, or for the next five years is the path to accomplishing them. Outlook Tasks reminds you of key steps along the way and gives you the chance to adjust according to your priorities (see Chapter 2).
Customer contact and education

Outlook Contacts is more than a telephone black book; it’s an information center to track your relationships and activities. You can attach related documents to the Contact record for easy access, record recent phone call highlights, create anniversary reminders, store personal information about clients, and even build an active telemarketing application. It also has 18 one-click actions, including dialing the phone for you, to save you time. For more information on working with contacts, see Chapter 4.

Sales and fulfillment activities

Analyzing lost orders can, for many companies, reveal where follow-up has been neglected. When calls come into the inside sales department or when outside salespeople come back to the office, they often don’t record a customer’s pending issues. Later, when the order comes in, the issues may be overlooked. Salespeople aren’t paid merely to send quotations to customers but also to follow up on their needs and to understand what’s required to get a customer to commit and the deal closed. But salespeople often get bogged down under the flow of everyday activities and lose their focus on the customer, which reduces the number of incoming orders. Opening a Task for each pending quotation and setting pop-up Reminders for next actions can help keep salespeople on track. You can use Reminders for an internal request or just to touch base with customers. For more on tracking sales activities, see Chapter 14.

Procurement

Procurement for office supplies is easy. You can order through the Internet or catalogs or simply go to a store or a supplier’s warehouse. But besides these simple orders, how do you control a step-by-step order from an international supplier? How do you control a project being developed by a new supplier? Outlook Tasks can help remind you to place a new order, even if you’re working in a corporation with tracking software. Tasks can help you track special projects or actions. Associating the appropriate contacts for each action, you can easily call or send an e-mail while you’re working with the task on-screen.

Financial and organizational control

Mailing a check is a task often put off or delayed by something else, causing the unpleasant “Hi, did you send the check?” phone call. You can remember to make monthly payments by using recurring reminders.
Making Outlook Your Control Panel

The huge amount of information you receive, process, and store in your brains nowadays increases stress levels and slows you down like a computer with the hard drive full. Everyone was taught since kindergarten to retain information because information is unchangeable. That’s no longer compatible with today’s paradigm: that knowledge evolves . . . and quickly. You need to discover how to critique, select, and filter information before it even occupies your brain. To be productive, you need to filter and select valued information to help you achieve your goals. Without some training, most people find it difficult to keep up with the information avalanche and end up trapped beneath it. Understand the problem and start using Outlook to organize the incoming information flow according to your priorities, thus increasing your quality of life.

Making Outlook your control panel means managing your time and tasks by writing or downloading your information and organizing it by priorities, thus achieving your goals (see Chapter 2 for details).

Downloading your memory

Don’t tie a string around your finger or place a sticky note on your PC screen anymore. Instead, tell Outlook to remind you. Are you leaving the Office? Print the reminders list or synchronize it with your cell phone or PDA.

Many people wake up daily and inhale their breakfast because they don’t have time to sit down and eat it, and they’re always late. An ambulance driver doesn’t drive 24 hours a day, 7 days a week. He has to rest. So why are people running around as if they were working in an emergency room? Anxiety, stress, and lack of priorities are the roots of this kind of behavior. Downloading your memory into an agenda or daily planner doesn’t remind you of your commitments unless you open and read it. Outlook allows you to turn off your ambulance-driver behavior so that you can achieve your commitments and priorities. You can set up pop-up alarms and reminders for events, deadlines, meetings, or anything at all.

Time commitments and to-do commitments aren’t the same thing. You can adjust to-do commitments according the due date and your priorities, but time commitments aren’t so easy to change.

**Time commitments:** The 5 p.m. tea at Shelley’s house begins at 5 p.m. sharp, so don’t be late. Any planned arrangement at a specific time is a commitment. You can use the Calendar to schedule your arrival and leaving time. For more on scheduling, see Chapter 12.
To-do commitments: It’s Monday, and you need to send a sales proposal Friday. You have more than four days to choose when to write the proposal. You can write when and where you want according to your priorities. Simply write each new job on the Tasks list and adjust the Reminder to pop up according to your will.

Planning your goals and activities

Archimedes taught us his physics principle over 2,000 years ago: No two objects can occupy the same space at the same time. By analogy: No two commitments can be done at the same time by the same person. So how do you prioritize your commitments and accomplish them all? If you have your list ready, you have many ways to choose which comes first:

Choose fun first: If you like it, you tend to do it first. Often, the unpleasant tasks are the ones that you tend to put off and you start them only when you receive complaints.

Process by incoming dates: Prioritize by doing the first task in, first task out, also known as FIFO (first in, first out). However, if a priority change occurs, this system doesn’t work.

Prioritize by due dates: Adjust a task list according to the delivery date.

Handle by importance: Look at your most important goals first. Which is the most important job? Start doing it.

Choose important versus urgent tasks: Downloading all your tasks and time commitments and setting the Reminder alarm with no planning can cause conflicts. You may end up having to “Be at the board meeting” and “Deliver a proposal for your Gold customer” at the same time. To avoid this type of conflict, you need to understand how to distinguish important from urgent tasks. Important is what brings results. Urgent is the pressure for something to get done.

For more on managing your Tasks, see Chapter 2.
Chapter 2

Organizing Yourself with Outlook

In This Chapter
- Scheduling your day with the Calendar
- Prioritizing your to-do list
- Organizing Tasks and e-mail

Every single day, information and action items come flooding into your office by the hundreds. They occupy your mind and even cause you to lose track of your priorities and waste time on things that aren’t important. How do you release your mind and organize yourself to focus on what’s important to your work and personal life? How do you arrange your time so that you can enjoy working, maximize free time, attend sporting events, see rock concerts or the symphony, or sneak out of town on a short getaway?

Organizing information, time commitments, and actions helps you to pace your life and get it under your own will. More than just organizing time and actions, Outlook helps you organize yourself.

Planning Your Day with Outlook’s Today Options

Your life may look like a race, but how about changing it from a wacky race to a championship Formula One race? Winning this race becomes easier when you adopt Outlook as your dashboard. In order to see your main dashboard:

1. Click the Mail command in the Navigation Pane.
   Your Inbox list appears.

2. Click Personal Folders in the All Mail Folders list.
   Outlook Today opens, as shown in Figure 2-1.
Whenever you open Outlook, three columns display the various activities you have lined up for the day:

- **Calendar**: Your open time commitments.
- **Tasks**: Your Tasks list, showing whether your Tasks are done (shown with strikethrough) or open. Tasks shown in red are overdue. Each Task's priority symbol is also shown.
- **Messages**: Your current messages and e-mail activity. You can choose which mail folders appear in this column.

This handy summary keeps you aware of your time and obligations so that you can choose how to attack your Tasks one by one.

### Customizing Outlook Today

If you're not an extremely focused person, you may lose track of your momentum and workflow after lunch, a long phone call, or a customer visit. Opening Outlook Today can help synchronize your mind with the demanding actions of the day. You can make Outlook Today the opening screen whenever you start the program by choosing Customize Outlook Today. In the Customize Outlook Today screen, shown in Figure 2-2, select When Starting, Go Directly To Outlook Today.
The remaining options in the Customize Outlook Today screen allow you to format the appearance of the Today screen for your best productivity:

**Messages:** The Choose Folders button allows you to select and display any desired folder in the Messages column of the Today screen. Try adding the folders for each of your main customers.

**Calendar:** You can choose how many days you want to see in the Calendar column of the Today screen. If you’re busy, select 2; if not, select 5 days.

**Tasks:** You can sort the list in different ways, using different sort fields.

**Styles:** I prefer the Standard style with three columns, but you can choose one or two columns and different backgrounds like Summer (yellow background) or Winter (white background).

When you finish setting your options, click Save Changes to save and close your customization.

**Working with Dates in Your Calendar**

When you get used to the basic Calendar, recording your appointments becomes part of your daily routine. Using the View button, you can see your appointments according to your priorities list or view them by day, week, or month. Figure 2-3 shows the One Day Calendar view.
If you become a heavy Calendar user, you may prefer to group your information in certain categories, such as active appointments, events, recurring appointments, annual events, and so on. To do so:

1. **Choose View** ➪ **Arrange By** ➪ **Current View**.

   The Current View dialog box opens to show the following options:
   - **Day/Week/Month With or Without AutoPreview**: Changes your Calendar view to look like an agenda (see Figure 2-4).

### Happy birthday!

The Calendar reminds you on the exact day of a birthday or anniversary. All anniversaries and birthdays recorded in your Contacts appear at the top of the Calendar on the appropriate day.

To receive a reminder before the date (so that you can order a gift, for example), you need to create a Task (order birthday gift) and set up the reminder ten days before the big event. (For more on scheduling Tasks, see the section “Scheduling a Task,” later in this chapter.)
• **Active Appointments**: Lists all your open appointments, including the holidays inserted in your calendar (see Figure 2-5).

Figure 2-5 shows a lot of Holidays listed. Because no appointment or event occurs between the holidays, they’re listed together. (You can load the national holidays from many countries; see Chapter 13.)

• **Events**: Lists only all-day events (see Figure 2-6).

• **Annual Events**: Lists only the yearly recurring events.

---

**Warning!**

Joe Owl arrived at work with one shoe brown and the other black. All his mates laughed. From that day on, Joe started to plan each day the night before, selecting his clothes and placing them on a chair. He also started leaving the office with a printed copy of Outlook Today, to plan the next day before sleeping.

Each person has a different energy curve during the day; select your best energy time to work on Tasks that require more attention. If you’re an early bird, set up the important Tasks reminders early in the morning. If you feel energized in the afternoon, then set up the reminder for the evening.
Use your Calendar Appointments view to list all your appointments.

Use the Calendar of Events to list all your open events.
• **Recurring Appointments**: Lists the appointments by recurrence pattern, such as weekly or yearly.

• **By Category**: Lists your open appointments by category, such as Sales Meeting, Important, or Type Of Customer, according to your use of categories. (For more on categories, see Chapter 4.)

• **Define Views**: Opens the Custom View Organizer so that you can create your own Calendar view.

2. **Select Day/Week/Month**.

3. **Select the Month button in the toolbar**.

The Month view appears, as shown in Figure 2-7.

---

**Figure 2-7**: The Calendar month view gives an updated picture of the monthly schedule.

---

**Organizing Your Priorities with Your Tasks List**

Organizing your priorities is about listing your dreams, your daily tasks, and obligations and making a choice about what should be done and when to achieve your goals. Prioritizing helps you create a self-fulfillment prophecy step by step.
**Yikes, what should I do first?**

You don’t like working like a slave Sunday to Sunday, until a breakdown comes. Working with preoccupation means occupying your time before it’s needed. Planning your work can shrink your preoccupation and turn slavery work into hard but unstressed work. Outlook is the tool to help you plan your day, record your appointments on the Calendar, and compile all your jobs on the Tasks list.

Instead of the feeling like “Yikes, what should I do first?” ask yourself two questions:

- How much working time do I have committed today?
- How do I choose the Tasks to be done in the remaining time?

Remember that committed time means that you’ve already planned and promised that time (promised to yourself or a client).

For example, say that you plan to work from 8 to 6 p.m. today, which gives you ten hours in the office. But you have to account for your daily downtime — lunch, coffee breaks, restroom, a little chat. Give this two hours of your day. You also have two appointments scheduled, which occupy three hours. That means that your time available is 5 hours (10 – 2 – 3) to work on your Tasks list, not deducting any unplanned interruptions.

Using your Calendar and this calculation, you now know your daily time available. Now you just need to focus on the most productive Tasks.

**Knowing what’s urgent versus what’s important**

Separating urgent from important tasks is something many people don’t do well. People tend to focus on urgent activities, mistaking them as important. *Important* is what brings results; *urgent* is the pressure for something to be done. You can classify your activities by determining both their level of importance and their level of urgency.

The Tasks list in Outlook lets you classify your Tasks by Priority, like High, Normal, and Low. To select or change the level of priority in the Tasks list, click the Priority button in the Task line you want to change and choose your priority, such as Low.
But what if you have five important Tasks going on at the same time? Which one should you do first? Sort your Tasks list by the Priority field to choose the important actions you want to take first. To sort a Task list by priority field, simply click the Priority field title in the title bar.

**Scheduling a Task**

You can open a new Task and not schedule it by simply typing the information without a Start Date or Due Date or by using the Reminder to start doing it and saving it in your Tasks list. However, scheduling means having a list of all your Tasks with Start Date, Due Date, and Priority Selection in order to select what you should do first, second, and so on, and finishing them one by one.

To schedule a Task:

1. **With the Task open,** type the Start Date in the date box.
2. **Type the due date** in the Due Date date box.
3. **Select High in the Priority list box.**
4. **Select the date you’d like a reminder** in the Reminder time date box (see Figure 2-8).
5. **Click Save And Close.**

Your Task is now scheduled and published on your Tasks list.

<table>
<thead>
<tr>
<th>Subject</th>
<th>Status</th>
<th>Due Date</th>
<th>% Complete</th>
<th>Categories</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loan</td>
<td>Not Star</td>
<td>None</td>
<td>0%</td>
<td>Goals/Objects</td>
</tr>
<tr>
<td>Normal</td>
<td>Not Star</td>
<td>Sun 7/23/2006</td>
<td>0%</td>
<td>Strategies</td>
</tr>
<tr>
<td>High</td>
<td>Not Star</td>
<td>Fri 6/20/2006</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>Purchase</td>
<td>Not Star</td>
<td>Thu 6/6/2006</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>Project</td>
<td>Not Star</td>
<td>Fri 1/27/2006</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>Print and place on a plastic cover</td>
<td>Not Star</td>
<td>Thu 9/30/2006</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>Proposal request</td>
<td>Not Star</td>
<td>Thu 10/12/2006</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>Best Company follow up</td>
<td>Not Star</td>
<td>Fri 10/12/2006</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>Deliver proposition</td>
<td>Not Star</td>
<td>Thu 11/1/2006</td>
<td>50%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Project</td>
<td>Not Star</td>
<td>Fri 6/1/2007</td>
<td>25%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Customer request #121</td>
<td>Not Star</td>
<td>Thu 7/9/2007</td>
<td>0%</td>
<td>Key Customer</td>
</tr>
<tr>
<td>Year 2006 goal One Double the Company</td>
<td>Not Star</td>
<td>Fri 12/31/2013</td>
<td>0%</td>
<td></td>
</tr>
</tbody>
</table>
Estimating your completion time

Pressure is not the best way to build your Tasks list. Due date, Status, and percentage of work done are available fields on the Tasks list to help you choose a working completion order. Why should you estimate your Tasks’ completion time? Because estimating each Task’s execution time can give you an idea of how many Tasks you’ll be able to accomplish in a set period of time.

What do you do when you have several important and urgent Tasks to complete at the same time? How do you choose among them? How do you know which one is the highest priority? Here are some ways in which you can make distinctions:

✔ By the customer’s screams: You work in the best company, where mistakes are addressed without any problem. When a customer wants more than is possible to give him on prices, delivery time, or credit, the ability to negotiate and say no is the art of changing the scream into “Okay, I understand you company’s decision. Thank you. Here is your order.”

✔ By pressure from above: Is your boss the #1 customer? Well, yeah, sure! The #1 customer deserves the best relationship, right? A good practice is to show your boss your Tasks list and negotiate the priorities with him. (See Chapter 10 to find out more about sharing your Tasks.)

✔ By due date: Setting the due date according your schedule or accepting the due date upon request is a target or a commitment that could change. Set the due date to avoid constant changes and change the expiration dates only for low priority issues.

✔ By percentage of work already done: Say that you have two important Tasks to complete, and one is 85 percent done while the other is 30 percent done. Choose the one that is closer to being finished first and then go for the second.

✔ By status: The only status that you really need to be concerned with is the status of Tasks that are “waiting on someone else.” These Tasks may require that you pressure someone else to release his or her part. All other Tasks are under your own control to complete and prioritize. On the other hand, maybe your coworker has different priorities, and your task is not important or urgent to him. What then? Perhaps you can help him with his priorities or organization. One way to start is to get him a copy of this book.

✔ By time estimate: To increase your productivity, figure out how much time you have available to work and then choose the Tasks that fit into that time slot.
To record each Task’s completion time:

1. Open any new Task.
2. Click the Details tab.

   The Details screen, shown in Figure 2-9, appears, and new fields are available.
3. Type your estimated time in the Actual Work field.

When you’re finished with the project, type the actual time it took in the Total Work field so that you have it for future reference or charge your customer for your time.

Viewing all your fields in the same list

Deciding what is important and urgent can be a terrific help when all variables are seen at the same time, such as Priority, Due Date, Percentage Of Work Done, and Estimated Time to complete the job. If you have two Tasks with the same priorities and due dates, you can choose to finish the one that needs only half an hour to finish and leave the one that requires six hours for later, allowing you to get an important Task done sooner.
To view all the Tasks’ evaluation fields on the same list together, customize the Tasks list in the following way:

1. Click Tasks in the Navigation Pane.

2. Choose Customize Current View in the Detailed list.

   The Customize View: Detailed List dialog box opens.

3. Click the Fields button to open the Show Fields dialog box.

4. Select All Tasks fields in the Select Available Fields From list box.

5. Drag and drop the Actual Work and Total Work fields to the Show These Fields box.

   All required priority fields are visible in the same list box so that you can choose your Task by priority, due date, or percentage accomplished.

6. Select each field and move through them in the following order: Icon, Subject, Priority, Due Date, Actual Work, Total Work, and then any other field.

   This order helps you select which Task to accomplish first by using the priority and due date fields or which Task could be accomplished first by reading the actual work and total work fields. Having more information available makes it easier to select the first Task to be done.

7. Click OK.

   The Tasks list contains information to help you select the Task by level of importance.

**Saving the view**

You can save the Tasks Customized Detailed view by copying it and giving it a new name.

1. Choose View ➪ Arrange By ➪ Current View ➪ Define Views.

   The Custom View Organizer dialog box appears.

2. Click the Copy button to open the Copy View dialog box.

3. Type Important x Urgent in the Name Of New View text box and click OK.

   The Important x Urgent view is shown in the Navigation Pane.
Adding the Actual Work and Total Work columns helps you estimate the time needed versus your available time and gives you more information besides just the priority and due date. The time spent planning pays off with more productivity or available free time.

Don’t freeze up because you’re looking at a long Tasks list. Instead, slice it and look at it one piece at a time. Adjust the size of your Tasks list column for Next Seven Days Only. Did you accomplish everything? Go to the next slice (page). Select a view such as Simple List or Next Seven Days. Beside the ten default views, Figure 2-10 shows some of the views.

To return any view to its default state, choose Customize Current View➪Reset Current View.

---

**Figure 2-10:** The Tasks list Navigation Pane shows some available views that you can choose.

---

**Tracking meetings and Tasks**

There are several ways to see your Calendar and Task lists together.

1. **Click the Calendar button in the Navigation Pane.**
2. **Choose View➪Taskpad.**
   
   (Taskpad is Outlook’s term for the Tasks list.) The Calendar and Tasks appear together, as shown in Figure 2-11.

To view all your active appointments, click View➪Arrange By➪Current View➪Active Appointments.
Designating and supervising Tasks

Designating a Task is not getting rid of something unpleasant or giving an order to someone and saying goodbye. Delivering a job by e-mail and phone calls doesn’t always generate a commitment from both sides. One of the parties may forget about it or have different priorities. Designating a Task means delivering to someone a job and then confirming their acceptance and commitment to doing it. The responsibility for the action and its supervision still remains with the person who requested it.

Requesting and supervising tasks with Outlook generates commitments, saves time, and eliminates phone calls and interruptions.

Requesting a Task is easy. First, create a new Task. Then follow these steps:

1. Click the Assign Task button to designate the person to your Task.
   A new form opens.
2. Fill in the assignee e-mail address in the To box.
3. Select the following boxes: Keep An Updated Copy Of This Task On My Task List and Send Me A Status Report When The Task Is Complete.
4. Click Send.

The Delegation request is sent (see Figure 2-12).

Upon receiving it, the assigned person has to read it and select the Accept or Decline button. Accepting the Task inserts it into his Tasks list and sends back an answer to the requester creating a commitment until the conclusion of the Task. Declining it opens a window to send a comment back to the requester. (Read more on delegating in Chapter 10.)

If the recipient accepts the Task until the job is done, both people have the Task on their Tasks list — one to do it and the other to supervise. Upon completion of the Task, Outlook automatically sends an update to the supervisor’s Tasks list.

Figure 2-12:
Create commitments by sending a Task request through Outlook.

**Messaging**

Certainly you know how to send and receive electronic messages. How did you learn to send and receive e-mails? Tipping is the general answer. You got a tip and started using e-mail without thinking about how to organize and archive your messages. Now, you need to be rescued just about every time your Inbox becomes unmanageable.
To be more organized with your e-mails, it helps to know the tools available for automating basic e-mail procedures. A lot of garbage is sent without the sender thinking, “Why am I sending this message?” Outlook can help you detect and eliminate undesired behaviors, creating folders and using rules to select and separate the messages for you.

Organizing your mailbox

Outlook has some tools for your mailbox organization, such as the Organize pane, the Rules wizard, the Mailbox cleanup, the Junk E-mail filter, the Message options box, and the message views (see Chapters 8 and 9). Before using any tool, you need to clean your Inbox. By selecting the column From, you can view each group of messages by sender, and you can delete the entire group of messages in one click or delete only the unnecessary messages.

To clean up your Inbox, follow these steps:

1. Choose Tools and one of the following commands to organize your mailbox:
   - **Organize Pane**, when selected, appears on top of your mailbox, helping you select a message and use a command to organize. You can move messages to folders or change their color so that you can easily view them.
   - **Rules Wizard** selects and takes an automated action in a message based on some conditions. For example, you can move a sent message to your best customer to his folder rather than to the generic Sent Items folder. You can also select and screen incoming messages for a specific word, such as *weekly report*, and automatically file that message in a Reports folder. You can create hundreds of rules with the wizard (see Chapter 8).
   - **Mailbox Cleanup** allows you to view your Mailbox and deleted items by size and search for messages older than a certain date. You can also set up AutoArchive to move your older messages to the Archive file, automating the mailbox cleanup.

   
   The Junk E-Mail box has four filter levels of protection, from no automatic filtering to permanently deleting suspected junk mail. It also has tabs to access safe senders, and a Blocked Senders list lets you insert names on each list and even synchronize the safe senders with your Contacts list.

3. Select among No Filter, Low, High, or Safe Senders Only as your Filter Option.
4. Click OK.

The Junk E-mail filter is working for you. (Read more about it in Chapter 9.)

**Sending messages option**

The e-mail Options button available in the message form allows you to configure how you send messages so that you can take into consideration issues such as security, sensitivity, and scheduling. (See Chapter 11 for more details.)

To classify the type of e-mail you’re sending and to send it at a set time, follow these steps:

1. **With a blank message open, click Options to display the Options dialog box.**
2. **In the Sensitivity list box, select Confidential.**

   The list box also displays the options Normal, Personal, and Private, so that you can classify the type of message you’re sending.

   Confidential means that the recipient will see the phrase “Please treat this as Confidential” at the top of the sent message (see Figure 2-13). Any selection except Normal inserts the related message at the top of the sent message.

   When you want to schedule a message to be delivered on a certain day, you can still write the message ahead of time.

3. **Select Do Not Deliver Before, select the date in the date box, and click OK.**

![Figure 2-13: You can configure a message to be sent as Confidential.](image)
The Flintstones cartoons humorously remind us of how mankind has been developing automation for centuries. But Fred, even with his dinosaur automation, always worked harder rather than smarter. Because you’re not a cartoon character, you can use Outlook automation power to relieve you of boring tasks and increase your spare time. You can stop doing things just because you’re used to doing them. Automation is at your fingertips.

**Don’t Waste Time Dialing**

How much time do you waste making a single phone call? First, you find the phone number to call. Then you pick up the phone and wait until you hear the dial tone. Next, you press the numbers and then wait until someone answers — if the line isn’t busy. The process can take from one to three minutes. Instead, use Outlook to make the call for you (but remember you still need to do the talking).

Outlook call automation includes dial-tone monitoring and call status displayed in the status bar. When connected, you can pick up the phone and start talking.

Your phone must be connected to the computer’s modem output jack.

In the following steps, you have Outlook make a phone call for you and inform you when you need to pick up the phone and start talking. You don’t even have to open your Outlook contact to have the Outlook operator make the call for you.
1. Click the Contacts button in the Navigation pane.

The Contacts list appears.

2. Right-click the contact name you want to call and choose Call Contact.

The New Call dialog box, shown in Figure 3-1, displays the name of the contact in the Contact list box and the phone number in the Number list box.

3. Choose the desired number (Home or Business) in the Number list box.

To write your phone call notes, including a time stamp, and file them in Outlook, select the Create New Journal Entry When Starting New Call option. The Journal entry form, shown in Figure 3-2, appears, where you can make your notes about the call and record the time spent. When you’re finished, just click Save And Close.
4. Click the Start Call button.

The Call Status line shows the call progress from on hook until connected or busy.

5. Pick up the phone and speak when the status shows connected or when you hear a person answer the phone on the other end.

You can use your PC speakers and a mike as a hands-free phone.

To retrieve phone call information in a Call journal, follow these steps:

1. With the Contact open, click the Activities tab.

All linked Outlook items, such as Tasks, e-mails appointments, journal entries, and linked files related to this contact, are listed (see Figure 3-3). Look for the items with a telephone icon in the list to see the phone calls.

2. Double-click the desired call to open the notes.

If you have a long list, you can select only the journal items to ease your search.

3. Select Journal in the Show list box.

Only the Journal items appear.

![Figure 3-3: The Activities page lists all linked actions including the phone calls journal.](image)
Saving Time with the Embedded Fax

The old way of sending faxes is to print the documents and a cover page, retrieve them from the printer, go to the fax machine, insert the documents, and then send them. The time wasted during this process can range between three and ten minutes. Outlook simplifies this process because you can now send the fax directly from your PC.

Setting up the Microsoft Fax console

To send a fax straight from your PC, you must have the Microsoft Fax console installed. To see whether it’s installed, go to the Windows Control panel and the Printer and Faxes folder, and look for the Fax icon. If you see the Fax icon, then you’re all set up to send faxes.

If the Fax icon doesn’t appear, then follow these steps:

1. Click the Windows Start Button and choose Control Panel ➤ Printers And Fax.
2. Select the Add A Fax command in the Printers Tasks.
3. Follow the Fax Wizard until the end of the setup.

Sending a fax

With your Fax console device installed, you don’t have to print any paper and walk to the fax machine, losing time and energy in the process. If you’re working with a notebook computer, the Fax console helps you send a fax from your hotel room or any other place. Just connect the phone line and send.

To send a fax:

1. Open the document you want to fax.
2. Choose File ➤ Print.
   The Print dialog box opens.
3. From the Name drop-down list, select FAX.
   If the fax driver isn’t shown, see the preceding section “Setting up the Microsoft Fax console.”
4. Click OK.
   The Send Fax Wizard appears.

5. Click the Address Book button.
   The Outlook Address Book appears.

6. Double-click the recipient's fax number.
   The Fax number is transferred to the Fax Wizard.

7. Click Next.

8. Choose and complete a cover page and then click Next.

9. Choose whether you want to send the fax now or at a different time and then click OK.
   The fax will be sent, saving your time with no paper jam. The Fax monitor box opens, showing the call status.

You can read the complete report of your faxes sent and received in the MS Fax console (see Figure 3-4). Go to your Windows Control Panel, click the Printers And Faxes folder, and double-click the Fax folder to display the Fax console. Now select the Sent items to see a list of sent faxes.

---

**Figure 3-4:**
You can open the Microsoft Fax console folders to view the faxes sent and received.

**Integrating Communications**

Unified messaging — integrating fax, voice mail, and e-mail in one mailbox — became a telecommunication fashion about ten years ago. The Unified
Messages system allows more productivity by centralizing the messages in one place. Ten years ago, only corporations could afford unified messaging. Today, reliable and affordable service providers supply unified messaging systems for a few bucks a month, affordable even to one person.

To understand the fax server and voice mail routing, you have to know what Direct Inward Dial (DID) is. If your company has a simple business phone system, then it probably has only one phone number and several extensions. The receptionist receives calls and transfers them to your extensions.

In larger systems, you can order a number of lines and a block of sequential phone numbers. For example, if your company phone number is 555-0000, a sequential block of 20 numbers would go from 555-0000 to 555-0019. Your company then assigns telephone numbers to each individual for voice and fax. When someone sends a fax to one of the DID numbers, it arrives in one of the DID lines with a special signal indicating which DID number was dialed. The fax server receives the call and looks up the DID number in a table to get the e-mail address(es) to which the fax is to be delivered and then attaches and sends the fax in an e-mail message.

A fax service provider uses an infrastructure with thousands of DID numbers connected to servers. It stores and forwards faxes to its customers’ e-mail addresses, eliminating the need for fax machines and phone lines. You can pick up your fax in your e-mail Inbox — anywhere, anytime by using your webmail access. To choose a provider:

1. Type Fax service in your Outlook Help window.
2. Click Search.

Service Providers advertisement with Outlook matching products appears listed in the Microsoft Marketplace site, a site containing many third-party tools related to Microsoft products.

3. Choose a provider in your area code.

Don’t forget to look for an acceptable price range, international services, and other features.

A voice mail, like the fax received through a fax server, is an electronic file, but instead of written information, it has audio information in it. The voice mail database is related to one phone number and a time stamp. Proprietary voice mail systems can attach and send the voice mail file to your Inbox in the same way a fax is sent to your Inbox. You can buy a voice mail system with the routing properties installed in your company or lease voice mailboxes with DID numbers from a service provider. Or use a Unified message system that integrates your phone numbers with voice mail, fax, e-mail, call routing, and arrival messages information.
Managing Your Data

Sometimes you read in the news or watch on TV about strange people who don’t throw anything away and live in a mountain of garbage. Imagine what your house would look like if you never took out the garbage or organized your clothes or washed your dishes. Disgusting, isn’t it?

Do you know many people who don’t clean their computer files until they become unmanageable? Messages keep arriving in the Inbox, and they keep sending messages, which get filed in the Sent box. Completed Tasks and past meetings with no information to file keep enlarging the size of their Outlook archives and occupy more space on their hard drive. Because most people don’t see the garbage inside the computer, they don’t care. But by investing a little time reading this chapter, you can use Outlook automation to take care of your computer garbage and clean things up when you want them cleaned.

You can trim down your Outlook data and store the old data for archival purposes. The Outlook data file stores all Outlook folders, such as Inbox, Contacts, Tasks, Calendar, Notes, and Journal. While you’re using Outlook, this data file gets larger and larger, holding more information in your folders, which can slow down your Outlook searches and other operations. You can create a second file whose purpose is to hold any file you deem fit. Archiving items older than six months is the default setting, but you can select your own time period and also which of the current folders you want to archive. For example, you may prefer to delete the Calendar items older than six months. You can set the Archiving period for all folders, or each folder can have its own instructions. The new data file is called Archive.pst. You can open this archive file as needed. Another option is to back up all the Outlook files to another computer on the network or to a server for safekeeping.

Here are a few housecleaning tasks that you can automate:

✔ **Archiving:** The Archive Option creates a second Outlook data file, one file containing your current data and a second one containing your old data archive. (Read the details in Chapter 9.)

✔ **Synchronizing** means that you have two copies of your data file, one in your mail provider known as an online folder and another inside your computer known as an offline folder (*.ost). At the moment of synchronization, the two folders become copies of each other. A deleted message on your computer is deleted in your online folder. A message received in the online folder is copied in the offline folder. The benefit of synchronization, besides making a backup, is the available access from any other computer through Outlook Web Access, including Calendar, Tasks list, Contacts, and, of course, mailbox. Check with your mail provider to see whether this service is available.
If you’re not connected to an Exchange server, the free backup add-in is a great tool for backing up your Outlook data file. Upon exiting the program, Outlook updates your backup onto another computer in your network or prepares to record it onto a CD-ROM.

**Downloading the Outlook add-in tool**

Unless you were looking for a solution in the Microsoft office site, you wouldn’t know about the Backup tool, which is useful when your company doesn’t have any type of mail backup. Here’s how to locate and download the tool:

2. In the Search For A Download text box, type Personal Folders Backup and click Go.
   
   The title Outlook 2003 Add-In: Personal Folders Backup appears.
3. Click the title.
   
   A new page appears, showing the download button.
4. Click Download to launch the Download Wizard.
   
   This wizard is valid for Outlook 2000 to 2003 versions.
5. Click the Run button to install the pfbackup.exe software.
6. Follow the Download Wizard.
   
   The backup software is downloaded and installed.

Lost data is more expensive to recover than a stolen notebook, so make your backups on a regular basis.

**Creating a backup file**

After the Backup tool is installed (see preceding section), you’ve got a no-cost data safety system for making backups. Now it’s easy to keep a copy of your current Outlook files stored on another computer, server, or CD-ROM.

To create a backup file:

1. In Outlook, choose File ➪ Backup.
   
   The Outlook Personal Folders Backup window appears, as shown in Figure 3-5.
2. Click Options.

The Backup Options dialog box, shown in Figure 3-6, appears.

3. Select the Remind Me To Backup Every X Days to any period you want, such as daily or weekly.

   Automating overnight backups is an option often used by corporations. If you travel with a Notebook, then I suggest making a backup file before every plane, bus, or car trip.

   If you travel a lot, use an e-mail provider with Exchange server, allowing you to synchronize your data between the server and your computer. This is better than remembering to make your own backup files.

4. In the Backup These Personal Folders Files area, select the files you want to back up.

5. Click Browse to select a location to store your backup files.

   You can choose another computer on the network to store the file or create a file to record later onto a CD-ROM.
6. Click OK to return to Outlook Personal Folders Backup window.

7. Click the Save Backup to close the Backup tool.

The Outlook backup file is updated only at the moment you close your Outlook program according to the preset instructions. A copying file message is displayed while the backup is being updated.

Opening a backup file

After saving a file on a CD-ROM you need to know how to use the file in another computer. To open a backup file in any computer, follow these steps:

1. In Outlook, choose File ➪ Open ➪ Outlook Data File.

The Open Outlook Data File list box appears.

2. Select the driver and the backup file, such as d:\ Outlook backup.pst, and click OK.

The Backup file opens in Outlook.

Minding Your Own Business
(Life Balance)

“We might do work we love, give up the futile task of proving ourselves to anyone, keep money within perspective, and do whatever is necessary to enable us to walk away from our work and activities if our soul requires it.”

— (The Re-enchantment of Everyday Life by Thomas Moore)

What do you want from your life today or in the next five years? Often you hear about the choices people make in life. Some people want to watch their kids grow and wouldn’t accept a job promotion if it meant their kids weren’t the priority. Later in life, when their children are grown, they choose their career with great success. On the other hand, a successful corporate president may be on his fifth marriage, but he has worked for the company for 25 years without interruption. To whom is he married, the company or his wife?

Outlook can help you set up your own pace of life, because your life story is built according to your choices. You can list your choices for family, finance, education, social, spiritual, leisure, sports, health, and even retirement and then select the reminders according to each of these priorities.
For example, a child’s frustration because of a parent’s delay or no-show at their special activities is so common it’s become a regular theme for TV series. If you’re involved in your daily activities and phone calls with new action items rolling in every minute or two, a 15-minute warning before the event probably doesn’t give you enough time. Here are a few ways Outlook can help you solve that problem and others:

- **Retirement plan:** Set up the reminder for every six months and recurrence once a year to evaluate your next step.

- **Medicine reminder:** Set up the reminder and recurrence daily at the right time so that you don’t forget to take your medicines.

- **Kids’ competitions and exhibitions reminder:** Set up your child’s appointment reminder two hours before the event so that you start cooling down your activities and focus on being present at your child’s event. The day-after results: You’re more productive with no guilt and a happy family.

To find out how to create a reminder, see Chapter 2.

The fulfillment of your life’s dreams or achieving a life balance is a matter of writing your wishes while keeping in mind all your roles in life and making decisions on your priorities from time to time. Using Outlook reminders help you achieve this fulfillment.
Part II
Managing Contact Information

The 5th Wave  By Rich Tennant

"I like getting complaint letters by e-mail. It's easier to delete than to shred."
In this part . . .

Who are your contacts? Your friends, your suppliers, or your customers? How do you keep track of each contact and his specific characteristics? When you have hundreds or thousands of contacts, you can easily forget someone. In this part, you find out how to use Outlook’s Contacts list to save all this information about each individual so that you can improve your relationships. You discover how to customize the Contacts list so that you can be more productive and appear more dedicated to your customers.

Instead of using the default contact entry form, you find out how to customize and create your own contact form with only the information you need on one page. In addition, I introduce you to Business Contact Manager (BCM), which is a free add-in that comes with the Office Small Business and Professional editions. The BCM software enables you to control your sales opportunities one by one. BCM offers a series of reports that you can use to improve your business efforts.
Chapter 4

Creating an Awesome Customers and Suppliers Database

In This Chapter
► Making your contacts more than a black book
► Adding a new Contact
► Developing profiles
► Creating a company profile for sales
► Type-casting your customers

Are you tired of searching through sticky notes, business cards, sales records, accounting systems, and the like for your customer information? Instead of moaning about the time, organize your information into one system. This chapter tells you everything you need to know to get organized in Outlook Contacts.

Exploring Outlook Contacts

In 1998, when I was running a technology company, every penny we received was allocated to product development. We badly needed to update our customers and prospects database, but we didn’t have any money to spend on the project. We explored Outlook Contacts, which was already in our system software, and discovered that it satisfied our needs. Here are some ways you may be able to use Outlook Contacts in your business:

✔ Import existing contact information into Outlook. Every time a company starts planning a new system, employee grumbling is heard throughout the organization. Employees moan, “I don’t have time to stop my work and grab the information for you.” Outlook has a tool that enables you to easily load contact information in bulk.
Set Outlook Reminders to prompt you to follow up with customers. A key issue of business-to-business sales is losing sales orders because of lack of follow-up. Writing follow-up actions on a day planner can be helpful, but it’s easy for employees to lose track of some aspects of their projects. Outlook Reminders are an effective alternative to the day planner because a message automatically pops up on the screen at the predetermined time, reminding the user to follow up with a customer. This tool helps employees keep track of their projects.

Customize Contact fields for your needs. Some software applications don’t offer users the ability to create custom fields; you’re stuck with only the default fields. Outlook, however, has a tool to generate fields as needed and the ability to generate your own custom profile.

Design customized marketing campaigns. Using the Categories fields, you can classify your customers by your own criteria and design a marketing campaign by product, by segment, or by type of customers.

Add personal information to your Contact profiles. Business or personal relationships are built on mutual knowledge and understanding, not just on names and addresses. Outlook Contacts enables you to record personal information in each profile. For example, you may want to note that Joe Smith is fanatical about the Giants and loves to talk about pitchers or that Mary Ford likes to eat at French restaurants and show off her French accent when reading the menu.

Importing Contacts from Existing Files

Many people think that the only way to add a Contact record to Outlook is to type the information. If you have just a small number of contacts, this method is feasible. However, if you have hundreds of business cards, this task is a tall order. A better option is to scan the business cards with a card scanner and Optical Character Recognition (OCR) software (which scans the image and transforms it into text), creating an electronic file ready for import.

Outlook can import files from ACT!, Lotus Organizer, Schedule Plus, database files, Excel, Access, text files, and other types of resources. The following sections give you the lowdown on importing files into Outlook.

Importing compatible files

A compatible import file, including the internal field names within it, is fully understandable by Outlook, making importing easy:

1. Choose File ➤ Import And Export.

   The Import And Export Wizard appears, as shown in Figure 4-1.
2. Choose the Import From Another Program Or File option and then click Next.

The Import A File Wizard appears.

3. Select your importing software and then click Next.

4. Click the Browse button and find the file that you want to import; select the Do Not Import Duplicate Items option to avoid importing two records with the same contact and then click Next (see Figure 4-2).

5. Select the Contacts folder in the Select Destination Folder list and then click Next.

6. Click the Import “Your Filename” Into Folder check box and then click Finish.

The Import A File Wizard appears, showing a progress bar to monitor the import process until the process is finished.

7. Click the Contact button on the Navigation Pane and read the Contacts list, checking to see whether the imported names appear in the list.
Importing noncompatible files

A noncompatible file is one in which the field names are different from the Contacts list and must be matched (or mapped) one by one in order for the imported list to be merged correctly.

It’s unusual to find an Enterprise Resource Planning (ERP) system or a sales system ready to export a file to Outlook Contacts or any nonintegrated software because different software products have different requirements for importing. Most ERP software offers file export tools for exporting to standard formats, like comma delimited or Excel formats.

Before importing Excel files, you need to know the columns names used for the data and the content in order to map them to the appropriate Outlook fields. In the example Excel file, the field Customer Name is the same as Full Name in Outlook.

Follow these steps to import a noncompatible file:

1. **Choose File ➤ Import And Export.**
   The Import And Export Wizard appears (refer to Figure 4-1).

2. **Select Import From Another Program Or File and then click Next.**
   The Import A File Wizard appears.

3. **Choose Tab Separated Values (DOS) from the list and then click Next.**
   The Import A File Wizard shows the text box to type, or you can browse for the file to import.

4. **Browse to the file that you want to import, select the Do Not Import Duplicate Items check box, and then click Next.**
   The Select Destination Folder list appears.

5. **Choose Contacts under the Select Destination Folder list and then click Next.**

6. **Select the file in The Following Action Will Be Performed window.**

7. **Click the Map Custom Fields button in the Import A File Wizard.**
   The Map Custom Fields dialog box appears. In the left column, the Excel file is shown, and the field names are listed in the Value column in the From Frame. The Outlook file is shown on the right side with its fields shown in the Field column. A third column, Mapped From, is available under the To frame (see Figure 4-3).

Pay attention, because field names can be misleading. For example, a field called Name might mean First Name or Family Name, depending on how the database was designed. In the next step, you have the opportunity to map the content of each field.
Troubleshooting Excel import problems

In the past, importing Excel files to older Outlook versions without the proper Excel file configuration started an endless process of importing empty fields until the computer went down. Fortunately, Outlook 2003 warns of the translation error (see figure).

There are two ways of solving the problem quickly, one for people who are not so familiar with Excel and a second for Excel users.

✔ **Solving the no named ranges problem quickly:** Open the Excel import.xls file and save it as filename.txt. Then start the import again for the new text file. (See the section “Importing noncompatible files,” earlier in this chapter.)

✔ **Fixing the Excel file to solve the problem:** To prepare the Excel file, select the entire database inside Excel (including the headings and all the data) and then choose Insert ➤ Name to give the area (range) a name. Using this procedure solves the import problem with Outlook. Start the import again with the new Excel file. (See the section “Importing noncompatible files,” earlier in this chapter.)

8. Drag and drop the desired fields from the Value list to the Mapped From list.
In the example, the field Name was mapped to the First Name field in Outlook. The field Name is seen now in the Mapped From column. Figure 4-3 shows the result.

9. Repeat Step 8 for all the desired fields in the Value list (see Figure 4-4).

10. After you finish mapping all the values, click OK.

You return to the Import A File dialog box.

11. Click Finish.

The Import Progress window appears.

After the import is complete, click the Contact button on the Outlook Navigation Pane to see the imported contacts.

---

**Tip**

When importing from incompatible files, map the incoming fields to Outlook's Contacts fields.

---

**Going Beyond Your Little Black Book**

Ten years ago, not everybody had an e-mail address, a Web site, and an instant messaging address, requiring three new fields in the old black book. These days, the number of people you talk to and the information you have to record have grown at an exponential rate. Having all this contact information available at your fingertips helps you remember things like your customers’ favorite teams, their kids’ names, their birthdays and anniversaries, or their music preferences. With Outlook, you can maintain all this information and keep your business operating on a personal level. When you add a contact to Outlook, it’s much like recording personal information in a little black book.
To create a new contact:

1. **Click the Contacts button on the Navigation Pane, as shown in Figure 4-5.**
   The Contacts list appears.

2. **Click New.**
   The Untitled Contact opens, as shown in Figure 4-6.
   The General tab of the Untitled Contact looks like a black book. You can fill in your contact’s name, address, and phone number.

3. **Complete the form by clicking the appropriate buttons and typing the detailed information.**
   The Full name and Addresses buttons open a dialog box that lets you type detailed data, such as Mr. or Ms., city, and zip code. If you don’t see a button, just type the information in the available text box.
   Click the down arrows to choose other options. For example, you can change the address from Business to Home or the Business Fax number to the Home Fax number. In all, you have 19 options, as shown in Figure 4-7.
4. If you want to add a photo of your contact, click the picture frame and follow the wizard to attach the contact photo.

Outlook 2003, for the first time, gives you the capability to add a picture. Now, by inserting your contact’s photo along with the data, you can quickly associate the person’s face with the facts.

5. Click the Contacts button to link related contacts.

The Contacts list appears.

6. Double-click on the contact to link.

The contact is linked and listed.

For example, say that cousin Harry and his friend Tim play tennis together weekly. When you call Tim, who is your customer, Outlook Contacts can remind you of his relationship. Talking casually about the last tennis game may improve your relationship. You can easily incorporate strategy-focused networking when you remember connections. You can also link relatives like wife, kids, and mother-in-law on the contact page.

7. Click the Categories button to classify each contact into categories.

The Categories list appears with its default list, such as Goals, Strategies, Phone calls, and so on (see Figure 4-8). You can choose one of them or create your own category. Continue with Step 8 to create a New Category.
8. Click the Master Category List button.

   The Master Category Wizard appears.

9. Type the desired name in the New Category text box.

10. Click Add and then OK.

    The category is added to the Master Category List and is available
    for use.

    Cousin Harry, besides being a family member, is a friend and travel
    agent. You can classify him by using three categories: Family, Friend, and
    Supplier, allowing you to take different actions for Harry based on the
    different groups he’s in, such as sending a birthday invitation to friends
    or mailing your company communication to all suppliers.

    For more on categories, see the section “Categorizing Your Customers,”
    later in this chapter.

11. Select the Private button if you do not want to share this contact when
    Outlook sharing properties are active.

12. Click the Save And Close button.

    The new contact is added to your Contacts list.
Minding the Details

You can include so many details about your contacts, including information about their children, hobbies, spouses, and anniversary and birthdates. A contact has more fields ready and available than you could ever imagine. The following steps explore some of the fields available on the different Contacts list tabs.

1. **Double-click the contact in your Contacts list.**
   The desired contact appears.

2. **Click the Details tab.**
   The Details page opens (see Figure 4-9). The following fields are available: Department, Office, Profession, Manager's name, Assistant's Name, Nickname, Spouse's Name, Title, Suffix, Anniversary, and Birthday.

3. **Type the information you want to include into the available fields.**
   You can also use Outlook to remind you of important dates, such as anniversaries and birthdays. See Chapter 2.

4. **Click the All Fields tab to reveal more personal information fields.**

5. **Select All Contact fields in the Select From list.**
   All the native contact fields appear, as shown in Figure 4-10.
Figure 4-9: The details page shows additional information like birthday and spouse's name.

Figure 4-10: The All Contacts fields show only part of the fields available for each contact.
6. Select Address Fields, Names Fields, or User-Defined Fields to see a particular group of fields at the same time in the Select From list.

The Select From list has nearly 20 different options, including the All Tasks Fields option to show everything.

7. Select Personal Fields in the Select From list.

The Personal Fields list appears (see Figure 4-11) with new options, such as children, hobbies, and language.

8. Type the information in the desired fields.

9. Click the Save And Close button.

**Figure 4-11:** The Personal fields record information about children, hobbies, and language.

---

**Understanding views**

The Contacts list view is much more than a simple way of displaying the available fields in a preset format. Each view is also a different report that you can sort, filter, and list according to your needs. The Phone list view, for example, is ideal for telemarketing activities, and the Address Cards view is useful for those used to working with business cards or Rolodex files. What's more, you can add or delete fields, sort by one or more fields simultaneously in ascending or descending order, and even use filters to select subgroups, such as only people from a particular city. Create your own views to work on what is important to you.
To customize your Contacts view, select the Phone list in the Navigation Pane and then click Customize Current view. The Customize View Phone List appears.

You have the following options on this list:

- **The Fields button** is the path to the Show Fields box, where you can customize the fields listed or add and remove fields from the current view. (See the section “Creating custom fields,” later in this chapter, for more information.)

- **The Sort button** is the path to the Sort box, where you can sort by two or more fields at the same time, such as city and state.

- **The Filter button** is the path to the Filter box, where you can define criteria for each field, filtering your desired contacts down to a specific list. See Chapter 16 for information about selecting your customer base by using the filters.

Customized views are lists developed according to your needs. Develop lists for sending monthly birthday cards, developing telemarketing activities, sending advertisements to a selected group of customers, or tracking sales by customer. These are just some of the customizations you can develop by yourself. The starting point is understanding how to create custom fields.

**Creating custom fields**

You may need custom fields to record information about contacts based on your type of business. A legal office, a doctor, or distribution company may need to organize important information about the customer, creating special fields for each one.

Each Contact has only so many fields, and you may need to create a new field for a specific purpose. You can create any field you need with several choices of type and format. To create fields, you can start from any Contacts list view.

1. **Select the Phone list in the Navigation Pane.**
2. **Click the Customize Current view in the Navigation Pane.**
   - The Customize View Phone List appears.
3. **Click the Fields button.**
   - The Show Fields dialog box appears.
4. **Double-click the New Field button.**
   - The New Field dialog box appears.
5. Select Yes or No in the Type area for the following field types (see Figure 4-12): Text, Number, Percent, Currency, Yes/No, Date/Time, Duration, Keyword Combination, Formula and Integer, and each field with their own format options available.

6. Select Icon in the Format list box.

7. Type the field title in the Name text box.

8. Click OK.

The new field is listed in the last line of the Show These Fields In These Order List (see Figure 4-13). You can select a title for the field, such as Decision Maker, to record information about a person who makes the buying decision for the company.
Displaying the fields in your order

The fields sequence can be shuffled and displayed in any order, but you have advantages of choosing certain sequences. For example, if you ask to check your customer record, the operator has to read and confirm the person’s name, the company, name, job title, address, phone, and e-mail in the sequence and retype them whenever they change. The fields sequence is important and can be different, depending on the application. The Show Fields box allows you to customize the fields’ sequence.

1. Select the Phone list in the Navigation Pane.
2. Click the Customize Current view in the Navigation Pane.
   The Customize View Phone List is displayed.
3. Click the Fields button.
4. Drag and drop the desired field into position in the list.

For example, the Decision Maker field is at the end of the list, but you can move it so that it appears after the Full Name field (see Figure 4-14). This notation helps remind you who the person is before you call.

Understanding views, how to create fields, and the way to display the fields in a practical manner helps you and your team work in a more focused way, without losing time looking for information.

Figure 4-14: The Decision Maker field was moved below the Full name field to provide additional information in the view.
**Developing a Customer or Company Profile Checklist**

Who is your customer? A person or a company? You can record personal information in the Contact record, as well as the company information in the same record. If you have two people in the same company as customers, you’ll have the same company profile for both and a different customer profile for each person.

Say that Microsoft is your customer, so you have to build a Microsoft company profile. Who is ordering or using your product at Microsoft? You have to create the customer profile for each person to remind you who they are and how to improve your relationship with these people as time goes by.

The *customer profile* is the information about a person, an individual such as your customer or your contact, at a company that is your customer.

*Company profile* is the information about the company, such as the number of employees, location, size, products, and other information valuable for your work.

When you go to the family doctor, chances are that the doctor has a folder that contains all types of information about you: your medical history, test results, and past prescriptions, to name just a few. In a sense, this information serves as the doctor’s customer profile.

The doctor and you have the same objective: to develop a precise prescription. His records help him develop a personal and friendly relationship and keep his customers coming back.

A customer profile retains personal data according to each type of business. Your own profile in a jewelry store is different from your profile in the family doctor’s folder or if you’re a contact within a company. A *company profile* retains information about the company and the people working in this company. Depending on your business, you may need to build a customer or a company profile. You can use a Contact form and customize it to become a customer or company profile.

**Looking for company information**

A *profile* is a set of information about a person (a customer profile) or about a company (a company profile). When you’re running a business, you need the profile to know about your customer (the person) and his company, his ordering potential, the credit financial risk, preferences, and the way he
works. Before building any profile checklist, you need to understand the required information for your own business. You can use Outlook Research to find typical company profile information on the Web:

1. **Choose Help ➪ Microsoft Office Outlook Help.**
   The Help pane opens.

2. **Click the triangle in the Help title bar to collapse it so that you see four commands and choose Research.**

3. **Collapse the dialog box that appears.**
   A commands list is displayed.

4. **Select a company profile.**

5. **Type a company name in the Search box.**

6. **Click the Start Searching button.**
   A new window appears with your results displayed (see Figure 4-15).

7. **Choose Click To Read Full Profile.**
   Internet Explorer opens, displaying the Company profile free information (see Figure 4-16). If you need additional information, you pay a fee.

![Research pane](image)

**Figure 4-15:** A standard company profile found by using the research pane.
The profile found shows the company information in a format required by most companies today. Besides the address and phone numbers, the information provided shows the company's annual gross sales, number of employees, type of business, and so on. You can create the same fields in your contact to add the same information for each customer.

Developing your own profile

Profiles developed according to your own business needs help you have in hand all the information needed to negotiate and improve your customer relationships. You can sketch out your customer or company profile by writing the information you need to record and the name of each new field to create. Use the checklist to start your own company profile. Do you need a new field? Just create it. (See the section “Creating custom fields,” earlier in this chapter, to find out how to do so.)

Companies like Thomson Gale or Dun & Bradstreet specialize in collecting company information for credit and other purposes. Accessing these databases can save you a lot of time, providing you with information all at once. Basic information may be free, like the example, or you may have to order and pay for detailed information. These databases don’t solve all your needs. They don’t, for example, give you the right contact within the company or offer specific details for prospecting.

What else do you need besides a standard credit profile? Use the following checklist and write down any other fields you think you may want in your customer profile:

- **Company information**: Company size, total sales, territory coverage
- **Product or service information**: Product lines, production forecast
Financial information: Stock information, profit last fiscal year, credit released

Goal sales: Potential, strategy to make a goal, actions to perform

Competitor information: Name, strength, weakness

Contact information: Decision maker, active or reactive, preferences

Creating a profile for sales

Using a checklist (see preceding section), you can design your Contacts list as a company profile for sales and even sort your profiles by any field criteria, like the quarterly goal field, to focus on each account. You can create a company profile with the following fields in the Contacts List view: Icon, Attachment, Flag Status, Full Name, Decision Maker, Company, Quarter Goal, Goal Today, Business Phone, Journal, Categories, and any other field you think you may need.

This company profile gives you three new fields. The first is your current sales, the second is how much you need to accomplish your forecast, and the third is the name of the decision maker to close your order. With the Phone List view selected for the Contacts list:

   The Customize View Phone List dialog box appears.

2. Click the Fields button to display the Show Fields dialog box.

3. Select Frequently Used Fields from the Select Available Fields From list box.
   The fields are listed in the Available Fields list.

4. Double-click each field needed from the Available Fields list to move it into the Show These Fields In This Order box.

5. Click the New Field button to create the fields.
   If you’re not sure how to create fields, see the earlier section, “Creating custom fields.”
   The fields are created and inserted in the Show These Fields In This Order Box.

6. To create your company profile list, select each field, move it up or down inside the Show These Fields In This Order box, and set your desired sequence.
   If you’re not sure how to line up your sequence, see the section “Displaying the fields in your order.”
   The Company profile is ready to be saved (see Figure 4-17).
7. Click OK.

Your Contact Phone List view appears (Figure 4-18). It contains two important fields:

- **Journal**: Helps you find any record, such as a proposal or phone-call notes, related to the customer. (See Appendix C for more information.)
- **Categories**: Helps you classify the customers for several purposes (see the next section).

![Figure 4-17: Show new fields sequence as company sales profile.](image1)

![Figure 4-18: The Customer profile list is ready to be used.](image2)
Categorizing Your Customers

At times, you’ll want to take actions or perform analyses on groups or batches of customers. You should typecast your customers or suppliers in order to perform different kinds of group actions. For example, you may want to perform actions on a specific market segment, send specific information to a market segment, measure sales results from a particular group, or other batch processes. The Categories field is your tool to type-cast customers and create groups.

Open a contact and click on the Categories button in the lower right corner of the screen to see the default Categories list. Then simply select the following categories one by one in the Categories dialog box: Strategies, Suppliers, and VIP. Then click OK. The Category window for this contact appears as with all categories (see Figure 4-19).

No matter what you’re focusing on, categories can organize your records so that you’re ready for a specific action. For example, you can create a mailer for people with specific job titles, like financial manager, surgeon, or cardiologist. You can use categories to send a mailer introducing a new product to a particular group, such as a new medicine for dermatologists or a new component for design engineers.

You can even create your own categories. For example, say that you need to group customers according to each salesperson. You can simply create a category for each salesperson and then insert the category in each customer’s contact. To create a custom category:

1. With your contact open, click the Categories button.
   The Categories dialog box appears.
2. Click the Master Category List button.
   The Master Category List box appears (see Figure 4-20).
3. Type the name of the category in the New Category text box and click Add.
4. Click OK.
When they hate you . . . Creating categories

This may sound odd, but you may want to create a category for customers who hate you. That’s because it’s important to record customer problems, such as the company’s failure to correct an emergency support issue or a bad relationship between a former salesperson and the client. Classifying the customer and knowing the reason for the problem may help you recover that customer later.

You can also use a number of other categories in your Contacts list for sales purposes, such as prospect if you’re at the beginning of a relationship, potential after you’ve developed the relationship but haven’t closed a deal, active for a current customer, or inactive for a customer not ordering after one year.

The easiest way to increase sales is to work effectively with your own, current customer base. Companies working for some years will have all kinds of customers categorized in their customer base.

For example, hidden customers: have great potential but haven’t been exploited. Writing a profile with their credit information, Web site information, and search engine information by company name or products may reveal more hidden customers in your list.

Forgotten customers have been great customers in the past but remain nonactive because of a change in your product base or a broken relationship. Using categories to type cast your customers makes it easier to discover and recover them. If you have a few Hates us contacts in your list, you can use reminders to call them monthly. Listing ten forgotten customers, you can call one or two each day of the week and then weekly until you turn them into active customers again.

The company profile helps you to have a better understanding of your customer and the way business goes.
Chapter 5

Building Customer Profiles with Forms

In This Chapter
- Creating a form
- Discovering the toolbox
- Creating a customer profile form
- Using the new form rather than Contacts

Outlook forms are great tools to align the company information, increase your productivity, and even start a small sales force automation system. Before the computer age, if you wanted a form, you needed to sketch it on graph paper, have a designer develop a model, and then order the form from a print shop.

With Outlook, when you open a new e-mail to write, you’re opening an e-mail form where you fill in your communication and send it in a format recognized by any e-mail user. E-mails, Appointments, Tasks, Meeting Requests, and Contacts are all available forms. In this chapter, you find out how you can customize Outlook’s available forms so that you can include more key information about your customers.

Exploring the Contact Form and Toolbox

Outlook forms all use the same concept: They have a grid-lined background with preformatted fields that you can easily adjust to your own use. You can start designing a form by using a Contact form.
To open a Contact form:

1. **Choose Tools ➪ Forms ➪ Design A Form.**
   The Design Form dialog box appears.

2. **Double-click the Contact form.**
   The Contact form, shown in Figure 5-1, opens. This form is the starting point for developing any Outlook form.

The toolbox, which appears on the left side of the Contact form (see Figure 5-1), contains 15 buttons. Table 5-1 shows each button and describes how you use it.

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Objects</td>
<td>Allows you to select an area with several objects and take actions like delete, align, change the size, or move the objects.</td>
</tr>
<tr>
<td>Label</td>
<td>Inserts an explanatory label over the background.</td>
</tr>
<tr>
<td>TextBox</td>
<td>Generates empty fields that you can fill in with your text.</td>
</tr>
<tr>
<td>ComboBox</td>
<td>Inserts a box that displays a set of custom-designed options in a drop-down list.</td>
</tr>
<tr>
<td>ListBox</td>
<td>Inserts a box that displays available choices in a list format. If the list exceeds the box size, the user can scroll through the list to view additional choices.</td>
</tr>
<tr>
<td>CheckBox</td>
<td>Creates yes/no or on/off options when inserted next to an item. You can use in groups to allow users to select more than one of the items in a list.</td>
</tr>
<tr>
<td>OptionButton</td>
<td>Creates lists from which you can choose only one item when inserted next to a group of items.</td>
</tr>
<tr>
<td>ToggleButton</td>
<td>Inserts an activation button, such as an on/off button.</td>
</tr>
<tr>
<td>Frame</td>
<td>Creates a titled frame for separating groups of items.</td>
</tr>
<tr>
<td>CommandButton</td>
<td>Creates a button that you can use for actions, such as Send or OK.</td>
</tr>
<tr>
<td>Button</td>
<td>Name</td>
</tr>
<tr>
<td>------------</td>
<td>--------------</td>
</tr>
<tr>
<td></td>
<td>TabStrip</td>
</tr>
<tr>
<td></td>
<td>MultiPage</td>
</tr>
<tr>
<td></td>
<td>ScrolBar</td>
</tr>
<tr>
<td></td>
<td>SpinButton</td>
</tr>
<tr>
<td></td>
<td>Image</td>
</tr>
</tbody>
</table>

Figure 5-2 shows what happens when you select each button and drag and drop it onto the form grid. After dropping a control onto the grid, you can select it and resize it, or move it into position on the form. Right-clicking on any item opens a menu of design commands, including a command for item alignment, design properties, and other advanced features.
Building a Customer Sales Profile Form

You probably have a Contacts list with names and phone numbers, but it may not show all the information you want to include. Fortunately, you can add customized information in the Field Chooser box on the Contact form. You simply select any available field and drag and drop it into place on the form.

I typically include the following fields, but you can include the fields that best meet your needs:

- Name
- Decision Maker
- Company
- Firm type
- Full Address
- Main phone
- URL
- Employees
- Sales
- Fiscal year end
- Year founded
- Primary SIC (business classification)
- Quarter Goal
- Goal today
- Backlog order last until

If the field name you want to use doesn’t exist, you can just create it. (See Chapter 4 for more information on creating new fields.)

To create a customer sales profile form, you need to follow these general steps, which are outlined in detail in the following sections:

1. Clean up your form design.
2. Create and rename any necessary frames.
3. Insert your fields in each frame.
4. Publish the new form.

Keep in mind that these steps show you how to generate a basic customer profile form. You can add more pages to the form or add more fields according your needs. You can even add extra pages for detailed financial information or other needs. The report created in these steps will help the sales force keep their goals.

Cleaning up the standard Contact form

The Contact form is a very complete and generic form for both personal and company information. When you design a form for a specific purpose, you don’t need to keep unused fields. Instead, delete them to have more space available for your own fields.

To clean up your Contact form design:

   The Design Form box appears.
2. Select and click the Contact form.
   The Contact form opens.
3. Select and delete any field that you don’t want.
   When I clean up my Contact form, it looks something like Figure 5-3.

![Figure 5-3: This cleaned-up Contact form shows only native fields.](image)
**Working with frames**

You may find that you can group the fields you want to include into categories. For example, I typically split my fields into three categories: Personal Information, Company Information, and Sales Goals. To split fields into categories, you need to create frames:

1. **Click the Toolbox button.**
   The toolbox opens.

2. **Select the Frame button and then drag and drop it two times onto the form — one on the bottom left and one on the bottom right of the form.**
   If you want more frames, drag and drop the Frame button as many times as the number of frames you want to create.

3. **Adjust the sizes of the frames you added in Step 2 so that they fit comfortably on the bottom of the form grid, as shown in Figure 5-4.**

4. **Right-click on the frame and choose Properties.**
   The Properties dialog box appears, as shown in Figure 5-5.

5. **Type the name of your first frame into the Name box.**
   For example, my frame's name is Company Information.

![Figure 5-4: You can adjust the lower left frame size.](image)
6. Type a caption into the Caption box.
   For example, my frame's name is Company Information, and the caption
   is the published frame title.

7. Click the Font button to select and change the Captions fonts.

8. Select the frame's color mode with the Background and Foreground
   selections.

9. Click Apply and then Close.

10. For each frame you need to name, repeat Steps 4 through 7.

### Inserting fields in each frame

After you create your frames (see preceding section), you're ready to insert
your fields (see Chapter 4 for more on creating new fields). To do so, simply
drag and drop your fields into the appropriate frames.

After dragging and dropping all fields, your screen may look something like
Figure 5-6, with all fields misaligned. Dragging and dropping the fields was
easy, but aligning them one by one manually would be torture.
Fortunately, Outlook has an alignment tool to release you from this tedious work. Just follow the next few steps:

1. Select the entire column of Text boxes of the frame that needs aligned, as shown in Figure 5-7, and right-click.

   The command list appears.

Figure 5-6: 
The Company profile for Sales misaligned.

Figure 5-7: 
My Company profile form with items ready to be aligned.
2. Choose Align ➪ Align Left.
   The Column aligns.

3. Repeat Steps 1 and 2 for all misaligned items on the form.
   The aligned form appears in Figure 5-8.

---

**Publishing the profile form**

When your form is ready, you can file it as a new form or publish and place it in a public folder available to all company members. You can even use it as your default contact form (see next section).

To save the form:

1. Click the Publish button (the leftmost button on the Form design bar).
   The Publish Form dialog box appears.
2. Type a name for the form into the Form Name text box.
3. Type a name to appear on the form itself into the Display Name text box.
4. Click the Publish button.
   The form is saved in the library.
Setting Up Your New Form as the Default

After you’ve created a custom form for entering all kinds of important customer information, you may want to use it as the default form when you open your Contacts database in Outlook. That way, you have all your important information in view while you talk to the customer.

Here’s how you set up your new form as the default:

1. **Select Contacts on the Navigation pane.**
   The Contact folder appears on top of the Navigation pane.

2. **Right-click the Contacts folder and choose Properties.**
   The Contact Properties dialog box appears, as shown in Figure 5-9.

3. **Select the name of the form you want to use in the When Posting To This Folder, Use list.**

4. **Click the Apply and OK buttons.**
   The new company profile is now your default Contact entry form.

---

Figure 5-9: You can establish your custom designed form as the default contact form.
Would you spell your name for me?

Names like Choo Lao Kon, Zgniev Brzinsky, Kamal Ahmed Gamal, Antoine Siqueira, and Belarmino Benallana expose us to the global caldron and make us repeat the same question several times: “Would you spell your name for me?”

Type the correct spelling into Contacts, and you’ll have no more spelling questions again. Using the Actions menu, you can write letters or e-mails, merge contact information, even have the computer dial the phone for you, and automatically apply many other timesaving applications to your contacts. Give them a try.
Chapter 6
Kicking It Up a Notch with the Business Contact Manager

In This Chapter
- Understanding BCM
- Looking at the BCM’s benefits for your type of business
- Understanding and overcoming BCM limitations

If you do a lot of traveling and rent cars from time to time, you know that you need to be flexible and adjust to each car. At the very least, the seat position and mirrors need to fit your personal preferences. Today, many people hate driving manual-transmission cars because they’re used to driving automatics. If you run a small business with limited resources, you must be flexible and adapt yourself to the resources available, such as Outlook, but you can put more of an automatic transmission into your sales with Business Contact Manager (BCM), which helps focus on the sales while the organization runs smoothly.

In this chapter, you find out how to enter your business information into BCM and use it to control your sales history and activity by customer.

Introducing BCM

Chapters 4 and 5 explain how to customize your Contacts to track your customer and suppliers information. If you don’t want to create your own contact pages, you can try using Business Contact Manager, a ready-made tool designed to control sales and other activities for small businesses. Ready-made pages with business fields help you control your prospecting and sales activities, focusing on speeding up your business without having to create custom forms. BCM is a great tool for managing all your sales activities, from
new prospects to your best customers, from the first e-mail sent, to closing deal after deal for years. To do this BCM adds an extra database beside the Outlook.pst file and four different forms to record your information. The Product And Service Items List allows you to add your products and service to any Opportunity. The Opportunity form is designed to link any business opportunity to a customer in Business Contact or to a company in an Account form.


---

### Installing BCM 2.0

To install BCM Version 2.0, open Outlook and connect to the Internet. Now follow these steps:

1. **Click Help→Check For Updates.**
   - You’re automatically linked to the Microsoft Office Downloads Home Page.

2. **Click Check For Updates.**
   - The check verifies your current Office version. At the end of the check, the Office Update page lists the available downloads to update your Office.

3. **Find and select Outlook Update With BCM 2.0 in the list and follow the Download And Installation Wizard until the end.**
   - If the update procedure can’t find the BCM update, use the Microsoft site search and search for Downloads, type BCV2UPD.exe, and click the Go button. The next page shows the downloads (see figure).
   - After the installation procedure, open Outlook. A new wizard should begin automatically, asking whether you’d like to use BCM with your current Outlook profile. Click Yes, and the BCM Database installation starts and is ready for use.
You can use BCM as an entry-level solution for customizing your sales and marketing activities. Instead of customizing Outlook Contacts for use in sales, try using the Business Contact or Account forms in BCM. Instead of using Tasks to control your business opportunities, share the BCM Opportunity form with your team.

With BCM, no longer will you leave notes in your shirt pocket and ruin them in the laundry. You can quickly record important remarks from phone calls. And you no longer have to open your billing system and build a report to check a customer sales report — a process that takes more time than you feel is worthwhile. Thankfully, BCM solves these problems by integrating all your customer information in one place and even synchronizing with your Pocket PC.

Keep in mind that BCM is designed to work best when integrated with MS Accounting 2006.

Today, many businesspeople visit customers and write notes while on the go. Now you can have BCM on your Pocket PC and synchronize it with your office PC. (The BCM for Pocket PC doesn’t work on Smartphones, Palm Pilots, and BlackBerries.) To download Business Contact for the Pocket PC, visit the MS Office site, select Downloads from the Search drop-down list, type Business Contact For Pocket PC, and then click Go to start the search. The next page displays the download information. The download contains two parts: a sync provider for Microsoft Active Sync and a program residing on the Microsoft Windows Mobile Pocket PC device.

### Getting Information into BCM

After installing BCM, open Outlook and find the new Business Tools button on the toolbar. This button and its drop-down commands are how you access all BCM lists, forms, and reports. When you click the Business Tools button, a drop-down menu with the following commands appears:

- **Accounts** is where you add companies as customers by simply entering the account information into the Account form. The form content looks like a Contact form, designed with fields for classifying customers, such as Rating (from Excellent to Poor), Status (Current or Overdue), and Business type (Public or Private company). You can also include marketing information fields, such as Source Of Lead to record information about where the lead was generated. But the most important fields are the Account History items that list and link all customer actions — from phone calls to proposals — giving full customer activity information on a single page. (For more on adding information, see the section “Entering Account information,” later in this chapter.)
Business Contact is where you record information about individuals — whether the customer is an individual entity or an employee of your corporate customer. You can also use this option to link in an Account form a person’s information to the company he or she works for. You find all contact fields plus financial information and customer preferences (for recording the preferred way in which your customer wants to receive information — from instant messages to face-to-face contact) in this option.

BCM adds two new folders under the Contacts group so that you can split your contacts in the following way: The Outlook Contacts List for Personal relationships, Business Contact to record your customer information, and Accounts to record your corporate or other large customers. Moving your current contacts from Outlook to BCM is as easy as selecting the contact and then dragging and dropping it into the desired BCM list.

Opportunities is where you enter any sales opportunity, from a request for information to a quotation. Any customer activity should generate a new business opportunity. The Opportunity form is designed to track each potential sale from a probability of 0 to 100 percent, from a prospective customer to a closed sale, tracking each step in the sales process until the sale is made. The Opportunity folder is under the Tasks folders list. An opportunity cannot be saved unless it’s linked to an Account or Business Account.

Product And Service Items List is where you enter information about the products or services your company offers. They’re organized as a price list or sales proposals that include details about the service, number of hours, the materials list, and, at the bottom, the Total Value. The BCM Product And Service Items form is used mainly to quantify the item and value in a quick and easy format. To use the form, you’ll likely have to adapt your products or services descriptions to fit the existing fields. To find out how to do so, see the section “Overcoming BCM Limitations,” later in this chapter.

Finding disappearing BCM commands

Sometimes BCM commands vanish from your Outlook like a ghost. That’s because when Outlook has a software conflict, it disables the add-in software such as BCM. To check what is happening with BCM, choose Help: About Microsoft Office Outlook. When the About Microsoft Office Outlook dialog box appears, click the Disabled Items button. The Disabled Items list box opens. Select the BCM file and click Enable. The BCM commands are now on again.
Entering Account information

Chapters 4 and 5 show you how to create a company profile with multiple company information by using Outlook. Now the BCM Accounts form offers a predesigned form with some company information fields that may just suit your business as is. Here’s how to enter information in the ready-made fields:

1. **Click Business Tools and choose Accounts.**
   The Accounts list opens.

2. **Click the New button to begin a new account.**
   A blank Account page opens (see Figure 6-1).
   The Account page is designed to hold company information. For personal information, use the Business Contact form. (See the section “Entering the Business Contact information,” later in this chapter.)

3. **Complete the contact information.**
   The Account and Business Contact form can have duplicate information, such as the same phone numbers, Web site, and e-mail address for the Account name and the Primary Business contact. Don’t type everything twice. When adding a contact, you have the information on the Business Contact form.

![Figure 6-1: The Account form is designed for company information.](image-url)
This form does contain some fields that the Outlook Contacts form doesn’t offer, including the Account name field, which holds the name of the company and the Primary Contact field, which links a Business Contact (a person) to the account.

4. **When you get to the Account Financial Information, classify your customer financial information.**

You can seamlessly integrate the customer financial information from your accounting system from MS Accounting or by importing the data from other products. Having customer information in front of you helps you negotiate according to the customer status. The following three fields help you classify your customer financial information:

- **State**: Select either Active or Inactive. An Inactive customer is an older customer that hasn’t ordered for a long time.

- **Status**: Select either Current or Overdue to mark each customer’s financial status.

- **Rating**: Select Excellent, Good, Average, Fair, or Poor to rate the account’s performance.

In addition, the Categories button opens the Categories list. (See Chapter 4 for more on categories.)

5. **After you add your customer information, click the New button in the Account History Items.**

Your information appears in the Account History list, which includes all items related to the Account. After you click the New button, the following commands are available to link with the Account:

- **Business Note** is where you can enter any information about the account, like a tip or a comment that may be useful in the future. You also get a time stamping when you save the information.

- **Opportunity** creates a new opportunity linked with this customer. For more on the Opportunity page, see the upcoming section “Tracking Business Opportunities.”

- **Task** opens a new task linked to this customer.

- **Appointment** opens a calendar appointment linked to this account.

- **Phone Log** allows you to enter information while you’re on a call and includes time stamping and a field to type the information about the phone calls.

- **File** links any file with the account and includes the date that it was linked. You can link a proposal or any project-related file.

6. **Click the Details tab.**

The second page of the Account form opens.

7. **Enter your account details, as shown in Figure 6-2.**
You can include the following information about your account:

- In **The Business Type and Location** area, you can select your customer so that you take actions based on customer type or geographic location. In **Type of Business**, select from the following options: Public Company, Partnership, Private Corporation, Non Profit Corporation, Sole Proprietorship, and Other. In **Territory**, you can choose from eight geographic classifications.

- In the **Source** area, you can record how the customer found your company and who opened the Account. In the **Source Of Lead** box, you can help measure results from every marketing action by selecting the way that the customer found out about your business: Advertisement, Direct-Mail, Employee Referral, External Referral, Trade Shows, Public Relations, Partner, and Seminar. In the **Initiated By** box, type the name of the person who started the new relationship so that you can follow up with whoever is taking care of the customer.

- The **Record Details** area helps you keep track of the customer by recording general information, such as who has been in touch with him. The fields give a time stamping for the record creation and the last user modifying the record by login name if you’re sharing the BCM database and asking everyone to use his own login.

8. Type any notes or comments you have and then close the window.
Entering the Business Contact information

The Business Contact form looks like a mix of the Account form plus personal detail seen on the Outlook Contacts, such as birthday or an assistant’s name. The form has two objectives: to manage the Business Contact as a customer with credit and marketing fields and to link personal contact information to the company information.

For example, say that Daisy has a beauty parlor, and Mary St. Louis is one of her best customers. Every time Mary calls her shop, Daisy opens her Business Contact rather than her appointment book. Here’s how you can do the same:

1. **Click the Business Tools button and choose Business Contact.**
   
The Business Contact list opens.

2. **Select the customer’s name.**
   
The Business Contact page appears, as shown in Figure 6-3.

3. **Type your information into the form.**
   
The Business Contact Form has the same fields as a contact, plus the Contact Financial Information and the Business Contact History areas:
   - The **Contact Financial Information** area on the Business Contact has the same financial information fields as the Account page and is useful when you’re selling to a person, not to a company, such as when you run a beauty parlor or any personal service business.
   - The **Business Contact History** area has fields that allow you to attach all information related to an account, along with information about each individual. These fields help you organize information based on each person within a large account. When you’re selling to a person, you can easily see what you charged him or her in the past. In addition, you can also see whether your customer calls for estimates a lot and then always orders only the cheaper item, which helps you develop strategies to understand and increase your relationship with each customer.

After installing BCM, keep the Contacts List for your personal contacts, suppliers, and others. Move all your customers to the Business Contact and Accounts. You can move business-related contacts from the Outlook Contacts List folder to the Business Contact or Accounts folder by selecting, dragging, and dropping the contact into the Business Contact or Accounts folder.

4. **Click the Details tab.**
   
The only new information is the Contact Preferences area, which shows how communication should be made with this customer. The Method Of Contact box is a great tool for recording how your customer prefers to receive information (see Figure 6-4).

5. **Complete the Details form and then close the form.**
Figure 6-4: In the Business Account Details tab, you can record the little details that make a difference.

Figure 6-3: The Business Contact form helps to manage the Business Contact information.
Tracking Business Opportunities

A business opportunity is the chance to sell your product or service to an Account or Business Contact from the very first prospecting contact all the way to “closed and won” or “closed and lost.” Recording the contact information and linking each opportunity detail helps you track, evaluate, and negotiate the opportunity until it becomes a closed order. The Opportunity History Items allows you to link phone logs, tasks, business notes, and files related to this opportunity so that you have all your information in sight. To enter the Opportunity information into BCM, follow these steps:

1. **With the customer Account or Business Contact open, click the New button on the Business History Items.**
   
   If you’re not sure how to open the Account or Business Contact forms, see the sections earlier in this chapter. A menu appears.

2. **Choose Opportunity.**
   
   The Opportunity page opens, as shown in Figure 6-5.

3. **Complete the page.**
   
   Here are few pointers to keep in mind as you complete the form:
   
   - The *Opportunity* data links the Opportunity to a Business Contact or Account in the History Items list. The *Opportunity Title* holds the name or title of each opportunity so that you can remember the content when reading history or summary reports. The *Link To* field links the Opportunity to an Account or Business Contact. When you open from the History Items, the Opportunity is already linked to its source.
   
   - The *Status* area has three fields to track and evaluate the way the opportunity is flowing to a closed order. *Sales Stage* records the sale’s current stage, such as Prospecting, Qualification, Needs Analysis, Proposal/Price Quote, Negotiation/Review, Closed Won, or Closed Lost. Recording the appropriate stage helps you build your reports and take actions according each stage. *Close Date* helps you forecast when the customer expects to close the order and keep it in your priorities, based on the closing date. If you type the format as mm/dd/yy, it is auto-adjusted to the format weekday mm/dd/yyyy. The *Probability* field is typed in as a percentage reflecting how likely you are to win the order.

   Reading the Opportunities list, notice that the Expected Revenue field is the Opportunity value multiplied by the Probability percentage. If you open a $1,000 opportunity with a probability of 10 percent, the expected revenue is $100. The same opportunity with the probability of 50 percent yields an expected revenue of $500.
Background information has four fields, and two of them — Source Of Lead and Initiated By — already exist on the Account and Business Contact. These fields are duplicated because an Opportunity can start by a new marketing activity and can be initiated by another person. Competitors helps you evaluate the game and know who is competing for a particular sale. Type (of order) classifies the order by using Standard, Delivery, Bulk Order, or Special order.

Opportunity History Items shows various items linked to the opportunity. The New button allows five types of items to link: Business Note, Phone Log, Appointment, File, and Task. Remember that history items are also available through the Account and Business Contact forms.

Although the Opportunity folder is filed under the Outlook Tasks folder, no reminder is available. To use any reminder, you have to open and link an Opportunity to a Task.

Product And Service Items displays a list of items inserted on the proposal. Click the Add button to enter new products or services. See the next section, “Listing Your Products and Services,” for more detail.

4. Click Save And Close.
Opportunities recorded in this format helps you track each opportunity among by Account or Business Contact to improve your control of the sales process. When you complete a sales cycle, you can create quotes, sales orders, or invoices from your Opportunity records if Business Contact Manager for Outlook is connected to Microsoft Small Business Accounting.

### Listing Your Products and Services

When opening a new BCM sales opportunity, you have to specify the product or service requested. Every business has a list of the services and items it sells, including a single lipstick in a drugstore or a brand-new car in a car dealership. A consultant, a legal office, or a psychiatrist charge services by the hour and estimate the number of hours per service.

The BCM Products And Service Items List has only four fields to list your product or service and insert in any BCM Opportunity. You need to add a product or service in order to specify what is in your sales proposal. To insert the item:

1. **Click Business Tools and choose Product And Service Items List.**

   The Product And Service Items List dialog box appears, as shown in Figure 6-6. It contains an empty list with columns for the Item Name, Description, and Unit Price to describe the product or service, as well as the buttons Add, Edit, Delete, and Import. Clicking these buttons lets you modify your list.

![Figure 6-6: The Product And Service Items List is ready to insert new items.](image)
2. To add an item, click Add.

The Add Or Edit Item dialog box, shown in Figure 6-7, appears. It contains four fields:

- **Item Name**: Type the product name or service item.
- **Description**: Enter the item’s description or the type of service.
- **Unit Price**: Include the price of a single unit of this item.
- **Default Quantity**: Indicate the number of items that you typically sell at one time.

Only these four fields are available to include your product or service item in BCM list. If you think that your product or service doesn’t fit into these fields, read the next section, “Overcoming BCM Limitations,” to find your solution.

3. Complete the fields with your information and then click OK.

Your new item is added to the list.

**Importing an existing list**

If you already have an existing list, then you can simply import it directly into BCM with a wizard if the field names are exactly the same; otherwise, you have to make the imported fields compatible with the Product And Service Items List. You can do so by mapping the two sets of fields to each other.
To import the items, your list must have the same columns and titles and be saved as a file with comma separated values (.CSV). In Excel, instead of saving the file in the usual way (as .XLS), choose Save As and then select CSV Comma Delimited from the Save As Type list. Start the import procedure by browsing the file on the wizard when it’s ready.

To import your current list:

1. **Click Business Tools and choose Product And Service Items List.**
   The Product And Service Items List dialog box appears.

2. **Click the Import button to import or change the current list.**
   The Import Products And Service Items Wizard appears, as shown in Figure 6-8.

3. **Click the Browse button to locate the file to import.**
   The Files list appears.

4. **Double-click the file to import.**
   The file is ready to import.

5. **Select one of the two options available: Add The Items In This File To The Existing List or Replace Existing List With Items In This File.**

6. **Click Import.**
   Your imported list is ready.
Linking your proposal

Say that Assai Healthy Juices requests a quote for Açai fruits sold in containers. The fruit suppliers send a detailed proposal document and give the following product quote:

**Product Quote for Assai Healthy Juices**

<table>
<thead>
<tr>
<th>Item name</th>
<th>Açai</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Container</td>
</tr>
<tr>
<td>Quantity</td>
<td>1</td>
</tr>
<tr>
<td>Price</td>
<td>$123.00</td>
</tr>
</tbody>
</table>

Unfortunately, you can’t use the Product And Service Items List to hold and identify the size of the fruit, the net weight, the container’s net weight, whether the fruit is fresh or frozen, or the average fruit quantity per container. However, you can link to the proposal:
With the Opportunity page open:

1. **Click New under Opportunity History Items and choose File.**
   The Link File dialog box appears.

2. **Double-click the importing file.**
   The Fruit Supplier Opportunity to Assai is ready (see Figure 6-9).

You can use the Opportunity page for any kind of business.

---

**Overcoming BCM Limitations**

Business Contact Manager is a great tool if you understand how to use it for your benefit and overcome its two major limitations:

- **Older versions of BCM work as stand-alone units not allowing sharing among several users.** Upgrading your BCM to Version 2.0 allows database sharing among several users. If you’re using an older version, get online, choose Help in the Outlook toolbar, choose Check For Updates, and then follow the instructions to upgrade your system. To use BCM’s sharing features, your Outlook program must be installed on a computer running Windows XP Professional; BCM doesn’t share under Windows XP Home Edition.
The Product And Service Items List has a fixed format with only three available fields to import data from your sales and accounting system. You have to adjust the fields from your business system to fit into the three importing fields: Item Name, Description, and Unit Price, which limits the way of quoting services and products. Quoting the same product as one unit, one box, or one container means you have to open one line item per packaging. You can’t import your current inventory quantities because BCM doesn’t import quantity fields. To have the same item on the different packaging on the same line, you have to define the meaning of your unit quantity, whether it’s 1 shampoo bottle or a box containing 12 shampoo bottles. Adapting each Item Name, Description, and Unit Price for a service, a project, or product is the challenge of using BCM in any business.

Say, for example, that Daisy works in a computer and software maintenance company and receives a request for a quote to install and share the new BCM 2.0 in five workstations. She writes a detailed proposal, including minimum requirements like a Windows XP Professional in the workstation that will share the database, and estimates the number of hours for her service. She creates a new item to record this proposal:

**Service Quote for Installation Software**

<table>
<thead>
<tr>
<th>Item Name</th>
<th>Software installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>BCM 2.0 shared in 5 workstations</td>
</tr>
<tr>
<td>Quantity</td>
<td>1 service</td>
</tr>
<tr>
<td>Price</td>
<td>$120.00</td>
</tr>
</tbody>
</table>

Daisy uses the Item name field to specify the service and the Description field to list what was required. She also links the proposal as a file in the Opportunity History Items. Adapting her service to the Product And Service Items List, you can apply Daisy’s idea in any type of business.

In addition, say that Mark works in a legal office, and a new customer requests a quote for handling the company’s legal affairs. He writes a proposal explaining what his office services cover and sends it as $250.00 per hour, estimating ten hours per month of service. He estimates the proposal at 120 hours a year and sets it up in the following way:

**Service Quote for Mark’s Legal Services**

<table>
<thead>
<tr>
<th>Item Name</th>
<th>Legal support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Business legal support contract 10h/month</td>
</tr>
<tr>
<td>Quantity</td>
<td>120</td>
</tr>
<tr>
<td>Total</td>
<td>$30,000</td>
</tr>
</tbody>
</table>
Likewise, a cosmetology clinic can create a Product And Service Items List for Botox skin-care applications and laser skin-care services in the same way as a legal office or a computer service. A store or small industry can adjust its product list to fit BCM’s available fields by using the preceding examples.

Sharing your database

The Sharing Wizard gives you an option to print the step-by-step database sharing procedures. First, you have to give permission for your database to be shared. Second, you have to set up the other user’s PC to be connected to your database. If you find security problems during the installation, don’t waste your time trying to solve them and risk making your computer insecure. Instead, call the company that gives you technical support and ask it to complete the setup for you.
Chapter 7

Working with BCM Reports

In This Chapter
▶ Choosing from BCM’s standard reports
▶ Filtering reports
▶ Working with reports in Microsoft Excel

Business Contact Manager (BCM) Version 2.0 is a free add-in to Outlook in the Office Professional and Small Business edition. Using the BCM’s reports, you can have snapshots of the entire team’s activities, which makes BCM an important management tool. This chapter shows you how to get value out of BCM reports.

Getting Familiar with Your Report Options

Reports are not useless lists forgotten in the bottom of a drawer, but information that is presented and organized in a way to help you take actions or make decisions for your company. BCM offers more than 20 ready-made report formats, and the BCM Reports menu contains reports divided into four groups: Accounts, Business Contacts, Opportunities, and Others (with 20 more options). The rest of this section describes many of the reports available in each of these groups.

BCM works with two kinds of customers and offers reports related to each group:

- Business To Business (B2B), when your customer is a business organization
- Business To Consumer (B2C), when your customer is a person
Working only with people as customers (B2C,) you do not use the Account entry form and related reports, but the Business Contacts entry form and related reports. Clicking the Business Tools button and then the Reports and Business Account commands is your path for the exclusive B2C reports. A door-to-door cosmetic representative or a real estate dealer specialized in houses are Business to Consumer examples.

If you work with business organizations, you use the Account entry form to enter the company information and the Accounts reports to see that information in various ways afterward. You also use the Business Contact entry form to hold information about each employee at the company and then link these individuals’ records to the company record in the Accounts. Clicking the Business Tools button and then choosing the Reports and Accounts commands is your path for the B2B exclusive reports. An industrial parts salesperson is an example of a user of the Accounts reports. An Office product reseller store deals with both types of business, supplying business organizations as well as individuals.

No matter which report you create, the result looks roughly the same: The PC processes and opens your report in a list format.

**Accounts reports**

The Accounts reports are used when you deal with B2B customers or business organizations as customers. You can use the reports as a simple list or to detect and solve certain problems, such as collecting on overdue accounts. Read the following explanations to select the report you need for your business. Clicking the Business Tools button and then choosing the Reports And Accounts command is the path to these reports:

**By Status:** Status has only two options, Current and Overdue. This report is most useful for seeing and working with your overdue accounts.

**By Rating:** The rating report shows five levels: Excellent, Good, Average, Fair, and Poor, and you can create parameters to classify your customer in any of these categories. You can have a list showing you all your customers by classification, thus helping you to explore new strategies and turn good customers into excellent ones. Or you may notice that you have too many poor customers and need to prospect better quality leads. You can use these reports to analyze and work with customers to increase their ratings. Likewise, if you have too many low-rated customers, focus on prospecting new customers with higher potential. To see your Account By Rating report, click Business Tools and choose Reports Accounts By Rating. When the report appears, click View and choose Show Groups (see Figure 7-1).
By Category: Because you can create any category (see Chapter 4), you can identify vertical markets. For example, a fresh fruit distributor supplies customers in different markets, such as restaurants, pie companies, and ice cream factories. Create each category and list them to understand in which vertical market you have a better market share. You can also analyze your profitability within each market and see which one bring more results. Conclusions like “The ice cream market has a better market share but a lower profitability than the desserts market” can help you create new solutions, such as promoting your products in the desserts market by using special recipes or other offerings. Remember that besides the Report option, you can list your accounts by using the view by Category on the Navigation Pane.

Neglected: I call this report forgotten customers. Did your company give up on certain customers or simply forget about them? Is there any new barrier, such as a personnel change or a new competitor in the field? Analyzing the number of neglected accounts can show you problems not previously detected and ways to find solutions. Read the neglected customers’ histories and call the ones that warrant additional contact. Often a phone call to a neglected customer restarts the relationship.
History: When I worked in sales, before any phone call or meeting, I used to read a copy of the customer profile and analyze last actions and unanswered requests. An Account or Business Contact History Report presents the customer’s historical records, which you can use in meetings or read prior to starting new negotiations. Read the customer history before a phone call and print the report to have it in your hands for a meeting.

Quick Accounts List: This report only lists your accounts with the primary contact.

Accounts List with Business Contacts: This report adds every linked Business Contact to the Account where he works. Suppose that you work with a company with people working at home or in different branches. You have the Account entry form for the company and open a Business Contact entry form for each employee you deal with in the Account. This report shows all these relationships.

Business Contacts reports

Use the Business Contacts reports when your customers are people and not business organizations. To access these reports, click the Business Tools button and then choose the Reports And Business Accounts command to select the needed report:

Business Contacts phone list: This report is a simple address list.

By Status: The Current and Overdue status reports are for managing your financials.

By Rating: The rating reports are for showing accounts listed by their rating: Excellent, Good, Average, Fair, and Poor. See the By Rating reports in the previous section for more information.

By Category: Because you can create any category (see Chapter 4), you can identify vertical markets like real estate dealers for people looking for a house under a certain budget.

Neglected: I call this report forgotten customers. Did you give up on certain customers or simply forget about them? Try to call again after a period with no business at all.

History: The Business Contact History report presents the customer’s historical records, which you can use in meetings or read prior to starting new negotiations. To access this report, click Business Tools and choose Reports ➪ Business Contacts ➪ Business Contact History. In the Business Contact History Report dialog box (see Figure 7-2), double-click the desired full name in the Full Name list. The Business Contact History appears, as shown in Figure 7-3.
Figure 7-2: Select the Full Name to see the Business Contact History.

Figure 7-3: Read the Business Contact History before calling the customer.
Other reports

The Other reports offer two options, including the Business Tasks list that filters the Tasks list related to BCM and the Source of Leads, an excellent tool to measure who or what campaign is bringing the customer to your business. Clicking the Business Tools button and choosing the Reports And Others is the path to request the following reports:

✔ Source Of Leads: Measuring what is driving the customer to your company is great feedback to help you measure the return on investment of your marketing actions. This report lists customers by each marketing action and includes a rating. You may find that a particular effort generated 90 percent results, but all were poor customers. The sales results may not be according to your expectation. For example, say that you invested $5,000 to participate in a trade show, and, as a result, over a six-month period, you have five new customers who have ordered $30,000 in products. This investment paid out. Or perhaps you end up with 100 prospects and no deals at all. Evaluate new marketing campaigns and measure the results of your previous investments with the Source of Leads report.

To request a source of leads report, click Business Tools and choose Reports: Others: Source Of Leads. The Report appears. Then choose View: Show Groups. The report displayed in Figure 7-4 helps in moving fast from one group of leads to another, helping analyze your marketing efforts.
**Business Tasks**: Listing the Tasks linked to the Accounts or Business Contacts gives you a sort of pending items list for each customer. It’s like filtering your Tasks to see only those related to your accounts. It’s a great action report that focuses on the customers’ pending issues. Reading your Business Tasks list report daily helps you remember important follow-up actions and select sales priorities before they become overdue.

**Opportunities reports**

The Opportunities reports are the most important for tracking all business going on at your company. Listing your Opportunities in different ways can bring you better business perspectives and priorities. For example, the Opportunity Funnel report lists opportunities by sales stage from prospecting to proposal/price quote. The Opportunity Forecast shows them by most recent due date, giving you the chance to prioritize actions to get the order now. The Opportunity By Product And Service report lists opportunities by each product so that you can determine your most requested products. The Past Due Opportunities report lists opportunities by past-due dates, reminding you to reevaluate and understand these accounts. The Opportunity History report lists the history of a chosen opportunity that can be good to hand carry to a meeting. Clicking the Business Tools button and choosing the Reports And Opportunities command is the path to request these reports:

**Opportunity Funnel**: This report lists your Opportunities by each of the following sales stages: Prospecting, Qualification, Need Analysis, Proposal/Price Quote, Negotiation Review, Closed Won, and Closed Lost. Tracking all your opportunities by status helps you focus your energy on the appropriate next steps, to turn each opportunity into a Closed Won one by one.

**Opportunity Forecast**: Listing all your opportunities by due date by using the Next 7 days, Next 30 days, Next 90 days, and Over 90 days gives you a view of the sequence of opportunities coming due. Listing by due date lets you focus on opportunities that are more important and ready to close.

**Opportunity by Product and Service**: Looking at each item of your current inventory together with your Opportunity by product report helps your company forecast new orders. Figure 7-5 shows an example of a distributor report.

**Past Due Opportunities**: You can use this report to analyze the past-due opportunities to evaluate the problem or to determine whether you lost a sale to a competitor or because you simply gave up the opportunity.
As an example, you can request the Opportunity By Funnel report by simply clicking Business Tools and choosing Reports ► Opportunities ► Opportunity Funnel. The Opportunity Funnel reports opens, as shown in Figure 7-6.

**Figure 7-5:** Forecast new orders with the Opportunity By Product And Service Report.

**Figure 7-6:** The Opportunity Funnel Report lists and calculates values at each stage.
Squeezing the Report to Get Action Information

You can refine any report listed by using the available filters to have the precise information you need. Refining the Account By Status report, you can list the overdue customers to call and fix the payment delay problem.

To understand the whole process, open an Accounts By Status report in the following way:

1. Click Business Tools and choose Reports➪Accounts➪Accounts By Status (see Figure 7-7).

The report opens, listing the Current Accounts and the Overdue Accounts. If you want to work with only overdue accounts — for example, you’re in the accounting or collections department — you may want to show only the overdue accounts. To filter the current report to list only the Overdue accounts, use the Modify Report option.

2. Click the Modify Report button and then the Filter tab in the Modify Report dialog box.

The Filter options appear, as shown in Figure 7-8.

Figure 7-7: The Accounts By Status lists the accounts as current or overdue.
3. From the Field drop-down list, select the field you want to use to filter the records.

In this example, I use the Status field.

4. Select the condition to compare from the Comparison drop-down list.

I selected Equals to have the report find occurrences of the word Overdue inside the Status field that I selected in Step 3.

5. Specify the word or information you want to compare by using the Compare To text box.

In this example, I type the word Overdue. In Steps 3 through 5, I've asked Outlook to find all Status fields that equal Overdue. You can combine other fields with special conditions by using Steps 3 through 5. For example, you can find all records that contain a rating of excellent or good in the report By Rating.

6. Click OK.

The new report lists only the accounts you specified, as shown in Figure 7-9.

You can save BCM reports as Word documents (*.doc), Excel Workbooks (*.xls), Web pages (*.htm), and Rich Text documents (*.rtf) to use according to your needs. For example, using the Excel format allows you to work with your data to create charts and other analyses. (See the section “Designing BCM charts with Excel,” later in this chapter, for more information.)
Filtering the Opportunities Reports

Prospecting opportunities can bring surprises like a request for proposal ten times larger than usual. To analyze the new opportunities, use the Modify reports option to filter Opportunity by Product and Service.

With the Opportunity By Product And Service report open:

1. Click the Modify Report button and then click the Filter tab.
2. Select Total from the Field list box.
3. Select Greater Than from the Comparison list box.
4. Type the value in the Comparison text box.
   In this case, I used $10,000.
5. Click OK.

The filtered report, showing opportunities higher than $10,000, appears (see Figure 7-10). The report shows two top-priority opportunities that can boost the company revenues more than expected.
Using Views Rather than Reports

BCM offers two ways of delivering the same information. First, you have the ready-made reports, as in the Opportunity report By Funnel. Next, you have the view options, like the Opportunity view by Sales Stage. These two listing strategies supply the same information and both can be used for reporting. Comparing both figures, you notice the same information.

Using the Opportunity By Funnel report

The Opportunity By Funnel report gives you the number of accounts and total value at each stage: Prospecting, Qualification, Need Analysis, Proposal/Price Quote, Negotiating/Review, Closed Won, and Closed Lost. The Opportunities View By Sales Stage also shows the closed orders stage but doesn’t show the totals. Still, you can view the list, select it, and copy it to an Excel file faster than using the report.

With the Opportunities list opens, choose By Sales Stage in the Navigation Pane Current view. The Opportunities appears by sales stage in Figure 7-11.

You may find that using view options can be a great substitute for creating and modifying any of the Outlook BCM reports. An already existing view option (or
an easily modified one) may provide you with exactly the information you need — and even be more detailed than similar reports. Because the view options bring the information to the screen rather than to the printer, you can copy the information from the screen to Word or Excel for printing. Before using any report, explore the available views in the Current View window. The Current View options provide listings like By Category, By Rating, and Quick Accounts. If you need a quick view for a certain decision, changing the view can be faster and easier than using reports.

Refining your views

The BCM reports aren’t so flexible as the BCM views to create new reports. I use the BCM view to create my own reports, refine the data and collect the information I need as in the following example.

When your company exists for several years, your database accumulates history. A view to list only the opportunities created or changed in the last 30 days is available. Adding different fields can supply information for a specific time period, generating a concluding report:

1. With the Opportunities list open, select a view.

Selecting the Recently Modified view displays the opportunities created or modified in the last 30 days. You can add the Source Of Leads field to the same list if you like.
2. Select Customize Current View in the Navigation Pane.
   The Customize View (Recently Modified) appears.

3. Click the Fields button.
   The Show Fields dialog box appears.

4. Select Forms on the Select Available Fields From drop-down list.
   The Select Enterprise Form dialog box for this folder opens.

5. Double-click the Business Contact.
   The Business Contact now is in the Selected Forms list box.

6. Click Close.
   The Show Fields dialog box re-appears with the Business Contacts Entry Form fields available to select more.

7. Select Business Contact in the Select Available Fields From drop-down list.

8. Select the needed field from the Available Fields list (see Figure 7-12).
   In this example, select the Source Of Lead field.

9. Click the Add button.
   The Source Of Lead field is added to the view.

10. Organize the order of the fields in the Show These Fields In These Order list box.
Selecting and moving them up or down according to the way you need, the suggestion is always to keep the Source Of Lead and Modified fields side by side to measure the current campaign and if you want the city to work by territory.

11. **Click OK and then Close.**

The Recently Modified Business Contacts with the Source of Lead field is available.

12. **Click the new field column title to sort by type of lead.**

In this case, click the Source Of Lead field. Now you can measure the direct-mail campaign result from the last 30 days by Source Of Lead, as shown in Figure 7-13.

Fortunately, you can customize any view in order to refine your reports. You can use the Business Contacts, Accounts, and Opportunities lists to select the best view to create your own report. Simply select the list and cut and paste it into an Excel workbook to create your own reports. (See the next section for more information.)

![Figure 7-13: The campaign result is listed by Source Of Lead in the last 30 days.](image-url)
Collecting BCM report data as an Excel file enables you to extract and work with the information according to your needs, including transforming the numbers into charts for a better understanding of your business. Likewise, if you choose to copy data from views (as described in the previous section), you can use the Excel instructions in this section to manipulate the data after copying it into Excel.

**Saving reports as Excel files**

You can save the BCM reports as an Excel workbook file, which can help you refine the information and make calculations for your own business. To save any report as an Excel file:

1. **With any BCM report open, click File ➤ Save As.**
   The Save As dialog box appears.
2. **Type the name of the file in the Name text box.**
3. **Select Excel workbook (*.xls) in the Save As text box.**
4. **Click Save.**

**Designing BCM charts with Excel**

An image can be instantly understood with no questions at all. A table of numbers needs to be read, understood, and clarified. Using charts, you have
a self-explanatory image for results or trends. You can save BCM data as reports or views into an Excel file and then turn them into charts.

To create an Excel chart:

1. **Open your saved Excel file.**
2. **Select the data to fit into the chart.**
   
   In this example, I adjust two columns, Product and Value (see Figure 7-14).

3. **To draw a column chart, click the Chart Wizard button.**

   The Chart Wizard begins (see Figure 7-15).

4. **Select Column from the Chart Type in the Standards Types tab area and then click Next.**

   If you want to create a different type of chart, you can choose it now from the chart type list.

   The next wizard page appears, showing the chart model.

5. **Click Next.**

   The wizard now lets you enter a title for the chart and names for the axes.

6. **Type a title in the Chart Title text box.**

   For example, you could use Opportunity By Product.

7. **Type a name for the Category (x) Axis.**

   For example, try Product Items.

8. **Type a name for the Category (y) Axis.**

   For example, you can use the axis Value $.

9. **Click Next.**

   The fourth step of the wizard begins. You can save the chart within the current file or as a new file.
10. Select As A New Sheet in the Place Chart option.

11. Type a filename in the text box to save the new file.

12. Click Finish.

The chart opens, as shown in Figure 7-16.

Figure 7-15: The first step of the Excel Chart Wizard begins.

Figure 7-16: The Product Items chart facilitates the analysis of each product.
By analyzing your BCM reports, you can create marketing programs or business communications without any problem. You can use third-party services or use Outlook automation to broadcast messages from your desktop to specific groups. Read Chapter 16 for step-by-step instructions on these and other marketing procedures.
Part III
Handling Communication and Collaboration

The 5th Wave
By Rich Tennant

“It’s just until we install Outlook 2003.”
Driving a car in rush hour without a driver’s license or knowledge of the traffic rules would be a mess. So are many people’s e-mail Inboxes. Understanding why you send and receive e-mails, including understanding other people’s behaviors (when sending jokes or marketing messages), enables you to detect and avoid unwanted e-mail and then use Outlook’s rules and folders to eliminate them. Your Inbox is a tollgate, not a message parking lot. You can discover the Zen of mailbox management so that you can close your message parking lot and then hire the e-nanny (to organize your mailbox) and the e-office cleaner (to keep your deleted items box clean).

Coaching and supervising a team can be a lot easier when you use Outlook’s collaborative tools. You can request tasks and send invitations (answered by clicking the Accept button) to create stronger commitments than when using regular e-mail messages. Don’t waste your time in long and unplanned meetings anymore. Find out how to plan a meeting and invite people using Outlook’s meeting invitation. Traveling and mobility today means connectivity. You can create a few procedures to evaluate your remote access abroad and then increase your security by carrying and protecting your information in external environments.
Chapter 8

Surfing Over the E-mail High Tide

In this Chapter

- Responding to e-mails
- Cutting down on e-mails
- Creating folders and rules
- Mastering the Zen of e-mail management

Suddenly, like a nightmare, you are drowning in an endless e-mail tide in a sea of senseless messages. People at your side are sending good evening messages by e-mail rather than talking. Personal marketing messages arrive at an alarming rate. You have 25 separate “requests for answer.” It is enough to make you lose track of everything. How do you get rid of it all and wake up from this nightmare?

Understanding Why People Send Messages (And How to Respond to Them)

Consider two important skills for any competitive surfer: observation and practice. The surfing champion spends a month on the beach observing the ocean, getting a good sense of its tidal cycles. Each day, two high tides occur, arriving about an hour later than they did the previous day. Observing your Inbox content over time helps you understand the tides in your sea of e-mail and even take actions to keep tsunamis from coming into your Inbox bay, transforming your Inbox into a dreamer’s paradise.

Separating the wheat from the chaff

Written communication has been around since the Stone Age, with cave drawings from human ancestors trying to tell their stories. One or two
members of the community had the drawing skills. Today, millions of people are writing and reading quickly with the assistance of computers. What makes people read and write e-mail messages? What is important or unimportant for each individual?

Distinguishing the wanted from the unwanted, the valuable from the relatively valueless, is what our ancestors did in their ancient agricultural practices or what a surfer does today when choosing which wave to ride. Looking at your Inbox with thousands of e-mails parked in it is a waste of time and distracts you from your priorities. You can split the Inbox content among desired and undesired messages, personalities, feelings, and needs.

The lack of communication rules can generate nonsense messages. In the professional environment, we use e-mail to send and receive information, proposals, invitations, Tasks lists, and so on. Besides unwanted spamming messages, we receive unsolicited jokes; spiritual, religious, and personal marketing; and even answers sliced into 20 different messages. If you understand what is important to you as well as people’s behaviors and Outlook rules, you’re able to detect and avoid unwanted messages even before they’re written to you.

Unsolicited messages are different than unwanted messages. You can detect and remove unsolicited messages by using anti-spam filters, but unwanted messages from your own pool of contacts can be eliminated before anyone even writes them (see the next section).

You can also adopt several parameters to scan e-mails and classify them according to their content. You can then automate Outlook by using rules and automatically organize your wanted messages or eliminate the unwanted ones.

**Dealing with unwanted e-mails**

Unwanted e-mails come in two forms: unsolicited junk messages and inconvenient social behaviors from friends, workmates, and acquaintances. You can greatly reduce junk mails by turning on Outlook filters (for details, see Chapter 9), but changing a social behavior requires that you adjust your environment and use a little psychology.

Identifying behaviors and requesting behavioral changes when appropriate is a major step in surfing over the e-mail high tide. When you point out a behavior, people think twice about repeating it.
Following are some behaviors you may encounter:

- **Copy maniac**: Messages where your name appears on the cc or bcc line aren’t for your direct action, right? So why do they keep arriving at your Inbox, interrupting your actions? You can use Outlook rules to route these e-mails to a new folder called cc, removing them from your sight. You can then go through the folder at your convenience. A simple analysis of a week’s worth of these stored cc messages (organized by sender or by title) can reveal excessive unwanted messages coming from the same source. You can then identify behavior patterns in your colleagues and eliminate these behaviors before more messages make their way to your Inbox. (See the sidebar “Working with a cc folder” for more tips.)

A boss or any person sending a meeting invitation should do so by using the Calendar invitation features rather than a simple cc e-mail. Meeting invitations create commitment upon accepting them. (Read Chapter 10 for more details.)

- **Personal marketer**: Mark Eteer needs to send daily messages advising you of how good he is and how fine a job he’s doing. People moan about the number of e-mails generated, but don’t know how to solve the problem. You can use rules to move any Mark Eteer messages out of the Inbox and into a special folder. Showing Mark his folder with 25 messages in four days may make him conscious of his behavior and cause him to think twice before he sends any new marketing messages.

- **Procrastinator**: Noko Mitment is a procrastinator, always explaining why his work isn’t ready. Instead of reading ten excuses or schedule adjustments, detect the behavior by using Outlook rules. The rules, used to separate Noko’s messages from the rest, let you show Noko his own behavior and help you work as a team to avoid future procrastination.

- **Reliever**: Cherie Hart is a very sensitive person and sends many advice messages, tips for a better life and a better world, sunsets, angels, and so on. Outlook rules help you detect the behavior and perhaps make it easier to request that she keep it down to one “save the planet” message a month.

- **Joker**: A smile to break up the day is welcome but ten jokes a day? Call Batman to fight your Joker enemy or eliminate his messages by using Outlook rules.

- **Demander**: I want this information now! Why haven’t you answered me? Did you accomplish my request? When will the job be ready? All these questions reflect poor timing and prioritizing compatibility between two people. Understanding a person’s anxiety and the way he or she works helps shrink the demand to its real size.
Soap star: Mary Slicer is an anxious human being, and she sends messages at every step of the job. You can isolate her behavior by using Outlook rules, show her the results, and ask her to keep her messages down to information about key milestones in her project with no step-by-step messages.

Hypervisor: Howis Disnow is an anxious manager demanding status reports and sending messages every minute, interrupting your work. If you share your Outlook Tasks list with him, he becomes aware of your working priorities and progress without the need for repeated status reports, increasing your productivity with no stress. To share your Tasks list with someone, you should use the sharing folder properties if connected to an Exchange server, or you can publish your Tasks list on a server. (Read more about your Tasks list in Chapter 10.).

Working with a cc folder

If you create a folder for all the e-mails you’re copied on, you can sort it by sender to help you identify different behaviors among your coworkers. Analyze each sender’s mail, and you notice his or her behavior, which makes it possible for you to show them new skills for improving their communication by using fewer messages.

Here are a few solutions based on the content you find in your cc folder:

E-mail problem with an individual: Create a folder with the name of the person and apply a rule like, “E-mails arriving from John@Smith.com move to Smith folder.” Later, show the person the unnecessary energy spent with his or her messages. Use this same technique for other behavior patterns.

Company culture promotes an excess of e-mails: Make a presentation to your team showing it the meaningless e-mails. By unmasking the issue, you create the power to eliminate it. Create a campaign, “Less e-mail means more productivity,” using cartoons of the common behaviors identified.

News and other information: Create a News folder and create a rule to send all newsletters to the News folder. Read items in this folder when you have extra time.

Reports: Create a Reports folder with a rule that sends all arriving reports to the special folder. You can create a rule that looks for certain senders or certain words in the subject (like the word report).

Reflections and jokes: Why do people keep sending this stuff? Probably because nobody tracked the problem, measured it, and asked them to stop. People who send regular jokes and advice think they’re sending a smile or a feeling from the heart. Sometimes this is true, but in general, ten jokes a day is more a cause for crying than for smiling. Fifteen pieces of advice a day makes anyone angry. Telling people about it can solve the problem. Otherwise, you can keep using the special folder with the person’s name on it along with the Outlook rule to reroute their messages into the folder. If you’re still receiving ten jokes a day, separate them and block them by using rules.
You probably also receive other unwanted messages and junk messages. You can isolate any message constantly sent by using Outlook rules. Avoiding it is usually a simple matter of revealing the behavior pattern to the person sending you the messages. You can also use Outlook’s junk e-mail filter to eliminate unsolicited messages. (For details, see chapter 9.)

Using Outlook rules and creating new folders can enable you to detect, analyze, and eliminate messages before they’re written, thus changing unwanted behaviors. When a behavior is caught and exposed, the sender knows the behavior isn’t welcome any longer and the environment itself helps eliminate those e-mails. In the upcoming section “Using Rules to Eliminate E-mails,” you discover how to create new folders and use Outlook rules to drive messages straight into them.

### Classifying wanted messages

You can classify desired messages according to the action needed:

- **No answer required:** Newsletters, informative e-mails, newsgroup e-mails, and so on are messages that don’t demand an answer. You can have Outlook rules file them for you in a folder called something like News, Info, Suppliers Info, and so on. Open and read these e-mails at your convenience.

- **Action required now:** Answer now before you receive a “Where is my answer?” message. Send a response even if you don’t have the complete answer. A response stating “I’ll get back to you with an answer within 48 hours” can help eliminate follow-up messages from the sender.

- **Actions required later:** Although every e-mail message has a follow-up flag with a pop-up alarm reminding you to complete the action, I prefer to transform any pending-action e-mails into Tasks by dragging and dropping them into the Tasks list. The Tasks list is the best checkpoint for to-do items. To read more about using Tasks and e-mail, see “The Zen of Inbox Management,” later in this chapter.

### Introducing Outlook Rules

Can you imagine what traffic would be like today with no rules and no driver’s licenses? At the beginning of the 20th century, automobiles were a new technology for a happy few. There were no traffic jams and few rules. No driver’s licenses were needed, and few accidents happened. After a few years, cars became popular and soon obstructed the available roads until modern highways were built.
The same is happening with electronic messages; your Inbox today looks like a Disney parking lot avalanche during summer holidays. To manage e-mail traffic, you have to use the same techniques used for cars: Create rules and develop your driving and navigating skills.

Thankfully, the Outlook Rules Wizard is a powerful tool for eliminating problem e-mails. Using rules, you can apply your own criteria to move or block e-mails and set up alarms that help you surf the e-mail high tide.

Beginning to organize your e-mails

When you first start to organize e-mails, I always suggest keeping on top of the Inbox by using the Ways To Organize Inbox dialog box. This shortcut lets you start a rule or open a new folder in one click instead of repeatedly choosing the Tools command and following a menu sequence over and over. The Ways To Organize Inbox dialog box provides helpful shortcuts for selecting e-mails and taking actions on them one by one. It also contains a button for creating new folders.

To open the Ways To Organize Inbox dialog box, simply choose Tools➪Organize. The Ways To Organize Inbox dialog box appears at the top of your current mailbox, as shown in Figure 8-1.

Figure 8-1: The Ways To Organize Inbox dialog box appears in your Inbox, letting you start a rule or open a new folder in just one click.

Alternatively, you can use the Rules Wizard to manage groups of messages by using characteristics like sender, keywords in the Subject line, and so on.
Using rules to eliminate e-mails

Some e-mails, such as the ones you’re copied on, don’t require action and aren’t urgent. Because you don’t need to read them as they arrive, you can remove them from your Inbox and send them directly to a folder that you name. You can then access these e-mails at your convenience.

There are two steps to this procedure: First, you create a folder, and then you create a rule for filing these messages into the new folder the moment they arrive.

Creating a folder

To create a folder:

1. Click the New Folder tab at top right of the Ways To Organize Inbox dialog box.
   
   If you don’t see the Ways To Organize Inbox dialog box, refer to the section “Beginning to organize your e-mails,” earlier in this chapter.

   The Create New Folder dialog box appears, as shown in Figure 8-2.

   ![Create New Folder dialog box](image)

   Figure 8-2: You can name your new folder anything you want.

2. In the Name text box, type the name of your folder.

   For example, I typed cc for a folder that contains all the e-mail messages I’ve been copied on.
3. Make sure that Inbox is highlighted in the Select Where To Place The Folder list.

4. Click OK.

Your new folder is ready.

Creating an e-mail rule

After you have a folder ready (see preceding section), you can create a rule that screens every arriving message and files your message in the appropriate folder.

For example, say that you wanted to automatically archive messages copied to you. This rule gives Outlook an order: Check arriving e-mails, and when your address is not on the To list, file the message in a cc folder. (For more on managing a cc folder, see the sidebar “Working with a cc folder.”)

To create a rule:

1. Click the Rules And Alerts tab on top right of the Ways To Organize Inbox dialog box.

   If you don’t see the Ways To Organize Inbox dialog box, refer to the section “Beginning to organize your e-mails,” earlier in this chapter.

   The Rules And Alerts dialog box, shown in Figure 8-3, appears.

![Figure 8-3: The Rules And Alerts dialog box lets you lay down the law.](image)

2. Click the New Rule button.

   The Rules Wizard appears, as shown in Figure 8-4.
4. Select Move Message From Someone To A Folder in Step 1.
5. Click Move To The Specified Folder in Step 2.
   The Choose A Folder dialog box opens.
6. Choose the folder you want to move the message to and click OK.
7. Click Next.
   The next dialog box, shown in Figure 8-5, allows you to choose a condition.

8. Select the condition you want and click Next.
   For example, if you want to move all e-mails that you’re cc’d on to a folder, select Where My Name Is Not In The To Box.
9. In the next dialog box, select the action that you want and click the Next button.
   For example, if you want to move the e-mail to a certain folder, select Move It To The Specified Folder.
   When you click the Next button, the Are There Any Exceptions? dialog box appears.
10. Click Next if you don’t have any exceptions.

The Finish Rule Setup dialog box appears, as shown in Figure 8-6. Outlook automatically inserts a name for you in the Step 1: Specify A Name box.

11. Accept the name Outlook suggests or type a new one.

12. Choose Run This Rule Now On Messages Already In “Inbox” if you already have a lot of cc messages in your Inbox; if you don’t, skip to Step 13.
This option applies the new rule to all existing messages in your Inbox.

13. **Make sure that the Turn On This Rule option is checked and click Finish.**

Figure 8-7 shows a sample rule setup.

![Figure 8-7: The Rules And Alerts list shows the new rule.](image)

**Attaching previous messages**

An industrial site manager complained to me about how much time he was wasting reading messages that go back and forth many times. He has to read from the last to the first message to understand the whole picture and solve the problem.

To avoid confusing back-and-forth messages, configure your e-mail system to reply with the prior message attached instead of being at the end of the message text. To be more effective, this practice should be taught to the whole team as a company rule.

To configure Outlook to automatically attach previous messages when you reply to them is easy. Here’s how:

1. **Choose Tools ➪ Options.**

   The Options dialog box appears.

2. **Click the E-Mail Options button.**

3. **Select Attach Original Message from the When Replying To A Message drop-down list, as shown in Figure 8-8.**
4. Click OK.

The dialog box closes.

The Zen of Inbox Management

The Zen of Inbox management is a set of rules that lets you finish the day with no e-mails parked in your Inbox. To achieve this goal, follow the path to Inbox bliss:

- Think of your Inbox as a tollgate and not a parking lot. Every message that arrives should be read and an action taken to reply, move, or delete it.

- Remember the John Wayne rule: If the sender is unknown, delete first and ask no questions. Don’t be distracted by what’s on the Subject line.

- Read the e-mail now, answer it, and then move it to the appropriate folder or delete it.

- Reply immediately to all messages that require short answers and then delete the original message and file your reply if desired.

- For requests that you can’t answer immediately, reply by informing the sender that you’ll get back to them when you have a full answer. Drag and drop the requested message to become a new Task.

- Don’t keep any message overnight in the Inbox. The Inbox is a tollgate, and long-term parking is prohibited. Four exit lanes are available for your message: delete, answer now, move to file, or drag and drop to become a Task.
For messages that require more than the current day to answer, drag and drop them to your Tasks list. Set up the Reminder to schedule your time to work on each Task. Having all your pending actions in one list helps you establish priorities. You can see an e-mail dragged and dropped into the Tasks list in Figure 8-9. (Read more on this topic in Chapter 10.)

**The Art of Sending Messages**

Sending messages means paying attention to the other individual. It means thinking about his ability to receive and understand your message and writing in a way that satisfies the reader while communicating your message. Who is your recipient? How should you write to get and keep your recipient’s attention?

- Explain the objective of your message in the subject line.
- Summarize the objective of the message at the beginning. If it’s long, explain it step by step.
- Inform the recipient of any due dates.
- Before copying anyone, ask yourself why this person needs a copy.
- Attach the sender’s message when replying to it. Avoid long, drawn-out e-mail conversations.
- Use the telephone to clarify doubts instead of starting an inglorious e-mail battle.
- Revise the message again before pressing the Send button. Keep the following question in mind: Will the reader understand the meaning of this e-mail?
Use Tasks rather than e-mails to request actions from people in your company. The Tasks requests increase commitment when coworkers receive and accept the Tasks. Read more on using Tasks in Chapter 10.

Use the Invite attendees feature in the Calendar to schedule a meeting instead of writing and sending e-mail invitations. (Read more on this feature in Chapter 10.)

Request a read receipt for a message instead of calling the person to confirm that the message arrived (or worse, sending an e-mail to confirm the arrival of the other e-mail). In the e-mail form, click the Options button, and in the Options dialog box, select Request A Read Receipt For This Message.

Working in sales or any business associated with emergencies, you must be online full time and check your e-mail constantly. But for most other professions, you can probably open your Inbox every couple of hours or once in the morning and once in the afternoon. Think about working offline and reading the e-mails according to your business cycle with fewer interruptions.
Chapter 9

Managing E-Mail Cleanup

In this Chapter
- Eliminating garbage
- Taking the anti-plague medicine
- Organizing the mailbox fast
- Eliminating fraud

Cleaning up your house is not only about removing the dust, scrubbing the bathrooms, or washing your dishes; it’s also about organizing your closets and disposing of items not needed anymore. Imagine a cup of yogurt open for more than a year in your refrigerator. It would smell pretty awful!

A computer without file organization and proper cleanup can be worse than a refrigerator full of old food; the odor is terrible, and it’s awful to clean and organize again. Keeping your mailbox clean and organized is easier than you think when you apply the following concepts and rules outlined in this chapter.

Eliminating Trash

Before throwing old or unused stuff into the garbage or selling it in a garage sale, you have to organize and evaluate what you’re dealing with. The same is true with your computer but with one major advantage: You can use Outlook tools to help you organize the information and create an automatic disposal system for you.

Filing valuable information

Many people create folders for each customer or supplier and file all messages exchanged into the folder for archival purposes, which makes for some very large folders. If you receive an e-mail and answer it, then filing the sent message (your reply) means you’re filing the original message and the answer all in one message. You can therefore delete the original message.
You can use rules to move sent messages into appropriate customer folders instead of storing them in the Sent Items folder. This technique creates an automatic archival system without unnecessary e-mails taking up space. (Read Chapter 8 about using rules to eliminate e-mails by sending them to a specified folder.)

**Stomping out junk e-mail, the computer plague**

Hollywood directors often create terror films with plagues of cockroaches, bees, and locusts. The junk-mail plague is almost as disruptive. Internet providers often use strong firewalls to fight this hazard, but Outlook has some junk-mail options of its own. For example, you can keep a list of recipients to block and place senders or their domains on the list in just a few clicks. You can also use Outlook’s adjustable junk-mail filter.

Outlook has three main lists for managing incoming e-mail:

- **Blocked Senders list:** People or domains from whom you don’t want to receive any message.
- **Safe Senders list:** People or domains from whom you want to receive any kind of message.
- **Safe Recipients list:** People you’re sending messages to now and want to receive their answers.

You can use these three lists to eliminate a good portion of your incoming e-mails and focus on important messages.

**Blocking junk mail**

To block a person or domain from getting an e-mail to your Inbox, follow these steps:

1. **Select the sender’s message in your mailbox.**
   
   The sender message is highlighted.

2. **Choose Actions ➪ Junk E-Mail ➪ Add Sender to Blocked Sender List.**
   
   You’ve now notified Outlook that this sender is not welcome in your Inbox, and Outlook will move all his messages to the Junk E-mail box.

**Setting up your Safe Senders list**

Add all e-mail addresses in your Contacts folder into the Safe Senders list when setting the filter for Safe Lists Only. To do so:
   The Junk E-Mail Options box appears.

2. Click the Safe Senders tab.
   The Safe Senders dialog box appears with a permission list of e-mail addresses to be received by you. Add selected names to this list. This list works only when selecting the Safe Lists Only in the Junk mail filter to route all other e-mails to the junk mailbox.

3. Select the Also Trust E-Mail From My Contacts check box.
   After you select this option, you don’t see Contact e-mail addresses in the list. However, the Junk E-mail Filter allows all e-mail addresses in your Contacts folder to pass through to your Inbox.

4. Click Add to add one e-mail or domain in your Safe Sender list.
   The Add Address Or Domain dialog box appears.

5. Type the e-mail address, such as name@example.com, @example.com or example.com.
   The two latter examples allow e-mail addresses for an entire domain to contact you, while the first example specifies a single individual.

6. Click OK to add the name to your list.

**Setting your filter options**
Part of the security and productivity of your e-mail messages is under your control. You can use no e-mail filter at all or apply a higher level of security, such as allowing only those listed in the safe senders list to get messages into your Inbox.

   The Junk e-mail filter options appear. Clicking the tabs Safe Senders, Safe Recipients, and Blocked Senders display their respective mail lists, enabling you to add or remove any address or domain.

2. Click the Options tab to see the filtering levels.
   The junk e-mail filter has five levels that move incoming junk-mail messages to the junk-mail folder until they’re deleted.

3. Change the level of junk e-mail protection according to your needs.
   I suggest the low filter option day by day, but sometimes the junk-mail tide becomes a tsunami. If it does, change your filter to Permanently Delete Suspected Junk E-Mail until it’s over.
Helping you out: The e-nanny

When you were a baby, no matter what kind of mess you made, your mom, granny, or nanny would clean and organize it for you. Outlook 2003 has an Organize tool that works like an e-nanny, cleaning out your excess e-mails.

To call your e-nanny, simply choose Tools ➪ Mailbox Cleanup. The Mailbox cleanup, like a nanny, cleans the living room instantly but does not generate daily or weekly cleaning routines. The Mailbox Cleanup dialog box, shown in Figure 9-1, provides a convenient set of options that help you organize your e-mail folders immediately:

✓ View Mailbox Size button: Click this button to see the size of each folder.

✓ The Find button: Lets you set values for older than or larger than messages to look for and delete.

✓ AutoArchive button: Click this option to transfer older files to your Archive file. (See the section “Automatically archiving old messages,” later in this chapter, to find out more about the Archive file.)

✓ Deleted items options: Choose View Deleted Items Size to explore the items you have previously deleted or choose Empty to clean them out forever.

Figure 9-1: The cleanup options are your personal e-nanny.

Maintaining with the e-office cleaner

If you work in an office, you know that after working hours, the cleanup team cleans the office and performs its maintenance on a regular basis. Likewise,
the e-office cleaner can automatically empty your basket (deleted items folder) on a set schedule. It can also store your older items in the archive folder, and it never misses a due date.

**Emptying your deleted items trash**

To put the e-office cleaner to work and automatically empty your deleted items trash:

1. Choose Tools ➤ Options.
   The Options dialog box appears.
2. Click the Other tab.
   The e-Office Cleaner options appear.
3. Select Empty The Deleted Items Folder Upon Exiting.
   Now, every time you exit Outlook, the e-office cleaner empties your trash folder.

**Automatically archiving old messages**

You can store your old messages (over x days) in the Archive folder provided by Outlook, making your current Outlook folder much lighter. The Archive Folder is a second Outlook folder stored on your computer that you can open at any time to access old data. You’ll have the Outlook.pst file as your working file and the Archive.pst file holding your old data.

Setting up the AutoArchive saves time and organizes your older items for easy retrieval. To set up AutoArchive:

1. Choose Tools ➤ Options.
   The Options dialog box appears.
2. Click the Other tab.
3. Click the AutoArchive button.

The AutoArchive dialog box appears, as shown in Figure 9-2. It can prompt you at a specified number of days to transfer your older but needed files from the Outlook folder to your Archive folder, making your daily Outlook folder smaller and less encumbered. You can archive messages from all your mailboxes or select only your Inbox, and even delete messages over a certain age, such as 6 or 12 months.

You can tell AutoArchive to prompt you every so often (every 60 days, for example) before it performs its function.
4. Enter the desired number into the Run AutoArchive Every XX Days option.

So if you want AutoArchive to run every 60 days, type 60. Before autoarchiving on a regular cycle, Outlook can prompt you for your go-ahead.

5. Click to place a check mark next to the second line, Prompt Before AutoArchive Runs.

You also have the following setup options during autoarchive.

6. Select Delete Expired Items (E-Mail Folders Only) according to your needs.

Selecting Archive Or Delete Old Item displays two more options. The Show Archive Folder In Folder List option displays the Archive folder inside Outlook, and the Clean Out Items Older Than XX option sets at what age items will be removed.

7. Click OK.

Avoiding Fraud: Never Send Personal Data by E-Mail

Phishing attacks use both social engineering and technical subterfuge to steal consumers’ personal identity and financial account information. Social-engineering schemes use spoofed e-mails that lead consumers to counterfeit
Web sites designed to trick them into divulging financial data such as credit-card numbers, account usernames, passwords, and Social Security numbers. Hijacking logos and brand names of banks, e-retailers, and credit-card companies, phishers often trick recipients into responding. To find out more about the subject, visit the Anti-Phishing Working Group site at www.antiphishing.org.

To avoid phishing scams:

✔ Be suspicious of any e-mail with urgent requests for personal financial information.

✔ Don’t believe e-mails directed at you from unexpected sources. Phishers typically include upsetting or exciting (but false) statements in their e-mails to get people to react immediately.

✔ Never give personal data over e-mail, no matter who is asking for it. Phishers typically ask for information such as usernames, passwords, credit-card numbers, Social Security numbers, and so on.

✔ Phisher e-mails are typically not personalized, while valid messages from your bank or e-commerce company generally are.

✔ Distinguish between personalized and addressed-to-you e-mails. Most phisher e-mails have your name on them, but they’re not personally written for you. In other words, they’re form letters.

✔ Never fill out forms in e-mail messages that ask for personal financial information.

✔ You should communicate information such as credit-card numbers or account information only via a secure Web site or by telephone.

✔ Do not believe in any prize you may have won or miraculous offer to release millions of dollars from a former African state secretary.

Tips authorized by the Anti-Phishing Working Group site at www.antiphishing.org
Any business operates with teams, even if you work alone at your home office. There is, at the very least, a kind of unofficial team made up of your collaborators, suppliers, and customers. This chapter reveals how you can use Outlook to keep your team working together and in perfect order.

Maintaining Team Commitment

The most important and fundamental team is that of a simple couple. Two humans surviving together and growing a family — without this basic team unit, you might not be here today. Growing from two people to a family or a tribe, humans have always had to work together. Tribe leaders evolved to help guide the group through dangers and to manage internal problems, such as competition and jealousy. The most basic team commitment in our culture is the wedding ceremony, and it starts with a question: Do you take this person to be your spouse . . . for richer and for poorer, for better and for worse, through sickness and in health . . . until death do you part?

This question illustrates a perfect example of the team commitment: To harbor mutual respect and trust while maintaining a good climate anywhere and any time. One of the ways of creating confidence and respect is by combining and sharing resources. Sharing your goals, Tasks, and information resources with your team makes your business stronger and better. Outlook’s sharing properties can help you share your goals, Tasks, and information with your teams — whether your team is made up of family, business groups, or friends.
Maintaining a working team through good and bad times involves making the commitment to the team. Keeping commitments requires that you negotiate and maintain agreements. Daily actions based on mutual agreements, completed without excuses, is the key to making the team function properly. Your job description (both within a particular project and in the company in general) is an agreement.

Using Outlook’s collaborative tools to apply the following concepts, you can keep your team working cooperatively and efficiently, as well as give your business a boost of team power:

- **Leadership:** The role of a leader is to plan, delegate, supervise, coach, and keep the team moving in the right direction, scoring their goals. Outlook’s sharing and supervision properties can enhance leadership capabilities by helping team leaders zoom in on the players’ work (by reading their Tasks and Calendars). For more on reading Tasks and Calendars, see the upcoming section “Taking Advantage of Collaborative Tools.”

- **Negotiation:** Several steps are involved in achieving an agreement. Negotiating is the art of having two or more sides arrive at a common point or understanding. Outlook collaborative tools help you negotiate requests, such as proposing a new meeting time, saying “No” to a Task request and sending your reply with a new proposal, or coming up with another way to solve the request. For more on this topic, read the upcoming section “Taking Advantage of Outlook Collaborative Tools.”

- **Agreement management:** Having an agreement is not a guarantee of getting the job done. Supervision and coaching can help you avoid failures. The Tasks list helps you manage each team member’s pending Tasks. For more on Tasks, read the upcoming section “The agreement game,” later in this chapter.
Sharing: Companies that share values and information empower their teams more effectively than those that don’t share information. Outlook’s sharing properties empower each team member to get information without interrupting the other players. For more on sharing, see the upcoming section “The goal is sharing.”

Delegation: You are a doer, not a lazy person, and you wish you were an Octopus so that you could work on more jobs at the same time. So, how do you get more brains and arms working for you? Delegating to your coworkers is the answer. Outlook’s delegation tools let your chosen team members negotiate agreements on your behalf (accepting and rejecting invitations), without your having to open your Inbox. Take a breath and plan what you want to delegate. For more on delegation, see the upcoming section “Delegating.”

Commitment: The real commitment is not only a matter of saying yes but also having a willingness to do it. The Outlook Accept or Decline buttons increase the commitment among parts. Few people will click an Accept button without reading and thinking, “Am I willing to do this?” This mental question increases the commitment. For more details, read the upcoming section “The agreement game (Tasks),” later in this chapter.

Using E-Mail Tips to Promote the Calendar

You can use Tasks and Invitation requests to organize your team’s agreements and keep it working together and in unison. Outlook’s supervision and delegation features help move the ball downcourt toward the goal.

One such method is to send an e-mail tip. However, you need to ask yourself the following questions before sending a tip:

- What is the advantage to your team if the members start using this tip?
- Does your team know about the Calendar?
- Does your team know how to use the Calendar?
- Why is your team not using the Calendar?

The advantage of using the Calendar for invitations is saving time. Your team may not be using the product because they don’t know about its benefits.

For example, some managers told the HR department that their teams hadn’t been answering Calendar invitations by using the Accept or Decline buttons in Outlook, thus forcing the team to waste time by using the phone to confirm
the meeting or invitation. So the HR department broadcast an e-mail tip: Please answer the receiving appointment invitation by clicking the invitation buttons to accept or to decline the sent invitation. This communication was necessary because most people didn’t know how to use the Accept or Decline buttons. A tip can bring results when people already have some knowledge of the product. A training session and a campaign to implement the Calendar will bring better results if the Calendar is not generally in use within the company.

Instead, the broadcast tip needed a subject line more like “Save time by using Outlook Calendar for invitations and requests.” The message content should explain the problem and give readers the advantage and solution.

*The problem:* Losing Time due to missed meetings and excess confirmation calls and e-mails.

*The solution:* How to save time by using the Calendar appointments and invitation.

HR should inform the managers prior to sending the tip broadcast and should support the whole team’s use of the Calendar.

Training is not only long hours in the classroom or an e-learning course. Today, training includes broadcasting tips and filing them on a public folder. You can even create a six-month, quick-learning program to develop team skills one application at a time, as shown in Table 10-1.

<table>
<thead>
<tr>
<th>Month</th>
<th>Program</th>
<th>Benefit</th>
<th>Tool</th>
<th>Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Invitation time saving</td>
<td>Time saving</td>
<td>Calendar</td>
<td>12</td>
</tr>
<tr>
<td>2</td>
<td>Task supervision</td>
<td>Organization and</td>
<td>Tasks</td>
<td>10, 11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Time saving</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Drowning in e-mails</td>
<td>Shrink Inbox</td>
<td>E-mail rules</td>
<td>5, 6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>traffic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Priorities</td>
<td>Self-organization</td>
<td>Tasks and</td>
<td>10, 11, 12,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Calendar</td>
<td>and others</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>according to</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>department</td>
</tr>
<tr>
<td>5</td>
<td>Effective sales control</td>
<td>More closing</td>
<td>Tasks</td>
<td>14, 15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>business</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Delegating</td>
<td>Don’t be a doer,</td>
<td>Delegate</td>
<td>10, 11, 12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>be a leader</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Create tests like a fake invitation and check all attendee’s answers or circulate a Task request to be declined with a new date proposition. Invest time in helping the person who didn’t answer the test. Know-how without doing is not knowing.

Outlook Programs work when managers and leaders don’t exempt themselves from the rules and use the applications along with the rest of the team.

**Sharing Your Work with the SharePoint Server**

Today, corporations use third parties for everything — even to produce their products in different plants. How do you make the project drawings, sketches, documents, and schedules accessible from anywhere? You can load all your documents in a public folder and upload them to a Web site or have them in a more organized manner, by creating a document or meeting workspace on a SharePoint service. The *SharePoint workspace* is a predesigned Web site to integrate team information for small businesses. After creating your SharePoint workspace, you can invite your team to start working on the same workspace and start using the Calendar invitation features of Outlook.

The SharePoint server, together with Outlook, helps you work with team members from different companies. You can share the same information in a secure and organized way.

You can also send Tasks and Invitations to different companies without any problem. Since Outlook 2002, you don’t need to be connected to an Exchange server to send or accept Tasks and Invitations. Consider asking your close customers and suppliers for their permission to send Invitations and Task requests — doing so via Outlook is a great timesaver. Simply determine their Outlook version and their knowledge of its features to get a better feel for their capabilities. Close customers or suppliers can schedule appointments by sending an Outlook invitation and receiving the customer or supplier acceptance (or a new date proposal). You can send a Task to your supplier requesting any kind of office maintenance with a due date and receiving the due date confirmation.

For example, say that you need to develop an e-training manual about Outlook’s marketing features. Your assigned team works via Internet from different locations. You decide to employ a SharePoint workspace site where you can load and share documents and schedules without needing any technical expertise. To create a workspace for this project, enroll in the MS SharePoint trial on the site [www.sharepointtrial.com/welcome.aspx](http://www.sharepointtrial.com/welcome.aspx) and follow the instructions for setup. After the setup, log onto your SharePoint site and follow these steps to create your own workspace:
1. Click Create.
   The new page opens; scroll down to the end of the page.

2. Click the Sites And Workspaces hyperlink.

3. Follow the wizard to fill in the title and description of the workspace and the project description.

4. Continue through the wizard until your workspace is finished.
   Figure 10-1 shows a sample decision-meeting workspace.

5. Insert your information into each part of the workspace by clicking Add New Item.

6. Manage your attendees by clicking Manage Attendees.
   To specify each team member, give each attendee permission in the workspace. Then you can open an agenda item for each member. Table 10-2 shows you an example.

<table>
<thead>
<tr>
<th>Table 10-2 Team Members and Their Project Assignment List</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Member</strong></td>
</tr>
<tr>
<td>Marcelo</td>
</tr>
<tr>
<td>Mary</td>
</tr>
<tr>
<td>John</td>
</tr>
<tr>
<td>Joe</td>
</tr>
</tbody>
</table>
7. Insert each document into the Document library following the wizard steps.

Figure 10-2 shows the decision-meeting workspace with the information entered.

Several other templates for different project types are also available. With the page ready, you can use Outlook to notify your team members of the workspace and send updates.

To send a meeting request to employees to participate in a SharePoint workspace, follow these steps:

1. **With the Calendar view open, click the New button and choose Meeting Request.**
   
The Invitation form opens.

2. **Click the Meeting Workspace button to open the Workspace Wizard.**

3. **Select Change Settings to find your workspace address.**
   
The wizard page changes.

4. **Select Other in the Location list box.**
   
The Other Workspace Server box appears.

---

**Figure 10-2:** The workspace setup is ready to be shared among users.
5. Type your workspace site address.
   The workspace address looks like a site address, such as http://myb.sharepointsite.com/.

6. Choose Link To An Existing Workspace.
   The workspace address or address list is found and displayed in the Select Workspace list box.

7. Click OK.
   The Wizard page returns to the starting page

8. Click the Link button.
   The meeting workspace is linked to the invitation, as shown in Figure 10-3.

9. Complete the invitation and send it to each attendee.
   The attendees receive an invitation with the SharePoint site directions (see Figure 10-4).

Figure 10-3: Add the path to the workspace by sending an invitation with the site link embedded in the invitation.
Taking Advantage of Outlook Collaborative Tools

Outlook collaborative tools are Agreement, Supervising, Delegate, and Sharing. Two people working together can have many forms of agreements: looking in each other eyes, requesting the agreement by phone, or using Outlook agreement tools. Sharing your Calendar and your Tasks list gives support and supervision without interrupting any third-party work. Delegating others to act on your behalf can increase your productivity, so start delegating according to your needs.

The agreement game (Tasks)

If you’re in business, you can probably recall a time when your assigned Tasks did not get done. Mike believes Joe accepted an assignment and keeps asking about it. When the due date arrives, it turns out Joe doesn’t deliver
the job. If Joe could say, “I’m sorry, this is not my job. I can’t help you now, but I can explain how you might get it done,” he would not receive the repeated pressure from Mike, and Mike wouldn’t be angry about losing time. Saying no and negotiating another due date or explaining to coworkers how they can get the job done without you keeps the company game moving fast. Only when the team understands the workflow and the agreements involved in that flow will you start winning the game. Outlook’s collaborative tools can put you a major step ahead. There is no purpose in sending a Task request and not receiving a committed answer, such as, “Yes, I can deliver that by . . .” or “No, I can’t do that as requested, but I propose the following. . . .”

Today, working people send most of their requests by e-mail or phone, believing that the sent e-mail is enough. In this way, your request is lost in the mailbox mess without any priority and often forgotten. Outlook collaborative tools enable you to send a request or an invitation that demands a simple answer like accept, decline, or propose a new way, which means finding an agreement between the two parties. Everyone on your team must use Tasks lists and requests.

**Player rules**

Every game has rules specifying what each player should do. The agreement game requires that each player follow the rules like any other game. The following game rules help your team to use Tasks effectively.

- **Rule 1:** Each player should understand and use the Tasks list (Figure 10-5). He should assign his Tasks due dates, changing the priorities levels from time to time because new incoming events can change the priority of existing Tasks. For example, receiving an order to be shipped in two hours can change the team’s priorities in a few seconds.

  You can view the Tasks list in several views. From the Navigation Pane, choose Next Seven Days or Overdue Tasks to view and manage only your short-term priorities. The Tasks Navigation Pane offers ten ready-made options with self-explanatory names, such as Simple List, Detailed List, Active Tasks, By Category, Completed Tasks, and Tasks By Time Line. The Tasks View By Person Responsible or By Assignment are great for supervisors.

  Sort your Tasks list view by Priority or by Due Date by simply clicking the column title just below the Tasks title bar. Sorting by one of these columns changes the view and shows different priorities depending on the column used.

- **Rule 2:** The Task request, like a ball in motion, is “agreed to” by clicking the Accept button or rejected by clicking the Decline button (see Figure 10-6). Not clicking any tab is against the game rules.
After accepting and saving a Task request, you can open it in your Tasks list. Outlook automatically adds it to your Tasks list, sets up the priority among your open Tasks, and sets up the reminder for the time scheduled to work on it.

- Rule 3: The person who requests a Task, such as a coach, must supervise the team member’s action until the Task is complete. Clicking the Assign button to request a Task transforms your Task into an e-mail to be addressed with two available selection boxes:
  - **Keep An Updated Copy Of This Task On My Tasks List:** Selecting this option sends the Task and keeps a copy on your Tasks list for your supervision.
Send Me A Status Report When The Task Is Complete: Selecting this option generates a final status report that is automatically sent to you as a Task update e-mail upon the completion of the Task.

Using these two options keeps the requested Task on your list and helps you supervise it. Read more details about supervision in the section “Supervising,” later in this chapter.

Rule 4: Before bothering the person about the Task, go to your Tasks list and open your request to check any status changes.

Exception: Send simple requests, which can be completed or answered in a few minutes or in one step, by e-mail. Examples of simple requests include “Please send me the sales report from March that is in your file.” You don’t need to create a Task with agreement confirmation for such items.

The agreement game rules (Calendar)

The rules in the preceding section are valid for Calendar invitations or appointment scheduling. Click the Invite Attendees button on the Calendar or the Assign Task button on a Task to send your message with an automatic response capability. This lets the recipient answer by clicking response buttons.

Opening the Tracking tab in an invitation sent in your Calendar lets you supervise all sent invitations and the responses. Read Chapter 12 for more details on the Calendar.

Supervising

Good supervision is not just assigning a job by e-mail or by phone call and forgetting about it. Good managers don’t trust only their memories; they list all pending actions on a notepad and tick the completed actions when done. If you have hundreds of Tasks each week, using a notepad to control a group of Tasks is not an option. Assigning Tasks to your team and keeping a copy on your Tasks list facilitates the work, but supervising all pending tasks of only one person on your Tasks list is not easy. By changing the current Tasks list view on the Navigation Pane by Person Responsible, you can have all Tasks listed by each assigned owner (see Figure 10-7), which eases your supervision. A second view option, By Assignment, is available showing only the tasks assigned to other people.

Opening your own Tasks list by owner allows you to check each owner’s list and due dates so that you can negotiate a change when needed. By using your Tasks list, you don’t have to interrupt anyone’s work to check on the status of a job.
You have a distant vision of your team workers and a closer vision of their assigned Tasks. If your team encounters a particular problem or priority conflict, you can zoom in on your collaborator’s Tasks list and read all his pending jobs while working together on the priorities. To have the power to open your collaborator’s Tasks list, you must be connected on the Exchange server, and the collaborator must give you permission to open his tasks. To open your collaborator’s Tasks List folder from Outlook:

1. **Choose File ➤ Open ➤ Other User’s Folder.**

   The Open Other User’s Folder dialog box appears, as shown in Figure 10-8.

2. **Click the Name button to select the person you want to supervise.**

3. **Select Tasks from the Folder Type drop-down list.**

4. **Click OK.**

   The third-party Tasks list opens in Outlook; you can read and even suggest a priority change when needed.

---

**Figure 10-7:**
Use the Tasks List By Person Responsible to supervise the third-party pending Tasks.

---

**Figure 10-8:**
Take a closer look at your coworkers Tasks to solve conflicts.
Delegating

Delegating a job doesn’t mean that you’re getting rid of it. Rather, delegating involves passing on, entrusting, or assigning a job and all its decisions to a person able to perform it without your supervision. To delegate, you must be patient and plan ahead. You must train people to perform well by themselves on your behalf and define very clearly the limits of the Task.

You might, for example, show your administrative assistant how to act on your behalf in maintaining your meeting agenda, or in sending or receiving invitations for you. Outlook delegating properties allow the delegated person to receive your invitation requests in her Inbox and answer on your behalf. When she answers on your behalf, Outlook sends you a confirmation, informing you that the delegated person replied. You then have the information available on your Calendar.

Using the Outlook delegation feature, your receptionist or assistant can accept or decline invitations on your behalf, thus giving you time to concentrate on your priorities. Here’s how you can delegate your invitations:

1. **With Outlook open and connected to an Exchange server, choose Tools ➪ Options and then click the Delegates tab.**
   The Options dialog box opens to the Delegates options.

2. **Click Add to add users from your list.**
   In this example, I added Mary. The Exchange server adds Mary to the delegate list and opens the Delegate Permissions for Mary, as shown in Figure 10-9.

3. **Select the Delegate Receives Copies Of Meeting Related Messages Sent To Me box.**
   This way, you don’t have to share your entire Inbox with your coworker.
The Delegate permission dialog box lists other folders like Tasks and Notes with option to share with the Delegated person, creating a shortcut, instead of opening and sharing the folders one by one.

4. **Click OK to start delegating.**

**The goal is sharing**

When you make important information available to your team, you reduce interruption. Sharing your Calendar or Tasks list gives your team the power to read them, instead of interrupting you to ask questions. Sharing your folders is easy, but before sharing them, you have to determine the permission level of each team member. Sharing and data integrity must work together. You can have your assistant manage your agenda, sending or receiving invitations on your behalf, or you can allow team members to read your agenda only. The main permission levels are as follows:

- **Editor**: The Editor has full power, including rights to modify and delete the information being shared.
- **Author**: The Author has less power than an Editor and can’t modify items. The Author can add and delete items but not change previous items.
- **Reviewer**: The Reviewer can only read items.

To share your information, you have to choose which folders should be shared. You can share your Calendar, Tasks, and e-mail or contacts and specify who is allowed to view the information and at what sharing level. With Outlook open:

1. **Click the Calendar button from the Navigation Pane.**
   
The Calendar folder is visible on the My Calendars window on the Navigation Pane.

2. **Select Share My Calendar.**
   
The Calendar Properties dialog box opens on the Permission tab (see Figure 10-10).
   
   To allow someone to share your Calendar folders, you must add his name to the Permission list and choose the Permissions Level.

3. **Click Add to open your lists.**
   
The Add List dialog box appears.

4. **Open the Show Names box to see all the names available.**
   
   You can select individuals one by one or select a group.

5. **Click the name you want to select.**
   
   Figure 10-11 shows Joe, John, and Mary selected.
6. Click Add and then click OK.

   The chosen persons are added to the Calendar sharing list, as shown in Figure 10-12.

7. Select the Preset Permissions level on the list box or create a custom level by selecting each permission item on the Permissions frame.

8. Click Apply and then click Close.

   The sharing permission setup is ready.
You can share your Tasks list, Contacts list, and Inbox in the same way as explained with the Calendar. You can give certain team members the power to work in your Outlook folders in just few clicks.

To open the shared files:

1. Choose File ➪ Open ➪ Other User’s Folder.

   The Open Other User’s Folder dialog box opens.
2. Type the username in the space provided.

3. Select the folder name (such as Calendar) from the Folder Type list box.

4. Click OK.

   The shared Calendar opens.
Chapter 11
Applying Teamwork

In This Chapter
- Organizing customers and suppliers lists
- Confirming sent e-mail
- Voting
- Organizing the customer support
- Controlling projects

Like you, your customers and coworkers want to make life easier and better. They want to keep the ball moving toward their goals, not away from it. In this chapter, you find out how to use Outlook’s collaborative tools to move the ball toward the goal. You also discover how to avoid customer complaints due to unresolved and unshipped orders, how to avoid phone calls asking, “Hey, did you receive my e-mail,” and how to take a survey in a single e-mail. Using Outlook’s collaborative tools, you can determine how to achieve your objectives in fewer steps.

Creating a Uniform Customers and Suppliers List

Could you send a Happy New Year’s card to your entire customers and suppliers list today? This question is a good one to ask to determine how up-to-date your Contacts list is. Even small databases of 200 names involve regular updates and changes — one person leaves the company, another changes his phone number, and yet another is promoted. Companies with large customer lists end up creating task forces at the end of the year just to update the company database.
Another issue is where the list is located. Quite often, the list is split up among the billing system, the purchasing department, and each salesperson’s various archives (Rolodex, Pocket PC computers, and even the business card forgotten in the top drawer). Without an updated database, you can’t communicate well with your customers. Here are a few possible solutions to this problem:

- Use your Contacts list as your customer and suppliers database. Update any information as you receive it, when working by yourself.

- Use your assistant’s Contacts list as the company list. Create a rule that you send every new update you get, such as a business card, a phone call with new information, or an e-mail, to the assistant for database updating.

- Create a public list on the Exchange server and choose a person to be the list keeper. You can use the BCM Business Contact Manager add-in, shareable since Version 2.0. You can share the business contacts and accounts as one list with the rest of your company. (You can read more about BCM in Chapter 6.)

You should update address changes and add new contact information immediately. The first option is good when you’re working alone. The second option works when you don’t have an Exchange server available or don’t use the Business Contact Manager Version 2.0. The best option is the third one, because the Contacts list is available to the whole team anytime, anywhere with Outlook Web access. You simply type the new contacts into your Contacts list, save it, and then send it as a vCard to the Contacts list keeper as follows:

1. **Open the saved contact.**
2. **Choose Actions ➪ Forward as vCard.**
   
   A new e-mail opens with the vCard attached.
3. **Send it to the Contacts list keeper.**

   The Contacts list keeper receives the e-mail and can simply drag and drop the vCard from the e-mail into the Contacts list.

Adding a contact in this way automatically records the date the contact was created (using the field name Created) and maintains a last modification date (using the field Modified). You can customize your contacts view to include the Created and Modified fields if you want to keep track of this information. (Chapter 4 explains the procedure for modifying contact views.)

You’re likely to receive contact information from several sources, such as the internal sales system, each salesperson, or the management team.
Associating the contact with the person who generated it facilitates tracking. You can use categories to help you track this information:

1. **Create a new category for each sales team member.**
   (Read Chapter 4 to find out how to create categories.)

2. **Insert a new contact on the list.**

3. **With the contact open, click the Categories button.**
   The Categories dialog box appears.

4. **Select the Sender Name category and save the contact.**
   The contact is associated with its source.

---

**Following Up on Requests**

“Hello, Mary, did you get the e-mail I just sent you?” Is this a question you often ask your active customers or new prospects? The question sounds like something you tell first-year business students not to do.

Requesting an e-mail read receipt to confirm that the e-mail was received and read (thus avoiding the phone call) seems like a good idea, but some businesspeople consider the e-mail confirmation feature offensive. Many people even turn it off without allowing the receipt to go back to the sender. Most people don’t like to be forced into responding. So the question remains; what is the best way to follow up and close a request?

---

**Flagging**

A polite way to request an answer is flagging for a reply or call. Flagging means adding your reply information to the top of the e-mail, requesting an action — to call you or send an answer within a certain period of time.

Flagging works in the following way:

1. **With your e-mail open, click the Flag button on the toolbar.**
   The Flag wizard appears (see Figure 11-1).
2. From the Flag To list box, select one of the following options: Call, Do Not Forward, Forward, For Your Information, No Response Necessary, Follow Up, Read, Reply To All, Review And Reply.

3. From the Due By list box, choose the date and time.

4. Click OK.

5. Complete and send the message.

The person receiving the message sees a note on top of it (see Figure 11-2) with your request to reply and the expected return date.

The person usually gets the message with your polite request for action. You also can keep track of the sent message by opening it and adding a follow-up flag as an open issue reminder to you. To set up the flag:
1. Select the Sent items mailbox in the Mail Navigation pane.
   The Sent Items list appears.

2. Right-click the desired message to open the drop-down list.

3. Choose Follow Up ➪ Add Reminder to open the Flag for Follow Up dialog box.

4. Set up the reminder and click OK.

If you have a lot of messages with follow-up actions, you can list them all at one time. First, select your Outlook mailbox and then choose the For Follow Up search folder located on the Navigation Pane within the Search folder. All your follow-up messages appear.

### The e-mail confirmation request

Confirmation requests work with a little help of psychology, perhaps by inserting the following comment at the top of your e-mails: “I’ve set up an automatic e-mail confirmation to this message in case you don’t have time to reply.” You can set up the reading confirmation request the following way.

1. **With your e-mail open, click the Options button.**
   The Message Options dialog box opens.

2. **Check the Request A Read Receipt Of This Message check box in the Voting And Tracking options area.**

3. **Click the Close button to save the request.**

After you write the message and click Send, the message is sent with the read confirmation request. When the addressee opens the e-mail, he can accept or deny the read confirmation message. If he accepts it, you receive an e-mail confirming the time the message was read, thus saving you a phone call. Give your customer time to take a breath and think before you call to close the deal.

### Conducting Surveys

Voting is a popular method when you need a group of people to choose from several options. However, getting your team to make a decision can be difficult, not to mention time consuming, to plan, execute, and tally all the votes and hear all the opinions. With Outlook e-mail voting, you can hold an election
in minutes and avoid wasting time counting each vote. Outlook tallies the votes for you.

To conduct a survey and add voting options:

1. **With a new e-mail open, click the Options button.**
   The Message Options dialog box appears, as shown in Figure 11-3.

2. **Check the Use Voting Buttons check box.**

3. **Click the Use Voting Buttons drop-down list and choose the option you want.**
   You have three options:
   - Approve; Reject
   - Yes; No
   - Yes; No; Maybe

   ![Figure 11-3: The Voting and Tracking Options area allows you to type any voting buttons for your poll beside the native options.]

But these three choices aren’t sufficient for choosing from a list of possibilities. The surprise is that you can add voting options to the list and use them in your e-mails.

4. **If you don’t like the options listed in Step 3, create your own by selecting and deleting the text from the Use Voting Buttons list box.**

5. **Type into the Use Voting Buttons text box the options you’d like, separating them with semicolons.**
For example, if you wanted your employees to choose among pizza toppings, you may type; Veggie; Mushrooms; Onions; Black Olives; Cheddar; Pepperoni; Italian Sausage; Beef; Ham; Pineapple.

6. **Click Close to save the newly created list**

7. **Type the subject and text of the e-mail as desired and click Send to distribute it to your team.**

Figure 11-4 shows the e-mail if you were tallying up votes for pizza toppings.

After the voting takes place, you don’t have to count the votes one by one like a political election. When a team member clicks a choice, it automatically sends an e-mail back to you (the sender). But you don’t have to count each e-mail. Instead, just open the original e-mail you sent and click the Tracking tab to read the results at the top of the page (see Figure 11-5).

The sent e-mail’s Tracking tab doesn’t open until you receive the first answer.
Organizing Customer Support

A cosmetic company’s e-mail hotline receives the following customer e-mail: “My dog drank your shampoo. What are you going to do about it?” Customer service forwards the e-mail to the legal department, copying the woman. The attorney replies to the customer service department, blaming the woman. But he presses the Reply To All button, so the customer receives a copy of his e-mail . . . and the wrong impression. The results? The lawyer loses his job, and the company pays the customer damages with strong apologies attached.

Large companies run contact-center software for customer service needs, but you can create a small customer service center with Outlook Tasks. To make this center most effective, you must follow some standard procedures. First, every call should open a new Task, because Tasks are used to track the calls. Second, it’s forbidden to forward customer e-mails to others within the company. Instead, you drag and drop the e-mail into a Task and send it by using the Task request feature (see Chapter 10). A mistake like the one described in this section will never happen again.

A small company can run a hotline or customer service center by following a few simple guidelines:

- Every customer contact by phone, e-mail, or fax opens a new Task.
- All internal requests from customer service should be requested as a Task, keeping a copy on the customer service side.
- The Task is closed when the customer receives a solution.
- Save all closed Tasks in a special folder and analyze the problems from certain periods so that you can detect repetitive issues and solve for them.

You can customize the Task form to add a ticket number, product information, customer information, and the problem. It doesn’t matter what type of business you have; you can create any kind of field according to your business needs. You customize a Task in the same way that you customize a Contact form (see Chapter 5):

1. Choose Tools ➪ Forms ➪ Design A Form.
   The Form library opens.
2. Select the Task form you want displayed.
3. Because you don’t use the main page, click the page 2 tab (P, 2).
A full page appears so that you can design a form. You have a full page to insert any field for your new Task form. Chapter 5 explains the procedure for adding fields to this form. The information to include on your example customer service form may include

- **Product information fields**: Model, Description, Serial number, Purchase Date, Store, City, and State.
- **Customer Information fields**: Name, Phone Number, and E-mail.
- **Action Report field**: Insert a text box to type new information.

4. **Create the frames by selecting them from the Control ToolBox and then formatting them and inserting their titles.**

   See Chapter 5 for detailed procedures.

5. **Create the fields by using the Field Chooser and insert the fields inside each frame and align them.**

   See Chapter 5 if you’re not sure how to create fields.

6. **Create the Text box by dragging the TextBox from the Control ToolBox to the form page.**

   Read Chapter 5 for details.

7. **Save the form by clicking the Publish button on the top left of the form.**

   You now have a Task ticket to help you organize your customer service support. This ticket helps you control your customer service requests and move them around the company by using e-mailed Tasks. You can then customize the Task form according to your customer service department needs.

### Controlling Projects

You may be considering moving to your dream office — think of the architecture, the external design, the interior design. But when you calculate how much it costs to merely *start* the project, you may realize how much you need a project-planning tool to help. The first step, planning and budgeting your office, may look like only one Task, but when you look closer, it involves three new tasks:

- Evaluate with a real estate dealer the leasing cost at the building you want.
- Evaluate the interior design cost of your office with an architect.
- Evaluate how to finance your dream office.
Merely to start evaluating the project, you have three major tasks and three different people involved in making decisions. No doubt each of these tasks involves a series of smaller steps, too.

You can open a Task for each request or manage the office-budgeting project in only one Task. To use only one Task for the project, you can build a project-management table.

You have two suppliers for each request, their services, their contact details, the next action description, and the next action date and results columns. As you start, you fill in the next action date for each one and create the reminder for the next due date as it comes.

You can design your table in a Word document or in an Excel workbook. To paste the table in your new Task, follow these steps:

1. With Word or Excel open, select and copy the table.
2. Go to your new Task and paste the table into it.

Your Task now has a planning table (see Figure 11-6).

Figure 11-6: By adding a table to a Task, you can control the next steps.
You can attach tables to manage projects with sequential actions or multiple actions. For example, if you’re moving your office, you may have a table that keeps track of the planning sheet, packing and unpacking lists, and so on. An event planner may track suppliers, entertainers, catering professionals, printed materials, and giveaways. (You can read about event planning in Chapter 16.)

**Working with your Team’s Calendars**

Joe runs a company with Mary and John, and they all share their Calendars. (Each one can alter entries in the others’ Calendars as an editor.) Joe opens both Mary’s and John’s Calendars in Outlook, as shown in Figure 11-7, so that he can see a view of the entire group at one time. He can open any appointment in any Calendar and change it as the owner because of the permission settings. (Chapter 10 explains these sharing properties and how to open a third-party Calendar.)

![Figure 11-7: Viewing three Calendars together helps manage a team’s available time.](image)

Sometimes Joe needs to read only one Calendar, so he selects the desired Calendar from the Navigation Pane. Below his Calendar is a new window called Other Calendars, which he can select and deselect to open or close them.
To save the same appointment in each person’s shared Calendar:

1. **Create and save one appointment in the first shared Calendar.**
2. **Copy your appointment.**
3. **Select the next shared Calendar time with your mouse and press paste your appointment into it.**

Take care to select the right period in the Calendar. Copying allows you to paste the appointment into any time slot. The internal schedule automatically adjusts the appointment to the new time. Be sure to double-check that you pasted the appointment into the appropriate time slot.

Checking the availability of every member of a sales team takes time and can be a challenge. Open any appointment in your Calendar and click the Scheduling tab to display the Free And Busy Time table. Typing each name into the All Attendees list shows each person’s Free And Busy Time table. You can group the sales team together, so instead of typing all the members’ names on the scheduling list, you just have to type the group.

You can open a group schedule by name in the following way:

1. **With the Calendar open, choose Actions ➤ View Group Schedules.**
   
   The Group Schedule box opens.
2. **Click the New button.**
3. **Type the name of the group, such as Sales Team, into the text box.**
   
   The scheduling for that group appears.
4. **Click the Add Others button to select each member from your list.**
5. **Click the Save and Close button after adding the names to the list.**
   
   The group is ready.

To open the group and see the schedule:

1. **Choose Actions ➤ View Group Schedules.**
   
   The Group Schedule dialog box opens.
2. **Select the group whose schedule you want to see.**
   
   The group schedule opens.
Leading Your Team

The evaluation form is a good way to provide personnel directions and coaching, even in a small company. If you don’t have an evaluation form, look at the MS Office Online site at [http://office.microsoft.com](http://office.microsoft.com) for a template. When you have five or ten people under your command, you can file their evaluations as Tasks, opening each one from time to time to check on their goals and supervise how they’re progressing on them. You can also create a new folder to hold the employee evaluation forms:

1. **With the Task folder open, right-click the Task folder name and choose New Folder.**
   
   The Create New Folder dialog box opens.

2. **Type the folder name into the Name text box.**

3. **Click OK.**

   Your new folder is ready.

You then need to create a task form for each employee. For the due date, enter the date of the employee’s evaluation.

To create each employee’s evaluation form as a Task, follow these steps.

1. **Open a new Task with each employee’s name and the due date as the next evaluation date.**

2. **Open each employee’s old evaluation form.**

3. **Select the content and copy it.**

4. **Paste the form into each employee’s Task.**

   The Task looks something like Figure 11-8. Note the scrolling bar, used so that you can read the whole document.

The reminder doesn’t work for Tasks stored in subfolders. Reminders work only for Tasks stored in a main folder.

A good coach doesn’t have to keep in mind all the details about a team. You can store all these details in the evaluation. You can also send a copy of these Tasks to each employee after the evaluation.
Requesting and Planning a Vacation

Planning is the essential ingredient in making a vacation work. To schedule a summer vacation, take the following actions, which you can perform by using the Calendar, invitations, and Tasks:

1. Schedule and block the time on the Calendar with the Vacation label.
2. Send a Task request for boss’s approval for the time off.
3. Inform the HR department of the vacation schedule.
4. Open a new Task with the following subject: Transfer my duties to my coworker and set up the reminder date one week prior to the vacation.
Chapter 12

Shrinking the Meeting Time

In This Chapter

- Meeting cultures
- Planning meetings
- Cutting the invitation and confirmation time
- Managing resources
- Video and Web conferences

Gathering people together for any objective is an art and a science. Even just getting a group together for happy hour can be a challenge. The weekly sales meeting schedule always runs late. The training should start at 9 a.m., but at 10 a.m., people are still showing up. Why do event planners give early-bird prizes? Finding people and setting up meetings can be difficult.

People don’t always give time commitments the same priority either. This difference is especially noticeable across cultures. Every culture, country, or individual has a specific way of perceiving time. Fortunately, Checklist and Outlook can help implement time-commitment guidelines in your business when your entire team uses the Calendar and its sharing properties.

If you’ve never used Outlook Calendar, read Appendix A before reading this chapter. Understanding the Calendar prior to reading this chapter will increase your results on shrinking the meeting time.

Planning and getting effective meetings becomes easier when you understand people, cultures, and Outlook’s collaborative tools. Checking your team’s common free time saves you time scheduling meetings and sending invitations. The attendees receiving the invitation can answer simply by clicking the options, which also automates the process of inserting the meeting time on each Outlook agenda. At the same time, it sends a reply to the sender to facilitate attendance tracking. Finding meeting resources, such as a projector or a meeting room, become easy when using Outlook’s resources application. You can read more about sales meetings in Chapters 14 and 15.
Identifying Meeting Cultures

Time for an artist, a painter, or a film director has a different meaning than it does for a businessperson or university professor who spends years in specialized research projects, a farmer tending crops, or a Wall Street banker. Understanding their time perceptions makes your time commitments work better.

How much value do Americans associate with time? At the end of a meeting with your customer, the usual parting remark is “Thanks for your time,” showing the great value of the attention received. Hundreds of time-management trainings are available throughout the country. Thousands of books are in the library about the subject. While I was working in Japan, my Japanese representative scheduled our arrival so that we would show up at our meetings 10 or 15 minutes early; we would then wait to ring the bell precisely on time. I missed a train in Switzerland due to a one-minute delay. The siesta is a Spanish creation, and, when working in Latin America, your schedule is (more or less) on time. The precision isn’t great, but the attention when received is friendly and warm. Time perception isn’t the same everywhere. Understanding it and getting the mood helps you have better, more effective meetings anywhere in the world.

The Outlook Calendar time zone setup is intelligent. For example, when you open a conference call invitation from California in New York, the time schedule automatically appears in local time. The same happens when you send an invitation to your Japanese, Chinese, or Greek customers. Their language is different, but Outlook adjusts the time according to the time zone receiving the invitation. (You can read about working with two time zones in Chapter 13.)

Taking Advantage of Categories

Keep in mind that the company culture reflects meeting style. Today, many corporations make strong demands on their salespeople to attend Web conferences and Webcasts, often giving them little time to handle the customer’s demands.

You can track and measure how you spend your time during the week or during the month by categorizing each appointment and viewing the Calendar By Categories, thus allowing you to see the time invested in internal meetings, traveling, phone calls, or customer care.

Here’s an example. Joe is a sales director of a high-tech company. His company launches one product every week and sometimes two in a week. The company demands that he spend more time in product training than in sup-
porting the customer base. Joe uses his Calendar to measure his time spent on training and his time spent touching base with his customers in the following way.

First, he creates two categories to use in his appointments: a Training category for time spent in training and a Calls category to trace customer contact.

To create your own categories, follow these steps:

1. **Open Outlook Calendar and open any appointment.**
   The Appointment page appears.

2. **Click the Categories button in the lower-right side to open the Categories dialog box.**

3. **Click the Master Category List button to open the Master Category List dialog box.**

4. **Type your category name into the New Category text box.**
   For example, if you want to create a Training category, type Training.

5. **Click the Add button.**

6. **Repeat Steps 3 to 5 to create any other categories you’d like.**
   Your new categories are now available.

7. **Close the Appointment.**
   You return to the Calendar page.

For example, you can use a Calls category to classify every customer appointment and a Training category to hold every training session. Selecting a category for your appointments allows you to evaluate the amount of time spent in trainings and the amount of time spent with customers.

To view and calculate the time spent in each category, you need to modify your Calendar view as follows:

1. **Select By Category in the Navigation pane.**
   Outlook displays the Calendar entries by category.

2. **Choose Customize Current View In the Navigation Pane Current View.**
   The Customize Current View By Category dialog box opens.

3. **Click the Fields button.**
   The Show Fields dialog box appears.

4. **Double-click Duration in the Available fields list.**
   The Duration field moves to the Show These Fields In This Order list.
5. Click OK.

The Duration field is now visible, as shown in Figure 12-1. A new column showing the duration time of each event is now available.

Joe tracked his results for one month and presented the results to the board, which convinced them to develop a new training system to give him and his coworkers more time to work with customers. Like Joe, you can use your Calendar to measure and analyze the time you spend on different issues, which can help you create different ways to be more productive.

### Planning Productive Meetings

Your boss calls you and some of your coworkers for an unplanned meeting. The purpose is unknown. When everybody comes to the meeting room, the boss begins asking questions that no one can answer without preparation. To get the answers, the employees have to go back to their offices, collect the information, and prepare it for presentation after a coffee break. What went wrong with this meeting? The boss should have used Outlook to plan the meeting. Outlook Calendar is a great tool for sending invitations and receiving confirmations, but how do you effectively plan the meeting?

### Preparing for meetings

Mary is a sales manager and has weekly sales meetings from 8 a.m. to noon. The sales force reports on its weekly sales numbers, new prospects, and challenges. Unfortunately, some members of the sales staff were taking too long with their reports — talking about the weather or the traffic problem.
they encountered on the way to each customer. To solve the problem, Mary proposes a visit report. She proposes the topics and explains to each salesperson what’s important to discuss in the meeting. She also sends each one a recurring Task with the following subject: Weekly report reminder to be ready the day before, not Friday 5:30 p.m. A few weeks after starting the program, the meeting time shrinks to one hour, as scheduled.

You don’t need to be a manager to manage your own meetings. Just keep the meeting objective in mind, bring your meeting minutes to guide you through the meeting, and track the new requested actions.

**Developing a meeting checklist**

The Calendar Invitation form enables you to provide complete information about a meeting. (To access the Invitation form, with Outlook open in the Calendar, choose New ➪ New Meeting Request.) Then you simply use the following fields on the standard Invitation form:

- **Subject**: What’s the purpose of the meeting? What’s your expectation at the end of the meeting? Type the purpose into the Invitation subject.
- **Guest Invitation**: Why do guests need to come? Don’t waste time inviting people only for political purposes.
- **Requirements**: Should attendees read something before the meeting or bring something to the meeting? Will the attendee take part in the presentation? What part? How much time does each attendee have? Communicate the request to each attendee on the invitation.
- **Date, Time, and Place**: Fill in this information on the Invitation form.
- **Equipment required**: Will you need a meeting room, projector, conferencing devices, video, or other items? You can reserve shared resources by using Outlook Calendar, creating an e-mail address and calendar for each resource, and delegating an owner for the resources mailbox. Read more in the section “Reserving Resources,” later in this chapter.
- **Guest confirmation**: Track the confirmation in your own appointment by clicking the Tracking tab. The tracking application appears later in this chapter in the section “Getting the confirmation list.”

**Scheduling Meetings**

People still pick up the phone to call and ask meeting attendees their time availability for a particular meeting or send an e-mail and wait days for people to answer. When everybody is using the Calendar connected through an Exchange server, you can easily check a person’s availability.
How much time do you spend contacting people regarding an upcoming meeting? A 10-person meeting requires 20 phone calls and e-mails confirming and reconfirming the meeting. Outlook Scheduling helps you propose the first free time available for all ten people in one fell swoop. You can also negotiate with one or two people to see whether they can change their schedules to facilitate a common meeting time.

Using the Scheduling tool is an easy and efficient way to find the first available time slot common to all attendees, without calling or interrupting anyone. For example, say that you need to know your coworkers’ schedules for a meeting on Friday. Here’s what you need to do:

1. **With the Calendar open, click the Scheduling tab.**
2. **Add each guest name to the All Attendees list.**
   The Scheduling tab looks like Figure 12-2. In this example, Mary is busy at 1 p.m.
3. **Click the AutoPick Next button.**
   The green and red lines move to 2 p.m. through 2:30 p.m. and show the first mutual free time.

![Figure 12-2: You can find out the availability of the whole team in one view by using Scheduling tools.](image)
When exploring the Scheduling page in Figure 12-2, notice two things. First, the Zoom drop-down list includes an option to see a full week timetable. Use this view to find common free times during the week, rather than during a particular day. Second, the Refresh Free/Busy command, which you can access from the Options button, is useful for reconnecting your Outlook to the Exchange server and updating the timetable again.

4. **After finding an appropriate time slot, click the Appointment tab.**
   The Meeting invitation form opens with all guest e-mails ready to send.

5. **Fill in the subject and planning information.**
   The Scheduling tool fills in the time automatically.

6. **Click the Send button to send the invitation.**

Figure 12-2 shows your schedule with the subject of your meetings. When you need privacy and don’t want to show this information, uncheck your Outlook configuration for this option:

1. **Choose Tools ➤ Options ➤ Calendar Options.**
   The Calendar Options dialog box opens.

2. **Click the Planner Options button.**
   The Planner Options dialog box appears (see Figure 12-3).

3. **Uncheck the Show Calendar Details In The Grid check box in the Group Schedule because you don’t want to expose your appointments details to everyone.**

4. **Click OK.**

Because you already can share your Calendar with authorized people, don’t use this option when scheduling meetings. Show only your free and busy times to anyone.
Checking available time with the Free/Busy option

Not having access to an Exchange server is no longer an excuse for not sharing your free time and busy time with your coworkers. You can publish your Calendar on an Internet site. Outlook has a feature to publish your Free/Busy Calendar every few minutes or every hour on the site you choose.

To take advantage of this feature:


   The Free/Busy Options dialog box appears (see Figure 12-4).

   ![Figure 12-4: The Free/Busy Options dialog box is where you specify your Free/Busy site and updating frequency.]

2. Type the number of months you want to publish in the space provided.

   Free/Busy can publish your next 30 Free/Busy Calendars.

3. Type the number of minutes you want between each new update.

4. Check the Publish at my Location check box and then type the URL location where you want to publish your Free/Busy information.

   The name you specify, such as Internet site, can include FTP, HTTP, or file URLs.

5. Click OK.
Setting up your Free/Busy tool requires a little bit more technical expertise about loading and downloading information to an Internet site. Check with your Internet provider for the specifics.

The Free/Busy Internet page looks like a copy of your Scheduling tab (refer to Figure 12-2).

**Finalizing the invitation time**

Confirming and negotiating meeting times is now easier than ever. Outlook helps you eliminate stress and save energy trying to find the attendees and coordinate their schedules. Now, you can just ask your suppliers, customers, family, and friends to use the Calendar options. Any Outlook user with Version 2002 or newer can create invitations and confirmations, even without an Exchange server.

When you receive an invitation and open it, you see four buttons:

- **Accept:** Clicking the Accept button sends your acceptance and inserts the meeting into your Outlook Calendar.
- **Decline:** Selecting the Decline button gives you the option to add a comment to your reply.
- **Tentative:** Selecting the Tentative button opens a warning box with the following information: This Meeting Has Been Tentatively Accepted And Moved To Your Calendar. You now have three options: send the response, edit and add a comment, or cancel.
- **Propose New Time:** The Propose New Time button opens the Scheduling table when you’re connected to the Exchange server. You can click the AutoPick Next button to search for the next available time slot. (If you aren’t connected to the server, you have to guess about other attendees’ availability.) Click the Send button to send your new time proposal.

Don’t forget to set up the appropriate reminder 15 minutes before the event. Accepting an invitation or writing an appointment without turning on the reminder can spell disaster. Use the Default Reminder option as a safety to make sure that you never forget.
To set up the reminder:

1. **Choose Tools** ➪ **Options**.
   
   The Options dialog box opens.

2. **Check Default Reminder** to set a default reminder time in any appointment.

3. In the time list box, select the amount of time prior to the event that you’d like the reminder to appear.

4. **Click OK**.

**Getting the confirmation list**

When your guests reply to your invitation by using Outlook, you don’t have to read each e-mail confirmation to see who is coming. You don’t need a printed confirmation list. Just open your appointment, and a Tracking tab appears, as shown Figure 12-5; click it to produce a report that shows the replies to your invitation. This report serves as your confirmation list.

<table>
<thead>
<tr>
<th>Name</th>
<th>Attendance</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joe</td>
<td>Meeting Organizer</td>
<td>None</td>
</tr>
<tr>
<td><a href="mailto:marcel@instructor.com.br">marcel@instructor.com.br</a></td>
<td>Required Attendee</td>
<td>Tentative</td>
</tr>
<tr>
<td><a href="mailto:marcel@instructor.com.br">marcel@instructor.com.br</a></td>
<td>Required Attendee</td>
<td>None</td>
</tr>
<tr>
<td>Mike</td>
<td>Required Attendee</td>
<td>Accepted</td>
</tr>
<tr>
<td>John</td>
<td>Required Attendee</td>
<td>Accepted</td>
</tr>
<tr>
<td><a href="mailto:jarred@instructor.com">jarred@instructor.com</a></td>
<td>Required Attendee</td>
<td>None</td>
</tr>
</tbody>
</table>

*Figure 12-5: Invitation tracking shows the invitation confirmations so that you can follow up when needed.*
The invitation and confirmation procedures work without the Exchange server when using Outlook 2003 and 2002. Take care when using older versions, because users receive an unformatted and unreadable e-mail rather than an invitation.

**Reserving Resources**

Reserving a meeting room or a projector or a video used to be difficult. You had to call the receptionist and check whether the resource was available or not. Creating an Outlook address for each resource, such as a meeting room or a projector, you can reserve and see the current reservations online with fewer interruptions to the resource administrator. Request that your system administrator create an e-mail address for each resource, like meeting rooms or projectors. By having their own mailbox address, they also have their calendar and free-busy list, now available for online sharing when using the Exchange Server.

You simply assign a manager for each resource, such as a receptionist for the meeting room. To save the resource manager’s time, set up automatic answers to resource requests. With the mailbox for the meeting room ready, follow the next procedure to create the automatic reservation confirmation.

1. **Choose Tools ➤ Options ➤ Calendar Options.**
   The Meeting Room Calendar Options dialog box appears.

2. **Click the Resource Scheduling button.**
   The Resource Scheduling dialog box, shown in Figure 12-6, appears.

3. **Check the Automatically Accept Meeting Request And Process Cancellations check box.**
   If you ask for a meeting room reservation and it’s available, it will automatically accept the request and inform you of the reservation or cancellation.
4. **Check the Automatically Decline Conflicting Meeting Requests check box.**

If someone else made a reservation prior to yours, your request is declined. You then have to negotiate with the resource owner and the other requester.

5. **Select the Automatically Decline Recurring Meeting Requests check box.**

A recurring meeting request schedules the meeting room reservation for every week at the same time. Creating a rule to not accept recurring reservations is a company decision.

6. **Click the Set Permissions button to share the Calendar among the resource requesters in order to read the busy times.**

You can set up the permissions the same way you shared your own Calendar in Chapter 10.

When the setup is ready, everybody will know when the meeting room is in use or reserved without having to bother the resource manager.

**Managing Time through Agendas and Minutes**

Arriving on time requires that your Calendar reminder setup is adjusted properly, allowing you extra time to shift gears and perhaps fight traffic. (See the section “Finalizing the invitation time,” earlier in this chapter, for more on setting up reminders.) Conducting an on-time meeting requires planning, organizing, efficient note taking, and timekeeping during the meeting. Outlook can’t help you manage the time, but your note taker can write each action item and send it as a Task to each appropriate person.
You can find, download, and print agendas and minutes according to your meeting style from the Microsoft Office site. Click the Help button and the Microsoft Office Online command to open the Web page. Search the templates for “Agendas And Minutes.” Look for the Agenda Wizard; it helps you plan and manage all aspects of your meetings (see Figure 12-7) and use the Meeting tracking form to keep the meeting on time (Figure 12-8).

You can copy and paste agenda forms to your invitations.

Ringing cell phones during the meeting can break the concentration of the participants. The interruption is multiplied by the number of attendees in the meeting. Likewise, be sure to turn off your phone when visiting customers. After the handshake, you can even tell the customer you’re doing so to give them your undivided attention. The result is often reciprocity.

### Figure 12-7:
You can use a Meeting Agenda invitation model to plan your meeting.
## Meeting ABC

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Location</th>
</tr>
</thead>
</table>

**Meeting called by:**
Note taker.

**Type of meeting:**
Timekeeper:

### Attendees:
Please read:
Please bring:

### Agenda

#### Step 1

<table>
<thead>
<tr>
<th>Discussion</th>
</tr>
</thead>
</table>

**Conclusions:**

**Action items:**

<table>
<thead>
<tr>
<th>Person responsible</th>
<th>Deadline</th>
</tr>
</thead>
</table>

#### Step 2

<table>
<thead>
<tr>
<th>Discussion</th>
</tr>
</thead>
</table>

**Conclusions:**

**Action items:**

<table>
<thead>
<tr>
<th>Person responsible</th>
<th>Deadline</th>
</tr>
</thead>
</table>

---

**Figure 12-8:**
The Meeting tracking form helps you keep the meeting subject and time on your side.

188 Part III: Handling Communication and Collaboration
### Conducting Video and Web Conferences

Video conferencing systems used to be very expensive, and few companies had them. Today, kids use Instant Messaging software, such as Messenger with a Webcam and microphone, essentially having Web conferences with their friends. Webcast training isn’t just for techies anymore. You can invite people to Web-based training without requiring any technical setup by using Outlook’s invitation process with the Web conference page address on it.

<table>
<thead>
<tr>
<th>Step 3</th>
<th>Mary</th>
<th>20</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discussion</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conclusions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Action items:</td>
<td>Person responsible:</td>
<td>Deadline:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step 4</th>
<th>Joe</th>
<th>20</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discussion</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conclusions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Action items:</td>
<td>Person responsible:</td>
<td>Deadline:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Wrap up</th>
<th>Team</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discussion</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conclusions:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Action items:</td>
<td>Person responsible:</td>
<td>Deadline:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special notes:</td>
</tr>
</tbody>
</table>
When the attendees accept the invitation, the reminder opens Internet Explorer on the meeting page. To set up the invitation for online training or conferences, follow these steps:

1. **With Outlook open to the Calendar, click the New button to open an appointment.**
   The appointment opens.

2. **Click the Invite Attendees button.**
   The Invitation page opens.

3. **Check the box that reads This Is An Online Meeting Using.**
   The new field Event Address and a check box, shown in Figure 12-9, appear.

4. **Select Windows Media Services from the list box.**
   The other options are for Exchange or Netmeeting corporate users.

5. **In the Event Address text box, type the address of the site.**

6. **Check the Automatically Starts Windows Media With Reminder check box.**

7. **Fill in the invitation with your attendee’s address, the subject, and the proper time.**

8. **Click Send.**
   When the attendee accepts the online meeting invitation, Internet Explorer opens the Web training site automatically on time.

Figure 12-9: The Online meeting setup helps everyone show up online on time.
Chapter 13

Working with Outlook on the Road

In This Chapter
- Remembering the document expiration date
- Being a team player anywhere
- Using Outlook Web Access
- Planning remote access
- Working with two time zones
- Adding international holidays

Joe arrived at the airport for his trip to Brazil and was stuck because he forgot to get his visa. Mario forgot to bring his medicine with him to China. He doesn’t know what it’s called in China or if it even exists. Mary invited a local customer for dinner, and the restaurant didn’t accept credit cards. She was mortified when she realized she didn’t have enough cash on hand. Neal had problems accessing his e-mail from a small town. A phone call at 3 a.m. woke you up because your husband forgot the time difference between Hong Kong and his house. Jennifer brought her cell phone to Italy, and the roaming didn’t work. Traveling and working on the road require a bit of planning if you want to avoid these types of problems.

Traveling requires that you have flexibility and can find solutions for working in different environments while keeping the same quality and frequency of contact with your office and family. Outlook can help you work out of the office seamlessly.

Developing a Travel Checklist

The following list can help you avoid making common mistakes of international travelers:
Open a reminder on the Tasks list with your passport’s expiration date. (See the section “Remembering Expiration Dates,” later in this chapter.

Check the need for a visa or vaccines before the trip.

Order your medicines for the travel period.

Check cell phone roaming availability with your cellular service.

Don’t forget to make your schedule available to your team if you aren’t sharing yet through Outlook sharing properties. (For more on sharing, see Chapter 10.)

Share your agenda with your family. It’s an easy way to be in touch. Don’t forget to inform them of the time shift between your location and your home.

Determine which credit cards the country you’re visiting accepts.

List ATM addresses in the foreign city you’ll be visiting. Check the ATM locator on your credit card’s Web site. I looked for the city of Manaus in Brazil (in the Amazon Region) and found five ATMs available for MasterCard and 14 ATMs for Visa.

Keep funds handy for the international airport tax. Check with your travel agent to determine whether such a tax is necessary.

Check into ordering local maps for your Pocket PC. MSN Maps & Directions linked with Outlook Contacts does not have worldwide coverage.

Check customs rules for business samples, gifts, foods, and electronic devices.

Creating a technology travel checklist

How about creating a travel checklist for your Notebook or PDA Connections so that you can avoid any Outlook communicating problems? Here’s what you need.

**Wireless:** Does your wireless provider have any access point in the visiting country? Visit your provider’s home page or customer service to find out.

**Dialup:** Bring a dialup cord and print the settings for dialup, including the phone numbers to dial in from the country you’re visiting.

**LAN cord:** Bring your notebook LAN adapter and LAN cord to make a connection. They aren’t available everywhere. Print the settings for backup purposes. Throughout my many years of traveling I’ve seen people desperately looking for a LAN house because they brought the gadget but forgot the connection cable.

**AC power:** Europe AC power is 220VAC; is your power supply ready, or do you need an adapter?
Using Cell Phones Abroad

America, Asia, and Europe have different wireless systems, so ask your local operator to check the roaming availability of your system. Note that some systems require you to release your phone number to certain countries to allow the roaming to work. Also, don’t forget to write down the procedure for accessing your cell phone’s voice mail from an international phone (not the cell phone itself). Write this information in an e-mail and file it with your other techtip folder procedures — or put it on a note inside Outlook Notes.

Losing your cell phone means losing your embedded phone list. To avoid this potential catastrophe, synchronize your phone list with Outlook Contacts to keep everything current in your Outlook master Contacts list. Even cheaper phones allow you to synchronize with Outlook. Order a cable to connect your computer with your cell phone and install the appropriate synchronization software. Check your phone company site for a synchronization kit.

Technology Works Almost Anywhere

Before traveling with all your gadgets or wearing your Batman utility belt full of connectors and other gadgets, it’s a good idea to make sure that everything will work abroad. A computer isn’t a Swiss Army knife, after all. You can use three ways to access your Outlook data from anywhere in the world:

✔ You can carry your Outlook folder on a memory card or CD-ROM and open it offline on any computer that has Outlook. See Chapter 3 for details.

✔ When you employ an Exchange server for your business, you can access your online information by connecting and opening your Outlook Web Access (OWA) page and working online.

✔ You can carry Outlook on a device like your Notebook, PDA, or cell phone, thus allowing you to open the information online or offline. Read more in Chapter 3.

Opening your file from a memory card or CD-ROM

Follow these steps to open your file from a memory device or from CD-ROM. Outlook should be open on the third-party computer. Next, follow these steps to access your data:
1. Choose File ➪ Open ➪ Outlook Data File.

2. Search for *.pst file on your memory device (maybe E:\ Outlook.pst) or on the CD-ROM (using d:\ Outlook.pst).

3. Double-click the filename.

   Your Outlook file is open and ready to use. Any changes you make to your file while using the third-party computer are saved with your file.

   Be sure to replace the file on your office computer when you return from your trip so that you use the most current version.

### Connecting through Outlook Web Access (OWA)

If you travel a lot, you're probably accustomed to using Web mail to access your messages from any computer while you're on the road. Outlook Web Access (OWA) gives you the same online access to your entire personal information management (PIM) system in Outlook. Even if you bring a notebook computer with you on the road, accessing your information online has its advantages, including protecting your information from theft or system failures. You can work with your Calendar and your Tasks list online, from any computer, or search for a customer’s phone number from your Contacts list.

OWA is available if your e-mail provider offers the service on an Exchange server. OWA offers all the regular Outlook features online, including Calendar Contacts and Tasks. Today, even small companies with no Exchange server of their own can order the OWA service from an e-mail provider like MI8 (see www.mi8.com). You can also check the Microsoft Marketplace for an Exchange server provider. You can have the service for few bucks a month with no technical expertise needed. For more information, visit the MS Office home page at http://office.microsoft.com and select Office Marketplace from the left column.

OWA looks exactly like your version of Outlook, including all the same folders. . . you're simply accessing your Web mail and Outlook information from an online source. You can synchronize your computer's Outlook folders with the Exchange server so that you can work offline on your computer with the same information. The Outlook folders on your computer are called offline folders. If you're already connected to an Exchange server, right-click your Outlook Inbox and choose Properties. The Inbox Properties dialog box opens with the General options in view. Select the Synchronization tab to show the last synchronized date (see Figure 13-1).
Using an e-mail provider with Exchange server, you can order mailboxes for your family and share your Outlook information the same way expensive systems do.

**Connecting through Outlook Mobile Access (OMA)**

By using wireless Pocket PC and Palm OS devices, BlackBerry, Treo Smartphone, or Windows-based Smartphones, you can get full wireless access to your Outlook mailbox functions if your Exchange service provider or your mobile phone company offers the service. Exchange service providers, such as MI8 (see www.mi8.com), provide these kinds of services.

Cell phones with built-in cameras are sometimes not allowed in commercial buildings. These days, you may also be asked for your notebook serial number by building security personnel. To save time and hassles, print your notebook serial number and cell phone on a card to present at the reception desk and also record an Outlook Note with your computer serial number and save.
To open a note:

1. **Click Notes on the Navigation Pane.**
   
   If you don’t see the Notes button on the Navigation Pane, click the Configure button, in the Navigation Pane lower right to add the button.

2. **Choose New ‹ Note to open a new note.**

3. **Type the notebook data into it.**

4. **Click Save And Close.**

   You can also just double-click in an empty area of the notes screen to open a new note.

### Remembering Expiration Dates

People tend to forget about expiration dates on documents that stay valid for a long time, such as driver’s licenses, passports, and vaccine dates. When a document is valid for three, five, or ten years, you obtain it and tend to forget about it until you need them renewed . . . yesterday!
Don’t get stuck in the airport anymore because you didn’t check your visa or get a vaccine — these items are the first things you should renew when you’re traveling to a foreign country. Some consulates can be slow or may not even have an office in your city, so check the country’s requirements first and then schedule your applications well in advance. Passports are generally valid for a long time, so use the Task reminder one month before your passport’s expiration date to create a reminder:

With Outlook open on the Tasks list.

1. **Click the New button to open a new Task.**
2. **Type Passport Expiration into the Subject line.**
   
   You can open a Task to remember expiration dates for any document, including your passport, driver’s license, or any other document. Simply type the name of the document into the Subject line.
3. **Set the expiration date as the due date.**
4. **Set the Reminder date to one month before the due date.**
   
   Be sure to set the reminder with enough time to renew your document.
5. **Click the Save And Close button.**

Outlook now reminds you of your expiration date so that you have plenty of time to renew your passport.

### Coordinating Time Zones

Working daily with other locales and countries or from other countries means working with different time zones. Some people even wear watches that run two time zones at the same time. Likewise, Outlook allows you to add different time zones to your Calendar so that you can avoid waking up your spouse at 3 a.m. when you’re working in Hong Kong and forget the time shift. Adding Hong Kong’s time zone to your Calendar is easy.

1. **Choose Tools ➪ Options and click the Calendar Options button.**
   
   The Calendar Options dialog box opens.
2. **Click the Time Zone button to open the Time Zone dialog box, as shown in Figure 13-2.**
3. **Type your label in the Time Zone Label text box.**
   
   You can type ARZ if you’re in Arizona, for example.
4. **Check the Show An Additional Time Zone check box.**
5. **Select a time zone from the Time Zone drop-down list.**
You can select Hong Kong, for example.

6. **Type the city or country name in the Label text box.**
   
   You can type HGKG for Hong Kong.

7. **Click OK.**

Your Calendar now looks something like Figure 13-3.

If you work coast to coast in the United States, you can add the three time zones in the same way you added the Hong Kong time zone.
Finding You Anywhere Easily

Your clients and coworkers often need your input, even when you’re working abroad or outside the office. Outlook can help you keep your office informed about your external meetings and business trips. Making your agenda available to your company is easy. When you’re connected through an Exchange or small business server, you can make your Calendar (or parts of it) available to your colleagues so that they can find you in just a few clicks. You can also print a copy of your Calendar, publish it on the Internet, place it on a public folder, or use a SharePoint server. The SharePoint server is another Microsoft product that makes collaborative work easier. (You can read more about SharePoint and other sharing procedures in Chapter 10.)

Besides making your schedule available for others to read, you can give certain individuals (your assistant, for example) the power to add new appointments to it. Chapter 10 explains how to share your Calendar.

Tip

When you’re out of the office visiting a client, you don’t have to waste time writing your contact’s address down for your office; instead, you can attach the contact’s information to your Calendar appointment in Outlook. This connects all the relevant information in your appointment book for single-click access, and makes it available to your team if you choose to share your Calendar. Follow these steps to attach your contact to your appointment:

1. Open a new appointment in the Calendar.
2. Click the Contacts button in the lower-left corner.
   The Select contacts dialog box is displayed.
3. Select the applicable contact.
   The contact is linked to your appointment.

Keeping in Contact with Your Family

If you’re married or have kids, traveling on business can require more from you than it may from a single person. You must be available by phone, e-mail, or instant messaging at any point in the day — not only to keep the relationship running, but also to be available for the many little emergencies that happen all the time in families. Leaving a copy of your agenda with addresses and phone numbers can help your family connect with you when necessary. Outlook can help you deliver your travel agenda to your family in several ways.
The easiest way, of course, but the most likely to be misplaced, is to simply leave a printed copy of your agenda at your house. Just open your Outlook Calendar and print a copy of your agenda. Don’t forget to print the phone numbers of your hotel or of the other places you’ll be.

The following sections describe some other options.

**Publishing your agenda on the family home computer**

If you have a local network at your house, connect your computer to the network, open your Outlook Calendar, and follow these steps:

1. **Choose File ➤ Save as Web Page.**
   The Save As Web Page dialog box appears, as shown in Figure 13-4.
   You can set the starting and ending publishing date to show only your trip schedule.

2. **Set the trip’s duration by using the Start date and End date dialog boxes.**
   Adding dates publishes your agenda for the period listed; other dates aren’t published and appear blank. You can publish any calendar period you choose — from one day to one year.

3. **Check the Include Appointment Details check box.**
   This option gives others access to details such as meeting locations, phone numbers, and contact names.
4. Enter a name in the Calendar Title area.
   For example, you can use your name so that others can quickly see that this schedule belongs to you.

5. Browse through the home network to choose a folder on the destination computer, such as Shared Documents on a Windows XP family computer, for publishing your information.

6. Highlight the chosen folder and click Select.

7. Click the Save button to publish the Calendar.
   The Calendar is now available on the destination computer with the specific dates you chose to publish.

To view the schedule, open the shared folder located on the family computer and click the Calendar file to open it. Scroll down and read the appointment and event details on the right side of the Calendar. With this information, your family can quickly find and call you in an emergency. Don’t forget to include your hotel reservations on the Calendar.

You can also publish your Calendar on a stand-alone home computer. When you don’t have a home computer network, save the published Calendar on a floppy disk or CD-ROM. Insert the disk in your home computer, select the Calendar by its saved name, and click to open and read it.

### Publishing your agenda online

When your family is spread out across several different computers in different locations, you can publish your calendar online. In the same way people are publishing their personal blogs, you can publish your agenda on a Web site available to your family. Check with your Internet provider about how to upload your agenda. You publish your agenda the same way you do to save it on the family computer (see preceding section). When your family accesses the page on the Internet by using Internet Explorer, your published Calendar opens without Outlook. Publish it in an out-of-the-way folder (with no links to it) on your site so that nobody will know that it’s there except your family.

### Giving access to your Calendar folder

Running your own business by using an Internet provider with an Exchange server allows you to give Calendar access to your colleagues and family through sharing properties. Chapter 10 shows you how to share your Calendar and how to access a third-party Calendar. You can give your family a password so that they can open your Outlook Web Access (OWA) page and read your information. The OWA page is a synchronized copy of your own computer Outlook folder with your Calendar Tasks and mail folder available online.
Adding Foreign Holidays to Outlook

If you call a foreign country during one of the national holidays, you’re likely to waste your time and money. Without Outlook, you may not be able to recall Hong Kong’s new year or when the Carnival takes place in Brazil. You can add the national holidays from any country to your Calendar to avoid making calls at the wrong times.

1. Choose Tools➪Options to open the Options dialog box.
2. Click the Calendar Options button.
3. Click the Add Holidays button.
   The Add Holidays To Calendar dialog box opens.
4. From the list, select which country’s holidays you want to add and click OK.
   The holidays start loading into your Calendar.

You can also add religious holidays of the Christian, Islamic, and Jewish religions to your Calendar. Use them for your own religion as well as to observe your customers’ religious holidays.
"Sure, at first it sounded great—an intuitive network adapter that helps people write memos by finishing their thoughts for them."
In this part . . .

Millions of small actions — from posting a payment check on time to closing a lucrative contract — build any business. You can use Outlook to track the boring, day-to-day tasks. You can enter that tip you received during a phone call with your customer into a Journal form with a time stamp and then retrieve it by opening the customer’s contact. Visiting your customers requires planning and organization in order to achieve the best results.

In addition, marketing programs, besides needing creativity, need organization. You can start with simple checklists that you develop using Outlook. You can even create filters for selecting a customer base as you wish.
Sales activities differ from one business to the next. If you’re running a business where your customers keep buying from you weekly, monthly, or at least once a year, you have to take care of your customer relationships in addition to managing the ordering cycle. Getting the order and vanishing like a ghost doesn’t add value to your sale. Outlook can help you track your activities for each customer and even remind you to call your customer weekly.

Keeping a Client

Pressure to increase revenues often translates to finding new accounts at the expense of maintaining existing accounts. You’ve likely heard stories about surprised managers crying, “Oh, my gosh, this company used to be my top customer. Now they moved to our competitor without even negotiating with us!” What happened?

Taking care of your customers after you get the order — and keeping the relationship strong — is an art. Do you know how many times you have called or visited each customer lately? Most salespeople don’t control the number of contacts they make with each customer. However, you can classify your customers according to their sales potential and define the number of weekly calls or monthly visits each receives. Outlook can help you touch base with your customers according to your schedule.
Categories allow you to manage customers in groups. You can examine the groups and detect missing or unfinished activities for certain customers. Then you can schedule a certain number of visits or social meetings with your customers, such as happy hours or lunches.

You can classify your customers by using four categories:

- **Platinum**: The best customer
- **Gold**: An excellent customer
- **Silver**: A good customer
- **Standard**: An average customer

You can also define a call frequency for each category. You can then use the categories to classify each client according to sales potential and view your Contacts list by categories (see Chapter 4). Table 14-1 can help you plan your activities for each customer; it’s for customers placing orders at least quarterly.

<table>
<thead>
<tr>
<th>Classification</th>
<th>Visit</th>
<th>Phone Calls</th>
<th>Social Meeting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platinum</td>
<td>Weekly</td>
<td>Daily</td>
<td>Monthly</td>
</tr>
<tr>
<td>Gold</td>
<td>Twice a month</td>
<td>Twice a week</td>
<td>Once a quarter</td>
</tr>
<tr>
<td>Silver</td>
<td>Once a month</td>
<td>Once a week</td>
<td>Once every six months</td>
</tr>
<tr>
<td>Standard</td>
<td>Once a quarter</td>
<td>Twice a month</td>
<td>Once a year</td>
</tr>
</tbody>
</table>

Of course, you may not want to follow such a rigid contact cycle as Table 14-1 suggests. Maybe you have some customers that you just like spending more time with. Maybe your Platinum customer doesn’t want to receive your call at 9 a.m. every Monday morning. To achieve a balance and not lose track of your customers’ needs, use Table 14-1 only as a guide.

**Scheduling customer contact frequency**

Outlook offers many ways to remind you about your client appointments and calls. One way is to create a recurring Task. However, the objective isn’t to receive a reminder on the same day at the same time every week, but rather to remember the next required action after the end of a call or meeting. For example, after finishing a call with your customer on Friday, set the reminder...
for next week on a different weekday. And instead of using Tasks for simple reminders, use the Contacts follow-up flag as a simple reminder, thus leaving important Tasks in your Tasks list and the reminders in the follow-up flags.

To open a Task for each Platinum customer and then create a reminder for the next action, follow these steps:

1. **Open one Task for each Platinum customer.**
   
   Read Appendix B for more details.

2. **Type** Customer’s Name Touch Base Reminder **in the Subject field.**

3. **Write down your last actions with the date, such as the last visit date and your schedule for the next visit, or the last phone call date and your schedule for the next phone call.**

4. **Set up the reminder for the next scheduled event.**

5. **Save and close each Task.**

   The Task looks like Figure 14-1.

Creating a recurring Task is helpful for five to ten customers. If you have a group of 50 active customers, you add 50 Tasks to your list. See the next section to find out how you can avoid excessive numbers of Tasks by using the flags.

---

**Figure 14-1:**
Use a reminder to touch base with Platinum customers.
Flagging a contact

If you’re working with a large group of contacts, a better option than setting up Tasks (see previous section) is to use a follow-up flag. You can use this flag to set up five options: Follow Up, Call, Arrange Meeting, Send E-Mail, and Send Letter.

To view all your customer reminders in one list by category, set up your contacts list by using these steps:

1. With the Contacts list open and displayed by Category, click Customize Current View on the Navigation Pane.
   The Customize View dialog box appears.
2. Click the Fields button on the Customize View dialog box.
   The Show Fields dialog box appears.
3. Select Miscellaneous Fields from the Select Available Fields From list box.
4. Select the Reminder Time and Reminder Topic fields.
5. In the Available Fields list, click the Add button for each field to move it to the Show These Fields In This Order list.
6. Click the New Field button to create the Call Date field with the time format.
7. Adjust the new fields in the Show These Fields In This Order list according to your needs.
8. Click OK.

Your Contacts list now has three new fields: the Call Date field for typing your last call, the Follow-up field to see the next action, and the Reminder Time field (see Figure 14-2). This customized list displays your reminders together.

Instead of opening each contact to update it, you can update the list in the following way:

1. Select the contact name from the list and type the date in the Call Date field.
2. Right-click the contact name and choose Follow-Up.
   The flag for the follow-up box opens.
3. Select an action, such as Call, Arrange Meeting, or Follow Up, from the Flag To list box.
4. Select the date and time from the Due By list box.
5. Click OK.
The action and the reminder time appear on the selected contact line. Now you can control, in one page, all your customer actions — from the last contact date to the reminder for the next action. By setting reminders for every customer, you can easily remember to contact each customer according to your schedule.

BCM Business Contacts and Accounts provide the same customization as explained here. You can also use add-in software, such as Reminders, by e-mail, available at RSOutlook. You can then send the reminders to your mobile device.

Don’t set all follow-up reminders to the same time, such as Monday morning at 9 a.m. Schedule the reminders throughout the day and week.

**Tracking your customer history**

Salespeople aren’t always organized and often spend a lot of time looking for a proposal or trying to remember the date and subject of the last phone call. Using BCM (see Chapter 6), you can link all your actions to a particular customer and access all the information from the Contact record. The Outlook Contacts Activities page can show you all actions related to a contact. You
can link any document, Task, appointment, or meeting phone log to your customers and read them in one click. Here's how:

1. **With your customer contact open, choose Actions ▸ Link ▸ File.**
   
The Choose A File dialog box opens.

2. **Select your file, such as Mary’s Proposal 321.**

3. **Click OK.**
   
The proposal file is linked with Mary’s Contact record.

Besides linking external files and documents to your contacts, you can also link Outlook appointments, Tasks, phone call journal entries, and e-mails (both sent and received) and then read them in a single list.

1. **With your customer contact open, choose Actions ▸ Link ▸ File.**
   
The Link Items To Contact box appears, as shown in Figure 14-3.

2. **Select a folder, such as Tasks.**

3. **Select a Task from the Task Items list.**
   
   For example, I chose a Task called Deliver The Proposal To Gold Customer.

4. **Click Apply.**
   
The item is linked to your customer contact.
Automating links to your contacts

Linking each item to your contact manually is tedious and can potentially add hundreds of weekly actions to your work, making you lose more than your patience. You may forget to link items or lose track of e-mails, Tasks, and appointments related to your customers. Fortunately, Outlook can automatically link the items related to your contact in the following way:

1. **Choose Tools ➪ Options.**
   The Options dialog box appears.

2. **Click Journal Options.**
   The Journal Options dialog box appears, as shown in Figure 14-4.

3. **Select the items to be linked on the Automatically Record These Items list box, including e-mail message meetings, Tasks, and other actions.**

4. **Select the contacts to be linked from the For These Contacts list box.**

5. **In the Double-Clicking A Journal Entry area, select the option called Opens The Item Referred To By The Journal Entry.**

   The Journal has a wider application than simply linking Outlook items to a contact. The Journal can also measure the time you spend working on a document or present your documents in a timeline chart, showing each one on the date that it was used. Read Appendix D for more details about recording office documents in the Journal.

6. **Click OK.**

   All Outlook items related to your contacts are now linked.
Reading your client history

Searching for customer files in your computer’s folders can be tiresome. You may store one Word document in one place, an Excel spreadsheet in another, and the date of your last meeting in the Calendar. You can, however, have all this information organized for you by opening only one page, which means no lost time searching for the information.

To read your customer history:

1. **With the contact open, click the Activities tab.**
   The Activities page appears. When the Show list box says All Items, all your activities related to the open contact are listed, as shown in Figure 14-5.

2. **Click any item in the list to open the linked document or Outlook item.**
   The information is displayed without your having to look for it.

![Figure 14-5: The Activities page lists the customer history items.](image-url)
Creating Sales Targets

Past sales reports, backlog orders reports, and client histories can all give you a decent picture of your business today, without the need of a crystal ball. Open sales proposals and sales opportunities accumulated over a period of time can help you forecast short-term sales and create sales objectives for each customer — with your insight and analysis, of course. Likewise, listing the sales targets for a certain period helps you monitor each customer and achieve your sales goals. Creating a customized contact list with fields for your quarterly objectives, including your quarterly sales goal and your goal today, gives you an actual-versus-forecast picture. Figure 14-6 shows a customized customer list with a sales goal for each customer. (Chapter 4 covers customizing the Contacts list for sales activities.)

The sales goal is only the final parameter. Organizing your open opportunities and proposals, listing the missing items, taking actions, and negotiating with your customers helps you achieve your goals with less stress. You can open a Task to control every open sales proposal. You can also customize the Tasks list in the same way that you can customize the Contacts List (see Chapter 4).

To customize your Contacts list by category:

1. With the Tasks list open By Category, select Customize Current View from the Navigation Pane.

The Customise Fields dialog box appears.

Figure 14-6: You can customize the Contacts list for sales actions.
2. Click the Fields Button.
   The Show Fields dialog box appears.
3. Click the New Field button to create a new field.
   The New Field dialog box appears.
4. Type the name in the Name field.
   In the example, the field name is Value.
5. Select and move the fields in the Show These Fields In This Order list according to your needs.
6. Click OK and close the Show Fields dialog box.
7. Create the Proposal category.
   See Chapter 4 for more details on how to create a category.
8. Select every open proposal on the Proposal category.
   After this setup, you can close all categories in this view and see only the proposals (see Figure 14-7) with their due dates and status. Select the proposals and cut and paste them into an Excel workbook to analyze them and create forecasts and charts.

The Tasks list view, which includes the value fields, enables you to follow up with each proposal; the reminders turned on for the next step appear to remind you of the next action.
If you’re a BCM user, you can create a similar report to the one in Figure 14-7 without having to add new fields. Just use BCM’s Opportunities reports, such as the one shown in Figure 14-8. Unfortunately, there are no reminders available in BCM, but the numerous fields in BCM records let you create reports with all kinds of data in them. Use either BCM or Outlook Tasks, whichever best fits your needs. For more information about BCM and BCM reports, see Chapters 6 and 7.

Each BCM Opportunity is linked to its Business contact or Account. You can link any open Task to its contact by clicking the Contacts button at the bottom-left side of each Task and choosing the desired contact name. Open your contact and click the Activities tab to see all the Tasks associated with this contact. Read about the details in Chapter 15.

**Analyzing Quotes to Help Close Orders**

A distributor’s sales manager analyzes the number of quotes sent compared to the number of closed orders. The number is below 10 percent. The president of the company demands that any request for quote — even for nonregistered customers — must be sent promptly, so the manager analyzes all the quotes, one by one. He detects that most of the unclosed orders aren’t from current customers. He then negotiates with the president to create a new rule: to send quotes only for registered customers. Now, the receptionist asks every incoming phone call whether the person is a registered customer. If the
answer is no, she sends an e-mail form, customized by using Outlook forms, (see Chapter 5 for customizing a form), to register the customer. The result was fewer phone calls for useless quotes, and the number of closed orders versus quotes is four times higher than before. Having fewer prospects increased the company billings.

Analyzing your client’s current backlog report not only shows your future billings but also shows the way the client is placing new orders. You can detect a drop in orders so that you can work to get a new order or understand the customer’s current trend. Search the backlog report for orders that are about to hit the delivery stage and then follow up with each customer on the appropriate delivery date. Set up Tasks to remind you to follow up with each customer.

When your business is only you, you can’t delegate. But when the business is growing, inform your customers about your growing team. Introduce all new team members and distribute their phone numbers and e-mails. Tell your customers how the new staff members can support them on your behalf, even helping to close orders. The VIPs are your customers, and they must be supported by the entire team, not only by you.

Classifying Messages

If you deal with hundreds of messages each day, besides the Zen of Inbox Management (see Chapter 8), you may need to employ other tactics to classify and organize messages — especially for sales purposes. Using colors to organize messages, having Outlook search for specific words within messages, and even forwarding the messages to a mobile device are all helpful ways to keep organized.

Coloring messages

Coloring your messages can be a helpful tactic to get your mind around the wad of e-mails you receive every day. You can identify arriving messages by using colors — your boss’ messages in pink or your best customer in green — and simplify your Inbox, both visually and psychologically. To set up the colors for arriving messages, use the Organize Pane.
Don’t use all the colors in the rainbow to classify each of your incoming messages, because your Inbox will end up looking like a carnival parade. Overusing this feature defeats the purpose of coloring the messages.

To apply color to your messages:

1. **With your Inbox open in Outlook, choose Tools ➪ Organize.**
   The Organize Pane is displayed on the top of your Inbox.

2. **Click Using Colors on the left side of your screen (see Figure 14-9).**
   The Organize Pane shows the fields to color the messages.

3. In the Color Messages list box, select **From**.

4. **Select the desired e-mail from the Inbox to apply the color to or type the e-mail address into the text box.**

5. **Select the color from the list box.**

6. **Click the Apply Color button.**

From now on, the titles of the messages from this customer appear in the color you choose. Using color this way enables you to see important messages in the blink of an eye. You can classify your top five customers (perhaps including your boss) by giving each one a different color.

You can also apply colors to messages containing certain words or phrases. Colors and filters are a great way to organize and prioritize your actions relating to arriving messages.
Follow these steps to apply color to select words:

1. **Click the Automatic Formatting command at the top of the Organize Pane.**
   The Automating Formatting dialog box appears.

2. **Select your rule on the Rules For This View list box, such as Mail Received From John@123.Com.**

3. **Click the Condition button.**
   The Filter dialog box appears (see Figure 14-10).

4. **Type the words to search for, such as p.o., purchase order, rfq, and request for quote — all separated by semicolons — in the Search For The Words text box.**

5. **Using the In drop-down box, decide where in the message the search should be completed.**

6. **Enter the e-mail address into the From text box.**

7. **Click OK.**
   Messages with the words you entered now appear in the color you choose, thus calling your attention to these special messages.

**Selecting arriving messages by subject**

When you use colors and filters (see preceding section), you can select and color messages that come in from a particular person or that contain specific words. You can also create a rule to automatically categorize all arriving quote requests from your customers. Using the e-mail view By Categories, you can then list all incoming proposals together in one place.
With the Inbox open:

   The Rules Wizard opens.

2. Select Start From A Blank Rule.

3. In the Step 1 Select When Messages Should Be Checked, select Check Messages When They Arrive.

4. Click Next.
   The wizard displays a new page.

5. In the Step 1 Select Condition(s) list, select With Specific Words In The Subject.

6. In the Step 2 area, choose Specific Words.
   The Search Text dialog box appears.

7. In the text box Specify Words Or Phrases To Search For, type the words to search for, such as Quotation, Proposal, RFQ, and Quote, separated by commas.

8. Click Add.
   The text moves to the Search list (see Figure 14-11).

9. Click OK after you add all the desired words and phrases.

10. Click Next to see the new wizard page.

11. In the Step 1 Select Action(s) List, select the Assign It To The Category Category.

12. In the Step 2 area, select Category.
   The Categories list opens.

13. Select Proposal and click OK.

14. Click the Next button twice, skipping the exceptions list.
   The rule setup is ready (see Figure 14-12).
15. Type the rule’s name in the Specify A Name For This Rule text box. You can call the rule Proposal, for example.

16. Click Finish.

The Rules And Alerts list opens.

17. Select the rule you named, click Apply, and then click OK.

The rule is ready. All requests are now filtered and listed in one category — the Proposals category, in this case.

When you apply rules to your Inbox, you can also place a greater focus on your sales activities and related messages. To list your messages by category, choose View ➪ Arrange By Categories.

All arriving messages with the requested words are listed in the Proposals category. Sales managers can use the same technique to search for words and move them to specific folders. This way, they can route sales team reports to the appropriate reports folders.
Receiving Outlook messages on your cell phone

Mary is waiting for an important order from her top customer, but she can’t wait any longer. To be informed of the arriving message, she makes a rule that when a message comes in from important@veryimportant.com, Outlook should send a copy to her mobile device’s e-mail address. To send the e-mail to a cell phone, use the following rule:

   The Rules Wizard opens.
2. In Step 1, select Send An Alert To My Mobile Device When I Get Messages From Someone.
3. Follow the wizard instructions.

Check with your cell phone company about your phone’s capability to receive messages and their maximum sizes. In the worst case, you can probably receive the message subject, the sender, and arrival time.

You can also receive Outlook’s Reminders as SMS messages at your Mobile device by using available Add-in software such as Reminders by SMS. The software is available at www.rsoutlook.com. The add-in reminder software sends Outlook Reminders from Tasks, appointments, and mail messages to your mobile device through Short Messages Service (SMS), thus helping you keep your appointments no matter where you are. Besides the add-in software, you can contact your mail service provider or your cell phone company to determine what other wireless synchronization services are available.
Chapter 15
Planning, Prospecting, and Visiting Customers

In This Chapter
- Getting information about a new customer
- Planning a visit to a prospective customer
- Doing your homework after visiting a customer
- Sending and following the proposal
- Using BCM to track your customer account

A salesperson who doesn’t properly plan looks like a merchant in the Moroccan tourist market, hustling and negotiating to get the order. Although nothing is wrong with this type of selling, most likely your prospect isn’t a tourist searching for a bargain in an open-air market. You have to develop strategies to create good relationships. Winning the customer’s confidence means creating business for the long term. In this chapter, you discover the basic procedures for organizing a sales effort — from prospecting to closing an order — using Outlook or Business Contact Manager (BCM). (For more on BCM, see Chapter 6.)

This chapter explains the step-by-step procedures for building a customer profile and tracking all customer activities with Outlook Contacts or Outlook’s Business Contact Manager (BCM) add-in software. Both options are good, but different. For example, whereas in Exchange server you can load and share contacts, BCM has ready-made business forms. Which one you use depends mostly on what you need in a program.

Loading a New Customer Profile

Joe Newcomer was hired as a new salesperson to be in charge of prospecting and developing a new customer base. As soon as he starts, he’s assigned an unknown company to prospect. Instead of going for a blind meeting, Joe does a little Internet research to collect some customer information. He visits the
customer’s home page and collects some data. Next, he uses search engines such as Google and Yahoo! to search by company name and gets even more information. Third, he searches by the company’s products and services to gather information about their competition and product placement. He then loads all this client information into a Contact record that he customizes as a company profile (see Chapter 4). Figure 15-1 shows this record.

You can type information that doesn’t fit into your Contact record fields into a Journal note in the following way:

1. **With the contact on the screen, choose Actions ➪ New Journal Entry For Contacts.**
   
   The Journal Entry form appears. The Journal title always contains the contact name.

2. **In the Subject text box, type a name to remember the information you’re saving.**

3. **Select Note from the Entry type list box.**
   
   The Entry Type list box shows nearly 20 options, including Document, Phone Call, and Letter.

   The Start Time date box shows the current time, but you can change it as desired.
4. Type or paste the information at the bottom of the record.
   Figure 15-2 shows information in a customer record.

5. Click the Save And Close button.

![Figure 15-2: You can use a Journal note to hold customer information.](image)

**Mapping Your Client’s Location**

You can also use BCM to calculate the distance and driving time from your office to your customer’s place. To calculate the distance, open your prospective contact to find the map:

1. **With the contact open and in view, click the Traffic Sign button (display Map of Address) on the toolbar.**
   If you’re online, Internet Explorer opens to the MSN Maps & Directions site, showing the customer area map. Figure 15-3 shows an example.

2. **At the MSN Maps & Directions site, select the To Here command under Get Directions.**
   The new page shows the Start Address entry box.

3. **Type the starting address.**

4. **Click the Get Directions button.**
   The map is displayed with the route directions, including the distance and the time needed to get there. Figure 15-4 shows the example at this stage.
Working on a Customer's Request

After a customer meeting, you probably have plenty of homework to do back at the office. You may have to prepare a request for quote and estimate the time to delivery of a product. You also may need to prepare for a potential sales order.
Before writing the proposal, you may need to get information about delivery time from the product department, information about special payment terms, and discount information for volume orders. Request the support to close a proposal by using the Tasks assignment instead of using e-mail in the following way.

**Requesting internal support**

In a small company, you can probably just talk with your boss and get the answers you need. But in a larger organization, you should send a Task to the product department, asking for the lead time on a special order. You can also assign a Task to the credit department, requesting the information needed to release a special order payment terms.

You can assign any internal support by using Tasks instead of e-mails, thus creating commitments along with the messages. The following example steps walk you through the details.

1. **Type your subject into the Subject line.**
   
   For example, you might type, “Lead-time for Product ABC in a special package. Value $50,000/year.” Typing the value on the Subject line prioritizes the answer.

2. **Select High from the Priority list box.**

3. **Change the Status to Waiting On Someone Else.**

   This option increases the importance of the Task.

4. **Select tomorrow’s date as the Due Date.**

5. **Type your explanation text.**

   For example, you can type something like “Mark, Please evaluate the file attached and inform the lead time after receiving the order. Please also indicate the most economical volume for a monthly delivery. Thanks.”
6. Click the Insert button to attach the file with specification and quantities.

7. Click the Assign Task button.

8. Type the e-mail address of the person in the To text box (see Figure 15-5).

9. Select Keep An Updated Copy Of This Task On My Tasks List in order to not lose track of your request.

10. Select Send Me A Status Report When This Is Complete to keep tabs on the completion of the job.

11. Click Send.

After requesting the Task, don’t forget to follow up with a phone call.

---

Sending a proposal

After getting all the information and the proposal ready, you need to call the customer to arrange a meeting to discuss the proposal. During this meeting, you present and explain the proposal and note the customer’s reactions to it. Be prepared for negotiations. Some customers request the proposal before the appointment; in this case, send the proposal attached to an e-mail. Instead of using an e-mail receipt confirmation (which can offend your customer), you can insert a follow-up flag in the e-mail.

With the proposal e-mail typed and ready to send:

1. Click the Flag button.
2. Select Follow Up in the Flag To list box.
3. Select the current date in the Due By date box.
4. Click OK.

The follow-up message appears at the top of the e-mail as a reminder to your prospect (see Figure 15-6).

---

**Following up on the proposal**

Following up on proposals is not a simple and rational task. You have to recognize when it’s time to negotiate the order. You have to listen to the customer’s comments and provide information on how your product or service can solve their needs. Task reminders are a good way to start your activities, but your negotiating skills are the key to winning the order.

You can link each proposal to a Task and then set up reminders to follow up until the order is won:

1. **Select the Proposal e-mail from Sent Items box.**
   To move the e-mail into a Task, you have to move over some commands to open the new Task.

2. **Drag the sent e-mail to the Tasks button in the Navigation Pane.**
   The My Tasks window appears showing the Tasks folder.

3. **Drop the e-mail into the Tasks folders.**
   A new Task opens with the e-mail inserted into it.

4. **Select and link the prospect contact by clicking the Contacts button in the bottom-left corner of the open Task.**
   The phone number or e-mail address is then linked to the Task.

5. **Select the Proposal category by clicking the Categories button in the bottom-right corner.**
   Using the categories helps you list all open proposals by using the Tasks View By categories.
6. Set the Due Date to about five days from now.
7. Set the Reminder to tomorrow's date.
8. Choose Insert ➤ File to insert the proposal file.
9. Click the Save And Close button.

When you receive the reminder, call the prospect to check on the proposal status and to view his analysis and comments. You can then reply and overcome the customer's objectives. Then set up the reminder for the next call, as negotiated with the customer. Repeat this basic process until you close the order and turn your prospect into a customer.

**Recording and reading the entire customer history**

You can link to all your customer's details by using the Journal (see Chapter 14) and also create phone logs and notes by using the Journal Entry command. You can then read your customer's historical data by following these steps:

1. **With the Contact record in view on the screen, click the Activities tab.**
2. **Select All Items from the Show List list box.**

   The activities-linked files, meetings, appointments, phone call logs, notes, Tasks, and e-mails appear, as shown in Figure 15-7.

![Figure 15-7: The customer's history appears in the Activities section.](image)
Using BCM to Prospect a New Customer

If your company doesn’t use the Exchange server and doesn’t have anyone to customize Outlook, you can use BCM rather than Contacts to manage your prospects. To open the BCM new Account form:

   The Account list appears.
2. Click the New button.
   The New Account page appears.
3. Complete the customer information in each appropriate field.
4. Click the Save And Close button.

See Chapter 6 for more details about using BCM to store your customer information.

Recording customer information

To file the important information collected at the customer site, which doesn’t fit neatly into the fields of the Account record, you can open a note. Because the note is listed in the Account History, you need to type a title to make spotting the note in the history easy.

When your Account form is open:

1. Choose New ➪ Business Note in the Account History frame.
   A Business Note appears.
2. Type your information from the company site into the comments text box and type your subject into the Subject text box.
   For example, “Information from their site” would be a good subject that makes finding the information a quick task.
3. Click the Save and Close button.
   Open a new note whenever you need to type more information. Your two saved notes appear in the Account History.

Linking appointments

To set up an appointment from the account form, your best option is to open the appointment from the Account History Items, linking it to the prospect account.
To do so, choose New Appointment in the Account History frame. The appointment appears so that you can fill it in and save it. The Appointment is linked to the Account History. Figure 15-8 shows a New Account form. Notice all the available information about the prospect at this moment. You can even print the information and carry it with you to your appointment.

Remember to click the customer map button linking with MSN Map & Directions to calculate the distance and time between the two offices. (See the section “Mapping Your Client’s Location,” earlier in this chapter.)

![Figure 15-8: You can use BCM Account to record new prospect information.](image)

**Working on a customer’s request by using BCM**

A customer visit brought in a $50,000 per year “request for quote.” You need to create and fill in a new Opportunity and then send Tasks to other departments so that you can control your proposal. Open your Account and choose New Opportunity in the Account History. After the Opportunity appears, fill in the following fields:

1. **Type an updated name to the proposal into the Opportunity Title text box.**

   In the example, I use *Best Customer special packaging proposal # 1.*
2. Type the new expected Due date into the Close Date field.

3. Type the competitor’s name into the Competitors field.
   Knowing your competitor helps you building your negotiation strategy.

4. Type 25% into the Probability field, because you feel a good starting chance.

Your prospect demands a proposal with several items and descriptions that don’t fit into the current Opportunity fields. You can use the Product And Service Items List to value the entire package in the following way and link the proposal file with detailed information into the Opportunity History.

1. Choose Add: Create Your Own.
   The Add Item dialog box opens.

2. Type the item name in the Item Name field.

3. Type a description in the Description field.
   In the example, I use special packaging.

4. Type the total opportunity price in the Unit Price field.
   In the example, I use 50,000 as the whole package price

5. Type 100% in the Adjusted Percentage field.
   There is no discount or judgment yet.

6. Type 1 in the Quantity field.

7. Click OK.

Assigning internal support

The Opportunity total value is recorded in the Product And Service Items List. After updating the information, you need to assign Tasks to other departments. To assign a Task and link in the Opportunity History Items, follow these steps:

1. With your Opportunity open, choose New: Tasks from the Opportunity History items.
   The new Task appears.

2. Fill in the Task assignments and then send and save them.
   You can view the Tasks listed in the Opportunity History Items list.

Simply repeat the preceding steps for each new assignment.
Updating the opportunity

Organizing and linking files from the beginning is a smart way to not lose time searching for information. After receiving the assigned information and writing the proposal, you should link the file to the Opportunity.

With your Opportunity form open:

1. **Choose New** ➪ **File**.
   The Link File dialog box opens.
2. **Select the proposal by its filename**.
3. **Click OK**.
   The Opportunity is up-to-date (see Figure 15-9).
4. **Click the Save And Close button**.
   The updated Opportunity is linked to the Account.

---

**Figure 15-9:** The Opportunity History items lists all actions and files to each Opportunity.

---

Following up on the proposal by using BCM

You can e-mail your proposal to the customer and then follow up the next day to see what she or he thinks about the proposal.
With your Account open:

1. Choose New\r\nMail Message in the Account History Items in the lower left side.
   The new e-mail appears.

2. Write your message, attach the file, and use the Read Confirmation request or Follow-Up request as desired.

3. Send the message.
   The e-mail is sent and linked in the Account History items
   You have two options to follow up the proposal on time: using a flag or a Task (see the next two sections for details).

**Flagging as a reminder**
Use your Account flags to remind you of Tasks as follows:

1. With your Account open, click the Follow Up flag in the toolbar.
   The Follow up flag dialog box appears.

2. Select the due date in the Due By box.

3. Click OK.

**Reminding with a Task**
You can open a new Task to remind you of a Task.

1. With your Account open, choose New\r\nTask in the Account History Items in the lower left side.
   The new Task appears.

2. Type the proposal title in the Subject line.

3. Select the Reminder Selection Box.

4. Select the Reminder date and time in their selection boxes.

5. Click the Save And Close button.
Chapter 16

Minding Your Marketing Methods

In This Chapter

- Communicating with your customer
- Planning and implementing direct-mail campaigns
- Executing an e-mail campaign
- Planning events and pulling them off
- Creating telemarketing strategies

The Marketing department of Fake, Inc. had an excellent new product launch with advertising and direct-mail campaigns for their customers. Unfortunately, they forgot to communicate and prepare their sales channels to support the launch. Their resellers weren’t prepared for all the requests and inquiries they received, and they ended up losing orders. The lesson? Don’t let pressures force you into releasing a campaign without all the items checked and approved. Otherwise, you’ll be marketing a negative image of the company, and the expense of the campaign will not be well compensated. You can use Outlook tools to accomplish these basic marketing activities. This chapter shows you how to use the checklist to improve your marketing results.

Know Your Audience

Who are your customers? Do they know your product or service? Do customers know where to buy it?

Anyone who knows the answers to these questions and takes the proper actions should be a millionaire. Unfortunately, the answer is not the same for all products and all people. Consumer goods companies specialize in mass communication over a broad audience.

To improve results, companies are moving their campaigns from TV to Internet, measuring their expenses and the return on their investments. A pizza delivery store defines its territory and distributes its menu to most of the residents within the territory, working to be better than its competitors and notifying its customers by sending delivery menus with weekly offers.
What kind of promotions work and for how long? When you develop programs and record the sales results and questions received, you can improve your next marketing program. (Read more in Chapter 4.) The following sections in this chapter talk about the different methods you can use to deliver your marketing programs.

**Direct-Mail Marketing**

The direct-mail business started with no phone or computer systems, by the simple sending and receiving of information through the post office. Aaron Montgomery Ward sent out his first mail-order catalog in 1872 to rural America. The first catalog consisted of a single sheet of paper, 8 x 12 inches, showing the merchandise for sale with a price list and ordering instructions. Today, even a pizza delivery store uses the same concept, sending their fliers and waiting for customers to read them and call or order online. Technology evolved and now any kind of business can apply the brilliant idea of direct-mail marketing. The process consists of three simple steps: plan the direct-mail content, identify the audience, and get feedback.

**Planning direct mail**

Napoleon King is the emperor of his own pet shop company and decides to send a direct-mail letter to his customers. The most important thing for him is his signature at the bottom of the letter showing him as the company president communicating with his customers.

Newspapers, credit-card companies, and other large corporations have their own Napoleons sending mailings with their names at the bottom, but when you get in touch with the company, you end up talking to an impersonal and automated telephone system. You’re lucky if you get to talk to any human being inside the company, much less a decision maker.

On the other hand, Napoleon’s company is customer oriented. It communicates to the customer exactly how he will be supported, guaranteed! Besides planning the content of the communication, Napoleon’s company develops a customer base segmented by pet, which lets them work their customer base by each pet segment. It also uses the customer’s preferred way of receiving communications, whether by printed mailings, e-mail, or phone. The company collects feedback in the store, at its call center, and from its Internet store, closing the direct-mail cycle at every point.
Planning the content

A new hotel is inaugurated in the neighborhood of an exhibition center.Millions of dollars were invested, but the marketing content didn’t include the key advantage of the hotel — that it is only a few steps from the exhibition center’s main entrance. Similarly, a new pizza delivery opens in a neighborhood that already has five competitors. Its owners distribute their delivery menu without comparing it to their competitors’ menus. They simply forgot to read their competitors’ menus and communicate their advantages to their prospects.

Don’t make these same mistakes. Before creating a direct-mail program, plan your content by asking the following questions:

- **What value does a direct-mail program have for my customer?** Your customer may want to receive information about your product and service, or maybe he ordered once from your company and would view a newsletter as unwanted junk. Because direct mail is relatively cheap, companies often don’t pay attention to their lists, cleaning their database, or refining it according to the customer’s needs.

- **What would my customers like to hear about my product or services?** Refine and study your customer base. Ask customers what they don’t like before you ask them what they do like. This question can help you find the right way to distribute information about your products and services.

- **What would I like to communicate and receive as feedback?** You may want to send a newsletter that has no direct feedback expected from the client. The purpose of this newsletter is to keep your company on the customer’s mind and update customers about your products. On the other hand, you may send a direct-mail response card that you expect to receive back in the mail from a certain percentage of your prospects. Perhaps you want to send an announcement of a special event or sale that occurs on a specific date and increase the traffic at your shop. These are just a few of the possibilities of direct-mail programs.

After you determine the type of communication you want to create, you can plan a direct-mail campaign for better results. Fill in a Word or Publisher template (available at http://office.microsoft.com) and merge it with your Outlook Contacts to broadcast your print or e-mail communication. The systematic explanation appears in the section “Printing direct mail,” later in this chapter.

Selecting the audience

After you design your mailing content (see preceding section), you need to decide to whom you will send the messages — to 200 people or 30,000? A
new hotel may use previous trade show visitor lists as its first mailing list. A pizza delivery business may order lists in its territory to start its business. The following questions help you select and update your mailing list:

- **Who is my mailing target audience?** You can select your customer base or a specified territory or category for specific purposes. Read the section “Merging selected contacts with a letter,” later in this chapter, for more information.

- **Is my customer database up-to-date?** Databases get old quickly because phone numbers and job titles change all the time. When the Journal is on (see Appendix D), Outlook automatically records the created and modified dates for each contact, which you can use to find and eliminate old contacts. BCM Business contacts has four fields on the Details page that automatically record not only the created and modified dates but also the origin of the contact, identified by the user login on the system. Later in this chapter, under “Selecting customers by using filters,” you see how to filter your list to remove old contacts and check later whether they are still correct.

### Selecting the feedback

Aaron Montgomery Ward in 1872 sent his first catalog and explained the procedures for placing an order. Receiving the order was his feedback. Feedback can be necessary to prospect new customers, to develop branding, or to develop future product improvements.

Sending the information is just the starting flag; to win the race, you must have the feedback channels ready. When you receive response cards, phone calls, or Internet responses, all the feedback channels must work properly and every answer must be collected and analyzed. When the phone is busy for five minutes, the customer can move to another supplier. Receiving an e-mail without replying is the same as neglecting the customer. Feedback must work to improve a company’s relationship with its customers.

The kind of feedback you want to receive may include an answering card, an e-mail answer, a form filled in at your site, or a phone call. You have to get your team ready to receive the feedback and work with it, updating the information in your Contacts list or BCM Business Contacts list. The Mailing Form Checklist is the starting point to plan your mailing, as shown in Figure 16-1.

If you take the proper actions and use the checklist, you’ll cut down the possibility of failure and increase your results. Planning the process helps make the mailing easy to pull off, with no failures.
Printing direct mail

The great advantage of printing direct mail with Outlook is the capability to personalize each letter by inserting the name of the person not only in the address line, but also in the content, making each letter look unique to the addressee. Setting up the procedure, you can print hundreds of letters with specific details for each customer.

Besides merging the entire Contacts list, you can send the communication to certain contacts, selected by specific criteria, such as cat owners for a pet shop or job descriptions for an industry offer. The following sections explain merging contacts.

Business Contact Manager users can use the same steps by selecting their Accounts or Business Contacts list.
Merging all contacts with a letter

Merging each name from a customer list is easy with Word and Outlook, together with their mail merge options. For example, say that Golden Pet Shop is moving to a new building, and the owners want to invite their customers to an inauguration party. They have their entire customer base in Outlook Contacts and used categories to classify customers by their pets, with categories such as Dogs and Cats. They send a printed letter to all their customers. To write and merge a letter with Outlook Contacts, they use Word.

When the letter is written and ready, they need to prepare a merge with Outlook Contacts. You can use this procedure to merge your lists with any flyer, pamphlet, or envelope or to send the communication as an e-mail message. Here’s how you can do so:

1. With the form letter open in Word, choose Tools: Letters And Mailing: Mail Merge.
   The Task pane appears on the right side. Step 1 of 6 of the Task pane begins.

2. Select Letters as the Document type.


   The Select Contact list folder appears. Other contacts lists are also available.

5. Select your Contacts list.
   The Choose profile dialog box showing Outlook appears.

6. Click OK.
   The Mail Merge Recipients dialog box opens, showing your entire list with the capability to deselect (remove) any contact from the list (see Figure 16-2).

7. Click OK if you don’t need to edit the list.

8. Choose Next: Write Your Letter.

9. Click in your Word document where you want the addressee’s name and address to appear.
   This location becomes the insertion point of the address block for merging.

10. Choose Address Block in the Task pane.
    The self-explanatory Insert Address Block dialog box appears.

11. Configure the address merging format for your letter and click OK.
    The address block is linked to merge with your letter.
12. Position the insertion point at the greeting line in your Word document and click Greeting Line from the Task pane.

The Greeting Line Wizard appears.

13. Using the wizard options, adjust the greeting as you want, such as Dear Mr. Randall or Dear Mr. and Ms. Randall, and then click OK.

The Greeting line is linked to merge with your list.


At this point, you can use the arrow buttons on the Task pane to change the recipient name for your view and click the Exclude This Recipient button to remove any person in the mailing list.

15. Choose Next: Complete The Merge.

16. Click Print.

The Merge To Printer dialog box opens.

17. Select All and click OK.

The invitation letters start to print and the mail merge is complete.

**Merging selected contacts with a letter**

Selecting 50 or 150 people from a list of 15,000 names is easy when you use the Contacts list or BCM Business contacts. You can narrow down the list by choosing specific job descriptions, such as financial manager, or by choosing customer ratings, such as Platinum customers. You can also send an offer to only the customers in your southeast region. You merge the selected names with a letter the same way (see the earlier section “Printing direct mail”).
You can even use Outlook categories to link customers to a certain item. For example, a pet shop might link owners to their pets. To send a letter only to a specific group, such as cat owners, open your Outlook Contacts list or BCM Business Contacts list and follow these steps:

1. Select By Category from the Navigation Pane view.
   The Contacts list shows your different categories (see Figure 16-3).

2. Select the desired contacts from the category you’re interested in.

   The Mail Merge Recipients dialog box opens (see Figure 16-4).
4. Select Only Selected Contacts from the Contacts list.

5. Select All Contact Fields from the Fields to Merge option.

6. Select New Document if you don’t have a prior document; select Existing Document in the Document file frame if you have a prior document to merge.

   If your document to merge is ready, click the Browse button to locate the desired file. After the document filename is located and inserted, click OK. The documents are merged.

   This procedure links the existing letter with the list containing a certain category. You can save the selected categories as a data file for future use or reference. If you want to make another letter for the same customer list, the database is ready so that you don’t need to open Outlook and go through the selection procedures again.

7. Select Permanent File and type the filename in the text box or use the Browse button to find the file.

8. Select Form Letters in the Document type list box and New Document in the Merge To list box under the Merge options.

9. Click OK.

   Word opens, showing the mailing letter.


   The Word Mail Merge Task pane opens at Step 9 of the “Printing direct mail” section, earlier in this chapter.

11. Follow the Mail Merge Task pane procedures from Step 9 of the “Printing direct mail” section, earlier in this chapter, until the end.

   Your letter is ready to print.

---

**Labeling the mailing**

After the letters are ready, you need to print your address labels. To print the labels for a complete list, open the word processor as you did in the “Printing direct mail” section, earlier in this chapter.

Remember to have the brand and type of label ready, such as Avery 2336 or any other brand. Also check the Preview to see whether the inserted address block appears as desired.

To print your labels:

2. Select Labels for the Document type.
5. Choose Label Options.
6. Select the Label brand and number in the Label Options box and click OK.
7. Choose Next: Select Recipients.
8. Select from Outlook Contacts.
9. Choose Contacts Folder.
   The Select Contact Folder list opens. When using BCM, you can select the Account or Business Contacts list.
10. Select your Contacts list.
    The Mail Merge recipients list box opens, showing your entire list. You can deselect (remove) any person from the list.
11. Click OK.
13. Choose Address Block in the Task pane.
    The Insert Address Block Box Wizard appears.
14. Configure the address merging format for your letter following the wizard; check the format in the Preview window and then click OK.
15. Click Update All Labels.
    At this point, you can use the arrow buttons on the Task pane to change the recipient name for your view and click the Exclude This Recipient button to exclude any person from the mailing list.
17. Choose Next: Complete the Merge.
18. Click Print.
    The Merge To Printer dialog box opens.
19. Select all and click OK.
    The labels begin printing.

You can print selected labels by using these procedures. To create labels from a selected group of contacts, use the same procedure as described earlier in the section “Merging selected contacts with a letter.” Repeat the same procedure up to Step 5 and then begin here with Step 1.
1. Select Mailing Labels from the Document Type list box and New Document in the Merge To list box under the Merge options.

   The selected contact labels are ready to merge.

2. Click OK.

   Word opens automatically with a windows warning to press the Setup button on the Mail Merge Helper.

3. Click OK.

   The Mail Merge Helper appears (see Figure 16-5).

4. Click Setup.

   The Label Options dialog box appears.

5. Select your label brand and model and then click Close.

   You are back to the Mail Merge Helper dialog box. Word document now shows the labels border. At the same time, the Cancel button at the mail helper becomes the Close button.

   Don’t click any other button of the Mail Merge Helper; the preset is ready. The Create button is already configured for your label, the Get Data button is already configured to use your Outlook Contacts, and you don’t need to edit the database.

6. Click the Close button.


   The Mail Merge Task pane opens, and you should see Select Recipients on the first line.

8. Repeat the procedures from the section “Labeling the mailing” Steps 13 through 20 to configure and print the selected labels.

Having your Contacts list organized and updated is the key issue for a good mailing. Outlook does the rest for you.
Selecting customers by using filters

The earlier section, “Merging selected contacts with a letter,” shows you how to select contacts under one condition, such as by category. You can also easily select contacts using more than one condition by using the contacts default fields, such as Job Title and State/Province. For example, say that you want to invite selected people from your mailing by Gender, Job title and State; to a meeting. You can select up to three fields on the same time from your Contacts list.

To select contacts by using more than one condition, follow these steps:

1. With your Contacts list open, select the By Company view from the Navigation Pane.
2. Click Customize Current View from the Navigation Pane.
   The Customize View: By Company box appears.
3. Click the Filter button.
   The Filter dialog box opens.
4. Select the Advanced tab.
   The Advanced filter option appears. Next you can set the region criteria to something like States.
5. Click the Field button and then choose Address Fields: State.
   The State field is selected to add a criteria.
6. Select Contains from the Condition list box.
7. Type the State acronyms in the Value text box.
   You can type more than one value by including a semicolon after each value. For example, you can type NY; NJ; CT to search for three states at the same time.
8. Click the Add To List button to insert your criteria as part of the criteria list.
9. Repeat Steps 5 to 8 to continue adding fields from your Contacts list.
   You’re basically creating a filter with multiple criteria, and there’s no limit to the number of fields you use. Figure 16-6 shows the filter with three criteria: Gender, State, and Job title. You can also add a filter.
10. Click OK.
    The Contacts list displays the list according to the criteria.
After your list appears on-screen, you can select it and then copy and paste it into an Excel workbook to create different kinds of analyses.

If you’re a frequent mailer, you may want to add the Mail Merge toolbar. To use the shortcut, simply choose Tools  Letters And Mailing  Show Mail Merge Toolbar. The Mail Merge toolbar now appears as an extra line in your Word toolbar.

**E-Mailing Marketing**

You can send a personalized letter as a personalized e-mail. To send your mass mailings as e-mails, open the selected document in Word and then follow these steps:

1. **Choose Tools  Letters and Mailing  Mail Merge.**
   The Task Pane Wizard appears on the right side.

2. **Select E-Mail Messages.**

3. **Follow the wizard until you reach Step 6 and then click Electronic Mail under the Merge Frame.**
   The Merge To E-Mail dialog box appears.

4. **Select AutoMergeField from the To list box.**

5. **Type your subject into the Subject line.**
6. Select HTML Among Plain Text Or Attachment from the Mail Format list box.

7. Select All Records and click OK.

The e-mail broadcast starts moving the letters from Word to your Outlook Outbox to be sent until the broadcast is complete.

After sending the e-mail, check the Inbox for refused messages due to errors. Fix and clean your contacts after each broadcast.

Broadcasting e-mails from your own computer is possible on a broadband connection after hours, or you can use a service provider linking your Outlook Contacts to their broadcasting services tools. Using BCM, click the E-mail Marketing or Business Services command on the Business tools drop-down list to evaluate Microsoft as a service provider for broadcasting and controlling your e-mail marketing campaigns. Outlook 2003 users can also look for broadcast and mail services from other e-mail service providers.

Planning Events

Fake, Inc. put on a nice event with an outstanding stand-up comedian and a nice cocktail party, but what was the purpose of the event? The guests didn’t get the message. Another company invested $10,000 on a trade show booth and collected 343 business cards, later forgotten in the sales manager’s desk drawer. The return on investment is zero in both cases. To avoid these results, you have to plan your event to ensure a positive outcome.

Business events can be meetings, seminars, workshops, trade show booths, parties, and shows with small or large audiences. You can manage your events with Outlook even if you have hundreds of guests. Planning any event has four phases:

- Developing the event content checklist.
- Convincing the customers to come.
- Sending the right message to your audience during the event.
- Following up with guests the day after, when the message is still hot.

Thinking about the event’s content

Your event’s content can be a PowerPoint presentation by one person or a complex plan with several speakers. First, you create a table or an Excel document listing all the event details. Then you open a Task and paste the table
or link the Excel file so that you can control the sessions within Outlook. (Read Chapter 11 for information about pasting a table or inserting an Excel file into an Outlook Task.)

The infrastructure can be split into two parts: One part includes the location and resources needed and the other includes the materials for each guest.

Create your Event Planner Worksheet like Figure 16-7 and then copy it and paste into a new Task to control the event.

---

**Guest Material and Printing Worksheet**

- ( ) Charge $___ receipt ( ) Free of charge
- ( ) Badge ( ) Meeting name card 3 fold
- ( ) Answerback cards
- ( ) Guests check list ( ) Prize tickets ( ) Certification
- ( ) Marketing material list attached
- ( ) Gifts
- ( ) Other: ____________________

---

**TIP**

Designate an administrative person to create name badges and to coordinate written material, guest checklists, and gifts. Open a new Task and create a Guest Material and Printing Worksheet, such as the one shown in Figure 16-8. Send the Task to the designated person with your comments.

---

**Event Objectives**

---

**Day After Checklist**

**Actions**

Collect the answer-back cards and fill in each contact.

( ) Send a letter thanking the customer for coming.

( ) Make a personal thanks phone call for coming and record their comments.

( ) Determine who will make the calls if it’s not you ____________

( ) Send the phone call instructions. Attach the instructions

( ) Must be a person-to-person call? Name: ____________

( ) How long do you expect for the phone call results? ___ days.

( ) When is the next follow-up date ___/___/___

Who is in charge of the follow-up? ____________

Who measures the expenses and return of the investigation?
You can print badges and triple-fold name cards, merging the selected contacts as you print your labels.

**Convincing the customers to come**

Walter is a software design engineer and often visits and supports customers. His company’s workshop timetable is planned one year in advance, so while he visits customers, he warms them up as potential workshop attendees. When the company broadcasts its first e-mail invitation, the workshop is full in two days with no problem at all. Mark has the same job function as Walter, but he doesn’t tell his customers about the upcoming workshop. For Mark, every workshop is a fight to fill up with attendees, and the e-mail broadcast doesn’t bring the desired results. He has to work overtime to call and get workshop attendees. This scenario demonstrates that two people do the same work but obtain different results due to their communication.

Motivating the customer to come to an event requires a concerted effort. You can use marketing tools, such as flyers, invitations, e-mail announcements, and phone call reminders, to increase your results. Use Outlook or BCM at this stage to merge the contacts with your printed and electronic communications. The upcoming section on telemarketing explains how to use the Contacts list as an active telemarketing call center.

You can also use your own team to warm up the audience, asking them to remind customers about the event to come.

**Mingling during the event**

Your event must be designed for a pleasant time while your message is passed along to the audience. You can measure how the message sticks for each guest by gathering the comments heard by your team. Training your team to socialize while mingling with your guests gives you instant feedback at your event.

**Following up the next day**

Use feedback cards and follow-up phone calls after the event; an event is part of a process, and it doesn’t end when the event is over. Events aren’t stand-alone programs. Each event is an investment to get future results. Reactive or otherwise difficult prospects who became receptive at the event should get a “thanks for coming” and a phone call to solidify these new relationships. The Day After checklist (Figure 16-9) helps you schedule the next steps after the event.
Use Contacts or BCM Business contacts to send the “thanks for coming” letter and then update each attendee’s record in your Contact profile. Use the Contacts list as a telemarketing tool for the day-after-event calls. (For more on telemarketing, see the next section.)

**Ensuring Telemarketing Success**

Outlook can work as a telemarketing workstation, even doing the dialing for you. Creating the telemarketing view allows multiple phone calls in a sequence and is an effective way to invite guests to your event or to make the event follow-up call. Outlook is ready to make the calls for you. Open your Contacts list, select the contact you want to call, and click the Telephone button on the toolbar. Select the phone number, and the call procedures starts.

Your computer modem must be connected to a phone line in order to dial for you. See Chapter 3 for details.

If you need to make one call after another, certain Contacts List views, such as the Phone List or By Category, are better than others. When you need to fill in new data, you must create new fields and place those fields in the Contacts List view in a practical sequence (see the next section).
Telemarketing forms

The Telemarketing forms use the same design concepts in Chapter 4 but now applied to phone calls. Say that a company launches a new product with workshops and demos for beauty parlors and now wants to call the customers who didn’t order the product to evaluate the results. The company decides to add the following fields to the Contacts lists to have an effective telemarketing operation:

Using Outlook Contacts you can customize the view and add fields for your sales campaign. The following fields are typical for telemarketing activities.

- **Call date:** Add the call completion date.
- **Quiz date:** List the customer’s scheduled date to answer the questions.
- **Follow-up flag:** Use this field to remind yourself about the next phone call as scheduled by the customer.
- **Like:** Indicate whether the customer liked the product.
- **Buy:** Add the customer’s intention to buy the product or not.
- **When:** Type the expected date to place the first order.

The previous fields are useful for building your telemarketing application, not for communicating with your customers. Using straight questions like the ones in the preceding list can sometimes be offensive to a customer. Instead, build more delicate questions to gather the information in the form.

Chapter 4 includes details for adding fields and customizing the Contacts entry form.

Creating a view title

When a view is ready to work, you can rename the view for future use in one click. To create the Telemarketing view, follow these steps:

1. **With Outlook open on your Customized Contacts list for telemarketing, choose View ➪ Arrange By ➪ Current View ➪ Define Views.**
   
   The Custom View Organizer dialog box appears.

2. **Click the Copy button.**
   
   The Copy View dialog box appears.

3. **Type** Telemarketing **in the Name Of New View text box.**

4. **Select This Folder, Visible To Everyone and click OK.**
   
   The Telemarketing view appears in the Navigation Pane, as shown in Figure 16-10.
Adding a script to your telemarketing operation

Sometimes you need a script so that everyone is using the same text with carefully planned questions that match your company profile. Such a script explains the campaign objective and procedures to your operators. You simply have to send the script written in a Word document to each operator. To have the script running in front of Outlook, follow these steps.

With the Contacts list for telemarketing open:

1. Click the Navigation Pane in the Menu View.
   The Navigation Pane disappears.
2. Choose View ▸ Reading Pane ▸ Bottom.
   The Contacts list appears in the top half of the screen.
3. Open your Word processor in a separate window, write your script, and save the file.
4. Minimize and adjust the Word window size to fit over the Outlook reading pane.

Outlook Telemarketing, complete with a script, is ready to work. Don’t forget to use the Keyboard Alt + Tab commands to move between the Word document and the Outlook screen.

Telemarketing reports

You can create reports to analyze guest confirmations or to determine how many calls resulted in sales. Simply customize the Contacts List view by adding any question fields and measuring the outcome by using reports. Copy and paste your custom Contacts list into an Excel workbook for creating charts and statistical analyses. Select your Outlook list from your current view and copy and paste the list into an Excel worksheet to make your analyses.
Part V

The Part of Tens

The 5th Wave

By Rich Tennant

“Okay—antidote, antidote, what would antidote be under? You know, I still haven’t got my folder structure organized the way I want it.”
The day has only 24 hours. What do you want to do today, in the next 30 days, or the next year? Planning ahead helps you make the best of your 24 daily hours. In this part, I give you ten tips that put time on your side with Outlook’s help.

I also give you ten marketing and selling tips, as well as tips on basic security for your company data.
An old quote says, “If time didn’t exist, everything could happen at the same time.” People today are working in high-anxiety environments, where everything must occur at the same time. Take a breath, list, and plan your actions. A little planning can give you perspective about what is truly important.

Goals and tasks are imposed in three ways: from within, by your supervisor, or by the system in which you work. When goals are self-imposed, you’re the master and control your time. With supervisor- or customer-imposed goals, you have to negotiate a time slot with another person. System-imposed goals mean you have to obey the system instead of making it work for you. You can use Outlook to better manage your time and increase your productivity.

Self-Imposed Time Commitments

Listing your time commitments in the Calendar, your tasks in the Tasks list, and then filing the information in the correct folders can make your workload seem much more manageable.
Starting your day

Start your day by opening Outlook and reading your Calendar schedule and your Tasks list. Take a breath, evaluate what you want to accomplish in the morning and in the evening, select your priorities, and start doing them one by one. Do you need to wait for someone to finish a task? After a task request is sent and negotiated, jump right into the next job. Take a break between each job. Remember that time commitments are more than writing your schedule into an agenda or into the Outlook Calendar. When you need to make a change, you can plan your next steps so that you don’t miss today’s goals. To read the Outlook Today page:

1. **With Outlook open, click the Mail button in the Navigation Pane.**
   
   The Inbox list appears.

2. **Select Personal Folders under All Mail Folders in the Navigation Pane.**
   
   The Outlook Today page appears, showing your time and tasks commitments beside the Mail Folders list.

Focusing on the current activity

When you have someone to remind you of your daily activities, you can give all your attention to the current activity because you know someone will remind you of your next appointment or task. When you don’t have someone to remind you and because you aren’t a robot, you need something to remind you about your priorities. You can list all your tasks in the Outlook’s Tasks list. Turn on the reminders so that you can focus your brain on the current activity without interruptions. Then, write your to-do list, selecting the priorities and attacking them one by one without mercy.

Recording your goals as tasks with reminders

Dreams can become reality when you start writing them down and planning to achieve them. Where do you want to spend your next vacation? When do you plan to retire? Do you plan to raise a family? Write your personal and professional goals for this year and for the next five or ten years, creating a task for each one. Set up the reminder for the next six months. When the reminder pops up, you simply open the task and read it, update the task according to what you’ve accomplished, and then set the reminder for the next date until you achieve your goal.
Taking a break

When you work for hours in front of a computer screen, your eyes become tired, and so do you — especially when you're passionate about your work and forget what's going on around you. Taking short breaks energizes you for another round. Before starting a long and involved job, open a new appointment in your Calendar and set the reminder for 50 minutes from now. When the reminder bell sounds, take a break, stretch, and change your line of sight from your computer screen to a farther view from your office window (or at least the end of your room). You can produce more if you give yourself a few short breaks to reenergize.

Avoiding high anxiety (or “I don’t work in the emergency room” syndrome)

The workload and environment at certain places can look like an emergency room. Discerning what is important from what is urgent helps you list and complete each job by its importance level. Before you feel like you're working in an emergency room, use the task priorities and classify their importance levels. A little planning and prioritizing may even prevent you from needing bypass surgery.

Boss-Imposed Time Commitments

When two people want different tasks completed at the same time, they have to negotiate an agreement. Supervising, delegating, and sharing pertinent information help to make first things first.

Shrinking supervision time

Supervising a team with different, ongoing activities can be difficult, and you may spend a huge amount of time and energy making phone calls and requesting updates. Instead, assign a task to each person by choosing File ➪ New ➪ Task Request. Doing so gives each person a specific job. You can then select your Tasks List view to view the records by assignment, which lists all pending issues by the assignee.
**Delegating**

Delegating to members of your team so that they can act on your behalf saves you time and increases each person’s responsibility. When you use Outlook with Exchange server, you can access the delegating tool. It allows your assistant to send meeting invitations and reply to received invitations on your behalf. Outlook sends an automatic copy to your Inbox.

**Sharing your Tasks list and your Calendar**

When you receive many requests from coworkers, you may need to organize these requests better. You can make everyone list their requests in the Tasks list and then set the priority and due date for each task, thus creating a priority sequence. Share the Tasks list with your coworkers and then decide which tasks to do first. To share your Tasks list:

With your Tasks list open:

1. **Select the Tasks folder from the Navigation Pane.**
2. **Right-click the Tasks folder.**
   
   A drop-down list appears.
3. **Choose Sharing from the drop-down list.**
   
   The Tasks properties open on the Permission tab. To allow coworkers to share your Tasks folder, you must add their names to the Permission List and choose the Permission Level.
4. **Click the Add button to open your lists.**
   
   The Add Users dialog box opens.
5. **Open the Show Names From The list box to see all lists available.**
   
   You can select individuals one by one or a group list.
6. **Click the name you want to select.**
7. **Click the Add button and click OK.**
   
   The chosen persons are added to the Permission List.
8. **Select the Permission Level from the list box, such as Reader or Editor.**
9. **Click the Apply And Close button.**
   
   The Sharing permission setup is ready.
To open a shared folder, open Outlook:

1. Choose File » Open » Other User’s Folder.
   The Open Other User’s dialog box opens.
2. Type the name of the person whose folder you want to share.
3. Select the folder name, such as Tasks, from the list box.
4. Click OK.
   The shared folder appears.

**Time Commitments Imposed by the System**

You can avoid a lot of interruptions by simply controlling the way you’re online. Voice mail and e-mail are supposed to help you control the way you receive information. Repetitive tasks turn into time wasters, usually because information isn’t easily available. Organizing and filing the information can help you request service maintenance faster.

**Turn off the interruption killer**

When you don’t want to be disturbed, you turn on the DND (Do Not Disturb) option on your telephone device, close your office door, or put a sign on your door, right? When your Inbox notifies you about the arrival of each incoming message, you’re interrupted by the sound, and the warning appears on-screen. To solve this problem, you have to switch off the Notify Me When New Messages Arrive option. Because you control the e-mail and not the other way around, switch off the notification alarm.

With Outlook open:

1. Choose Tools » Options.
   The Options dialog box appears.
2. Click the E-mail Options button and then click the Advanced E-Mail Options button.
   The Advanced E-Mail dialog box appears.
3. Uncheck the following commands: Play A Sound, Show An Envelope Icon In The Notification Area, and Display New Mail Desktop Alert.

4. Click OK.

No buzzer alert will break your attention when incoming e-mail arrives.

**Streamline technical support**

Every time you need support for an electronic device like a printer, computer, or cell phone, you call the customer support line for a chat. The first questions are usually the same: What is your product? What is the model number? What is the serial number? When did you purchase it? Did you purchase the warranty? Many times, you have to disconnect, collect the appropriate information, and then call back. To solve such a problem, create a contact for each hardware device or software program you have and store the important information in the contact’s record. If you have several computers from the same manufacturer or multiple software licenses, you can create an Excel file with this data and attach it to your contact.

With the Contacts list open:

1. **Click the New button.**
   The new contact appears.

2. **Type Customer Service into the Name field.**

3. **Type the name of the product in the Job Title text box, such as printer or computer.**

4. **Enter the device’s customer service number and the company’s e-mail, IM, and site address in the appropriate fields.**
   To include the device’s name, model, serial number, and purchase or guarantee date, you can create new fields or use the existing fields.

5. **Click the All Fields tab.**

6. **Select Miscellaneous Fields list from the Select From list box.**
   The Miscellaneous fields appear.

7. **Type the following data in the appropriate fields.**
   Type *Product Name* in the User Field 1, *Model Name* in the User Field 2, *Serial Number* in the User Field 3, and *Purchase Or Guarantee Date* in the User Field 4.
   During a maintenance call, you can add additional information.
8. Type the Account number in the Account field.
9. Type the Account ID in the Customer ID field (see Figure 17-1).

10. Click the Save And Close button in the toolbar.

With 20 or 30 items, you can create a new Contact folder just for software and devices. You can name the new contact folder something like Support. Create a new contact for each new item upon its arrival or installation date. Spending a few minutes now can save you a lot of time in the future.

Figure 17-1: The Miscellaneous fields help you record and track device information for maintenance and service needs.
Chapter 18

Ten Sales and Marketing Tips

In This Chapter
- Discovering selling tips
- Getting the scoop on marketing tips

Getting the order is the final step of any sale. Whether you’re beginning with a prospect, getting to know your product or service, or arriving at the final sales procedure, you need to follow through with many steps to transform a prospect into a customer. Using Outlook to remind you about the next step helps you track and better serve each customer. Managing and maintaining your sales effort, along with a strong team and a good marketing program, are the ingredients of a good business. The following ten questions can help you brainstorm about your business.

- Who are your customers?
- Do they know your product or service?
- How does your product or service solve their problems or needs?
- Who are your competitors?
- Does your company deliver something better that your competitor?
- Do you record your customer information?
- Do you keep track of your customer requests?
- Do you keep track of your lost orders and indicate why you lost them?
- Do you keep track of your sales team actions? How often?
- Do you coach your team members to motivate them and improve their results?

In this chapter, I give you ten sales and marketing tips. Keep in mind that a sale involves understanding your customer needs and filling those needs with your products or services. Paying attention, following up correctly, and supporting your clients are the keys to maintaining good relationships. In addition, Outlook is a helpful tool when you know how to use its features for marketing activities.
Understand Your Customer’s Vision First

In the beginning of my career, I was a sales manager of consumer products. I dealt with highly professional procurement managers from national chains to very small storeowners to exporters from different countries. I found that each company has its own way of doing business. So does each person. By understanding the focus and procedures of each business, I was able to grow my sales territory as never before. Most salespeople, when talking with customers, try to explain how good their products are, before they really understand what the customer is looking for. If you understand your customer’s vision first, you can better explain your service or product in terms of how it fills their needs. You can present the same product in different ways to match each customer’s point of view. Working as a sales professional, you can record the customer’s information in Outlook Contacts so that you remember the kind of presentation that works best for each customer.

Track Opportunities with Tasks

One of the major problems in sales involves losing track of a potential sales order. Often, salespeople forget about a quotation because other customers are demanding their attention, so they end up forgetting or giving away a potential order. In Outlook, you can record all pending requests — from prospect information to quotations to closing the orders — in Tasks. Keeping the reminder on is a key way to following up at the appropriate time. For more details on reminders and tasks, see Chapters 14 and 15 and Appendix B.

Keep Tabs on Your Customers

The market moves faster than ever before. Our brains can’t keep track of so many changes and updates to customer information. You can, in a sense, download your brain by recording all the information about your contacts as profiles or by using the Account or Business Contacts in the Business Contact Manager. Before calling a customer, you can open his company home page each week and record the news into the contact record. You can easily record the information in the following way:

1. With Outlook open to your contact record, search the customer site with Internet Explorer.
2. Select and copy the information found in the customer site.

The information may be the quarter results, a new product launching, a new director, a new trend, or any unknown information.
3. Move to the open contact in Outlook.
4. Choose Actions➪New Journal Entry For Contact.

   The Journal appears.
5. Paste the information into the Journal.
6. Select Note from the Entry Type list box.
7. Paste an information title for easy retrieval into the Subject field.
8. Click the Save And Close button.

   You have now saved the information into your customer contact with a
time stamp without having to type any detail.

**Draw Up a Letter Of Understanding**

Sales professionals often have to consider a customer’s counteroffer or business proposition, so it’s important to know and remember exactly what the customer is offering. A *letter of understanding* becomes especially important; it confirms the terms of a proposed deal from a phone conversation or meeting. You can keep a letter of understanding template in your files and fill it in when needed. For familiar customers, you can write up the phone call information in a Journal entry and send it as a phone conversation reminder attached to an e-mail. (Read Appendix D for the details.) You can then insert a follow-up flag to remind yourself that the customer got the e-mail with the phone conversation reminder attached.

**Measure Your Sales Team’s Performance**

Unfortunately, many companies measure team performance only by gross sales and/or gross profit. But you may wonder why one salesperson’s results are better than another’s. Some possible reasons include the customer base potential, the number of customer visits made during the month, the value-add that the customer perceives, the business knowledge of the salesperson, and personal motivation. Sometimes a new hire can, in just a few months, bring in some surprising results from a customer base of leftovers. Self-motivation is the answer. Measuring your sales team’s activities and meetings by reading their shared Calendars, Tasks, and customer profiles can provide you with information to coach them and drive them to their goals. Evaluate with each salesperson the time invested in a potential customer and the
results. Coach them with your experience, by evaluating the opportunities and the identifying action items needed to focus the energy on the main opportunities. Don’t wait for the weekly meeting.

**Increase Marketing Productivity**

Outlook comes with your Windows operating system and can help control your sales and marketing activities for each customer. Using Outlook, you can broadcast personalized e-mails or letters to thousands of recipients within just a few minutes. You can customize the Contacts list for telemarketing activities, including dialup automation. The system works well and gives the best results only when your company is organized. The database must be correct, the marketing plan well developed, and the content of each letter or message carefully written. A handy software product isn’t enough without capable, motivated, and well-trained people. In the end, a motivated team brings the best result. Invest in your team’s training. Read more detail in Chapter 16.

**Increase Orders by Working with Target Markets**

When you aren’t working with mass-market products, you have to build a customer base with companies and personal contacts and compile information about each one in your Contacts list or BCM Business Contacts. The additional data helps you create strategies for different segments. With the right data, a pizza delivery restaurant, for example, can determine that it sells more veggie pizzas than anything else and create new veggie flavors for its customers. A dermatologist can offer skin treatments according to the age of the customer base. An industrial company can classify its customers according to their sales potential. A software company can research and develop new products for a vertical market in which it has more customers. Having an organized and accurate database helps you generate better marketing campaigns. Sometimes a simple newsletter to an inactive customer inspires them to reorder. Keeping your customer base updated and developing campaigns to communicate your service is easy with Outlook. Follow these steps to filter your customer base for a particular profile:

1. **With your Contacts list open, choose Customize Current View from the Navigation Pane.**

   The Customize View dialog box appears.
2. **Click the Filter button.**
   The Filter dialog box appears.

3. **Click the Advanced tab.**
   The Advanced Filter dialog box appears.

4. **Click the Field button.**
   All fields, including the ones you created for your business, are available.

5. **Select a field and a condition and then type or select a value for the selected field.**
   Some examples follow:
   
   - Filter for single or widowed customers by using the Spouse field and selecting Is Empty as the Condition.
   
   - Filter customers by age by using the Birthday field with the Condition On Or Before. In the Value field, enter a date such as 12/31/1950. You can also select the monthly birthday to send a birthday e-mail by using the This Month Condition.
   
   - Filter women only by using the Gender field. Select the Condition Equals and the Value Female.
   
   Using the three filters together, you can select women, single or widowed, born before 1950, as shown in Figure 18-1. You can refine your search even further by using the State field and selecting all customers living in the same state.

6. **Click OK.**
   The Contacts list displays your database filtered and ready for your action.

![Figure 18-1: You can filter your customer base for marketing purposes.](image)
Build a Checklist from the Customer Perspective

Marketing doesn’t just involve one department in a company. The marketing programs integrate several departments, including products, channels, and customer service. You get the best results from the customer’s perspective if you check all the details before you launch the program. The following expected actions by customers checklist helps you verify that the sales program is properly set up in all related departments.

✔ Grabbing additional information at the product Web site. Is the site ready, and did you measure its usability? Usability refers to how easily the reader can find and understand the information at your site. For example, certain colors and font styles aren’t friendly to older people.

✔ Calling an 800 number. Is the staff trained and ready to handle the customers’ questions? By using Outlook as a telemarketing tool, you can receive phone calls, record the information, and give good support, even if it’s only you doing all three tasks.

✔ Sending a message with a question about the product. Who’ll receive the messages and answer it? Create a special mail address for your advertising responses. Use Outlook’s rules to route messages or colors to prioritize them.

✔ Ordering the product in a store. Do the stores have enough inventory to support potential sales? Before you start the campaigns, the sales channels must have the sales inventory ready.

List the entire program systematically to create your checklist. Upfront planning is better than having to fix the program while it’s running and losing money. Even if you’re running a two-person business, simplify and use this checklist with your partner’s help. Create procedures to measure results. Measure the daily visits to your site, the numbers of messages received, and the numbers of calls received. Evaluate the program by the reported incoming problems, even if your results are positive.

Maximize Events and Presentations

For the past 15 years, I’ve been working with marketing presentations and workshops in the semiconductor and IT industries. The definition of a good
event can be merely the number of people in the audience, or it can be the
number of VIP customers present, or the number of smiling faces at the end
of the event. When you’re investing your money, you have to tighten up the
whole process, including getting the right audience to the event, feeling the
temperature while the event is running, and performing the day-after actions
to achieve your goals. Salespeople too often forget to follow up the day after.
Answerback or evaluation cards often don’t bring the desired information. By
working with small audiences, such as 40 or 50 people, you can use Outlook
to schedule phone calls during the week after the show. You can use a flag for
each contact or create a category to list all participants from the workshop
and select them for a telemarketing action.

Be sure to ask your workshop attendees whether the event met their expecta-
tions and what else you can do for them to increase their satisfaction. When
someone important misses the event, follow up with a phone call and send
the information anyway.

**Balance Mail and E-Mail Campaigns**

By broadcasting a free newsletter for self-enrolled readers and then measur-
ing the cause of returned messages at each broadcast, you’ll notice that
many returns are because the addressee’s mailbox is full. Other readers just
look at the headline and delete the message. Broadcasting to 10,000 readers
doesn’t mean that you have that many people reading your message.

Be sure to choose e-mail broadcast frequency and headlines so that you
make readers eager to get the information. In the past, I published a weekly
newsletter with timesaving and productivity tips; if I didn’t publish one week,
I used to receive letters from 3 percent of my readers asking for their tips.
Before broadcasting, think of yourself as your average customer and ask
yourself, “How often would I read the newsletter?” Broadcast your newsletter
with your own answer to the prior question.

Direct-mail campaigns, although more expensive with printing and postage
costs, have a strong value in delivering printed information into the readers’
hands with no need for a computer. You can use Outlook to broadcast or
print your mailers. Measure the return of both options (printed mail and
e-mail) against their cost to evaluate the right balance for your company.
When broadcasting by using Outlook instead of a third-party provider, mea-
sure the returned mail in the following way. (Remember to create an e-mail
address used only for the broadcast, such as
news@yourcompanydomain.com.)
Before the broadcast:

1. Create a new folder named `newsmmdd` where `mm` is the month and `dd` is the broadcast date.

   For example, `news0717` stands for July 17.

2. Create a rule for moving the returning messages from the broadcast address to a specified folder.

   See Chapter 8 to find out how to create a rule.

Open the specified folder and screen the returned messages two days after the broadcast. Check for wrong mail addresses and delete them from your database or fix them. Check for returned mail due to mailboxes being full and evaluate the percentage over the total sent to determine whether it’s worth sending a printed letter. Always evaluate the results and the cost of the procedures. Unrequested e-mail broadcasts are cheap, but your potential customer may avoid your company after receiving such unwanted messages.
These days, business road warriors work just about anywhere and any time. You need to have your computer information available and safe at any moment, without having to call and interrupt someone for a phone number, address, or business report. In this chapter, I give you tips that help you stay online while on the road and offer some advice to help you use and protect your information on mobile devices.

In addition, safeguarding means protecting your company information from being stolen or used by unauthorized people. Besides using the technical tips in this book, having knowledge of the potential hazards helps your team safeguard company information.

Receive Reminders via Your Cell Phone

One of Outlook’s most helpful features is its reminder. Unfortunately, you receive a reminder only when you’re working on your computer with Outlook. However, you can forward your reminders to your cell phone by sending a short message SMS. You simply insert an add-in software product to Outlook that sends every reminder as an e-mail to your cell phone mail address. Outlook then sends a short message to your cell phone when a reminder pops up in Outlook (your PC or server still must be on).
I use Outlook Reminders by E-mail from the RS Outlook site (see www.rsoutlook.com), but you can also try Sperry software at www.sperrysoftware.com. Use Outlook reminders if you’re often out of the office. If you didn’t request the SMS service from your phone company, check out how you can release the service for your cell phone.

**Synchronize Your Reminders Anywhere**

Today, even the cheapest cell phones also have calendars, tasks, and reminders, but using the cell phone keyboard to set up your calendar isn’t a fun and easy activity. However, you can use Outlook’s add-in software to synchronize your cell phone with your tasks and calendar. In addition, many phone manufacturers offer software for uploading your cell phone data from a computer, but if your cell phone company doesn’t offer such software, you can order the Phone Tools software from www.avanquest.com. You can synchronize by using a cable or infrared connection, depending on your device. You can synchronize the next 30 days of activities or just copy the appointments and tasks needed for the day.

**Protect Your Data**

Losing your device or having it stolen is a financial setback, leaving you open to the possibility of having an unknown person read your information. That’s a serious lack of security. Creating passwords to access your hardware is the first step. You should password-protect your notebook, Pocket PC, and even your cell phone.

To protect your Outlook folder, create a password. With Outlook open and the All Folders list displayed, choose Personal Folders ➔ Properties in the Navigation Pane. In the Personal Folders Properties dialog box, click the Advanced button and then click Change Password. Because you don’t have an old password, just type the new password, retype it in the Verify Password text box, and click OK. Now you have a password protecting your data.

The Outlook data file protection helps maintain privacy when other users use the same computer, but it doesn’t protect against hackers. This password was designed for privacy among several users, using the same computer only. This method isn’t as secure as using password-protected Windows user accounts. Keep a copy of your password in a safe place so that you don’t lose your data if you forget the password.
Protect Your Cell Phone Contacts

Today, cell phones can carry up to 2,000 names, but finding one out of 2,000 names in a cell phone takes more time than you may have. You can synchronize and shrink your Outlook Contacts list to work with your cell phone by creating a contact folder named Mobile and copying and pasting the contacts you want into this folder. Then install an add-in software program (such as Avanquest) to synchronize your cell phone agenda with Outlook.

If you don’t have a program to synchronize your cell phone agenda, I suggest using Mobile Phone Tools from Avanquest (www.avanquest.com). You can copy your contacts to a cell phone, edit your cell phone numbers on the computer instead of using the phone, and synchronize the phone contacts with the Contacts list. From the Mobile Phone Tools screen, you choose which contacts you want to move — all of them or just a few.

Before leaving the office, I make it a habit to copy the contacts I need for the day and any emergency phone numbers, too. I can delete them all later if I no longer need them on the phone.

Use Training as a Protection Tool

When the “I Love You” virus stopped thousands of companies, I heard a coworker who was informed about the virus say, “I had to open the message. Only my husband sends me I love you messages.” Even with all the firewalls and software protection tools available today, education is still the only way to avoid cases like this one. Training increases the awareness of each member of your team, so that they aren’t fooled by fake and inoffensive-looking messages.

The John Wayne rule is one important way to protect your company: “Delete First and Ask Questions Later.” When you don’t know the sender, the subject of the message is of little consequence. If there is a link to click, delete the message before you click away your computer’s security. When something is important to the senders, they’ll call you or send you a letter. Don’t trust any emotional mail about prizes, debts, jokes, love, sex, and other catchy topics. I recently won a prize from my Internet provider, but instead of clicking the link in their message, I opened their Web site and checked the published contest instructions, confirming the e-mail.
Avoid Mail Before Writing It

People tend to take the easy way out, which is rarely the most intelligent way. Most people find out how to use e-mail through tips or just by sniffing around on their own. Today, most people manage the messages only by chronological arrival, without evaluating the content. A joke or a $1,000,000 order is treated the same way from an e-mail processing standpoint.

Prioritizing the types of messages sent and received (as this book does in Chapters 8 and 9) helps people think before writing messages. When you identify and expose behaviors like unnecessary self-promotion or laziness, people will start thinking about their messages before sending them. Create e-mail rules in your company, including a manual, training sessions, and a campaign with sponsors from the IT and HR departments.

Increase Your Password Security

Do you know how many passwords you have? You generally have passwords for your e-mail address, your voice mailbox, your credit cards, your ATM card, security system keyboards at your house or office, not to mention all your logins to Internet sites. Easy-to-crack passwords include names, dates, or words in lowercase letters. Increase the security of your passwords by using uppercase and lowercase letters, mixed with numbers, such as L7o3KK4aB. Instead of having the passwords on your mind, create an Excel workbook for your passwords with password protection so you will need to remember only one password.

To create password protection for your Excel workbook, open your Password Excel workbook, which has previously been created and saved. Then choose Tools: Options to open the Options dialog box. Click the Security tab to open the security page, type the password in the Password To Open text box, and click OK. A Confirm Password dialog box opens for you to enter the password again. Retype the password, click OK, and then save and close the password file. From now on, the password file demands a password.

You can also search on the Internet for Keepass, a free open-source password manager, instead of using an Excel file.

Recover a Permanently Deleted Item

Instead of cursing your computer when you delete a message by mistake, you can recover the message for up to three days if you’re working with Outlook connected through the Exchange server. Here’s how:
In Outlook, open the deleted items folder:

1. **Choose Tools** → **Recover Deleted Items**.
   The files available for recovery appear.

2. **Select the deleted message you want to recover and click Recover**.
   The message is transferred to the Outlook mailbox.

---

**Create a Message with Restricted Reading Permission**

I recently received a message from a person with whom I have a good professional relationship. The message said that I had to sign on to the Microsoft IRM service by using my .NET Passport in order to receive messages from him. Because I didn’t know the meaning of the IRM acronym, I felt I was receiving a kind of Mission Impossible, top-secret message.

Well, IRM is a type of protection that keeps messages from being read, forwarded, or printed unless the sender allows it. The IRM acronym doesn’t mean Impossible Reading Message, but rather Information Rights Management. Sending a message with this service protects your message from being forwarded or printed and keeps the message’s content restricted according to the sender’s wishes. The service is available only to Microsoft Office Professional Edition users. Here’s how to send a restricted message.

Before creating a restricted message, you have to download and install the Windows Rights Management (RM) Client and sign up for the MSN .NET Passport to create your password to access the service’s server.

To install the Windows RM client and get a .Net Passport, follow these steps:

1. **With a new e-mail open in Outlook, choose File → Permission → Do Not Forward**.
   When trying the IRM the first time, a warning window prompts you to install the Windows Rights Management client.

2. **Click Yes to install the Windows Rights Management client**.
   Follow the setup instructions until the end of the installation.

3. **Going back to your message, choose File → Permission → Do Not Forward**.
   If you already have your .NET passport, Windows prompts to confirm whether you’ll use your current ID. If you don’t have a .NET passport installed, the Service Sign Up wizard appears.
4. Select Yes, I Want To Sign Up For This Free Trial Service From Microsoft and click Next.

The Windows RM Account Certification Wizard opens with two options.

5. Choose No, I Do Not Have A .NET Passport And I Want To Register To A .Net Passport Now or Yes, I Do Have A .NET Passport if you already have one.

6. Click Next and follow the wizard.

The wizard takes you to the Microsoft site to create your credentials or download your current one.

After you follow the steps from Microsoft’s site, your .NET Passport credential is ready, and Windows Rights Management is installed in your computer.

After you complete the setup, follow these steps:

1. **With a new e-mail, open choose File ➪ Permission ➪ Do Not Forward.**

   The Select User dialog box appears.

2. **Select the user from the list and click OK.**

   A headline on top of the message appears.

Although the Windows Rights Management and .NET Passport require some setup work the first time, they provide valuable protection that you can use on any new message.

The addressee who is using Outlook 2003 and receiving the IRM message also needs to set up Windows Rights Management in order to read the message.

To create a restricted-reading message, you need Office Professional 2003. Reading an Outlook message with a program other than Outlook is possible by downloading the Windows Restricted Permission viewer.

If you aren’t running Microsoft Office 2003 or an e-mail application that supports messages with restricted permission, you can view this message by downloading the Rights Management add-in for Internet Explorer from http://r.office.microsoft.com/r/rlidRestrictedPermission Viewer?clid=1033. You can then read the message as an Internet Explorer page.

You can also restrict documents created in Word, PowerPoint, and Excel in the same way.
Protect the Addressee’s Mail Address

Once, when I was participating in an e-learning class, the teacher sent her presentation in a regular e-mail to 100 participants. As an enrolled participant, I received her message and more than 60 unnecessary Replied To All messages, based on the teacher’s message. Participants used Reply To All instead of using the bulletin board, as instructed.

Broadcasting messages to a dozen people by using the CC: or To: line can be a lazy and even dangerous thing to do. First, you’re giving out others’ e-mail addresses without consent and thus multiplying their exposure to risks. Second, this type of message can generate a mass of junk mail when people start answering by clicking the Reply to All button.

To avoid these problems, use the BCC line for all the recipients’ addresses and put your own address into the To line, which sends the message to yourself. Your own address is the only one the recipients see.
“Oh wait – this says ‘Lunch Ed from Marketing’, not ‘Lunch’, ‘Lunch’.”
In this part . . .

These basic Outlook appendixes explain the step-by-step procedures for using the Calendar, Tasks, Contacts, Journal, and E-mail for those who aren’t familiar with Outlook.
Appendix A

Calendar Basics

In This Appendix

- Using the Appointment form
- Supervising your team’s appointments
- Customizing and viewing the Calendar

The word *calendar* comes from the Latin word *calendas*, which means the first date of the Roman month, and the day Romans paid their accounts. This definition may explain why, to this day, the first of the month is often when bills are due. Outlook Calendar is useful not only for organizing your time commitments and automatically reminding you about those commitments, but also for inviting people to a meeting or event.

Creating an Appointment Entry

An Outlook Appointment is the basic form you use to set up anything in the Calendar, including personal time commitments, meetings, events, and activities to which you invite other people. Outlook’s definition of an event is an activity that lasts all day.

Although one Outlook event lasts all day, it doesn’t block the day during the event. You still can use it for other purposes.

Exploring the Appointment form allows you not only to understand all the resources for making appointments, events, or meetings, but also figure out how to classify each appointment and list according to your priorities and how to use the reminders to organize your time.

Follow these steps to set up an Appointment.

1. **With your Calendar open, click the New button.**
   The Appointment appears.

2. **Set up the Start Time and End Time (see Figure A-1).**
The start time typically indicates the beginning of the appointment, not the time to start going to the appointment. Calculate the time you need to get to the appointment and then set up the Reminder in Step 11 to help you arrive on time. You can even change the Reminder sound to a horn or heavy rock if you tend to get too involved in your work. Another option is to add the travel time to the actual appointment and adjust the start and end times accordingly. This technique is useful if your assistant is likely to book another appointment in the Calendar during the time you need to be traveling. If you don’t build this time into the appointment, you or your assistant may forget and schedule something in that time slot.

You can double-click in the Calendar One Day view to see the appointment, with its start time, as selected in the Calendar.

3. Type the subject of the appointment in the Subject text box.

4. Type the appointment’s location, such as your office or the customer site, in the Location text box.

5. Select your label from the Label list box to color-code your appointments.

The Label list box enables you to pick ten colors in order to color-code your appointments. The following Calendar views support these color...
codes: One Day, Week, Work Week, and Month. When you have three appointments colored in red, for example, you have three important appointments on that particular day. You can associate each color with these definitions: None, Important, Business, Personal, Vacation, Must Attend, Travel Required, Needs Preparation, Birthday, Anniversary, and Phone Call. The Label option colors only the appointments.

6. Click the Contacts button to open the Contacts list. You can link any contact record to this appointment or meeting.

7. Click the Categories button to open the Category list, and then select and classify the appointment in any category.

8. Check the All Day Event check box to turn the appointment into an all-day event; the Start Time and End Time drop-down boxes disappear when you use this option.

   The Show Time as list box displays four options: Busy, Tentative, Free, and Out Of Office. This feature is especially helpful when you work with groups, because it shows your free/busy times on your Scheduling page when you're connected through the Exchange server. In addition to affecting the Free/Busy scheduling, the Show Time as options also show up in the Calendar, each with a different colored bar next to the appropriate time slot. This view provides a quick, visual take on your day’s appointments.

9. Select the Show Time as list box according the options explained previously.

   The above selection in the Appointment will display the same color bar in the calendar and Scheduling pages.

10. Set the Reminder to a time just before your appointment.

11. Click the Reminder sound button if you want to play a different sound when your reminder pops up.

   The Reminder Sound selection box appears.

12. Click the Browse button, select a sound, and click OK.

   Your pure dynamite sound is ready to catch your attention.

13. Click OK and then the Save And Close button in the Appointment.

   The Appointment is saved in your calendar.

---

**Setting Up a Recurring Appointment**

You can use the recurring appointment feature to establish meetings or time commitments that repeat weekly, monthly, or even annually or to set up a recurring appointment.
To do so, open your first appointment and follow these steps:

1. **Click the Recurrence button.**
   The Appointment Recurrence dialog box appears (see Figure A-2).
2. **Set up the desired recurrence pattern, such as daily or weekly.**
3. **Click OK.**

![Figure A-2: Select a recurrence pattern for an appointment or meeting.](image)

---

**Collaborating on Time Commitments**

In addition to the Appointment form, which you can use to control your own time commitments, the following Calendar tools can help you schedule your time with other people.

### Free/Busy scheduling

Free/Busy scheduling displays each attendee’s time slots as Busy, Tentative, Free, or Out Of Office. You select one of these options in the Show Time As list box in every saved appointment. Follow these steps to see the Free/Busy grid:

With the Appointment open in Outlook:

1. **Click the Scheduling tab.**
   The Free/Busy scheduling grid appears. You can compare your schedule with your colleagues’ free and busy times when you’re online and on the same Exchange site.
2. **Type the e-mail address in the All Attendees column.**

The Free/Busy time slots appear in the attendee’s e-mail address line. Now you can check the first free time available to all attendees (see Figure A-3).

3. **Click the Autopick Next button.**

The bars in the scheduling calendar move to show the first free time available to all attendees. Outlook adjusts your meeting’s start and end times based on this particular time frame. After selecting a free time slot, you can e-mail all the attendees an invitation.

---

**Figure A-3:** Checking your sales team’s free/busy times.

---

**Meeting invitations**

From Outlook’s point of view, a meeting is just the same time commitment for more than one person. You can use Free/Busy scheduling to check your colleagues’ free time or simply invite them to a meeting on a tentative basis.

With your Appointment open:

1. **Click the Invite Attendee button to transform the Appointment into an Invitation.**

   The To line is added to the Appointment, enabling you to send the invitation as an e-mail.

2. **Type the e-mail address into the To line to invite the addressee.**

3. **Click the Scheduling button to check the attendee’s Free/Busy time.**
4. **Click the Send button to send the invitation.**

   The invitation is sent.

## Meeting commitment

The meeting invitation is a timesaving tool that helps eliminate the need to locate people by phone. The addressee sends an answer by clicking the Accept, Decline, Tentative, or Propose New Time buttons (see Figure A-4), creating a commitment by automatically inserting the invitation into his or her Calendar.

---

**Figure A-4:**
Addressees click the Accept, Decline, Tentative, or Propose New Time buttons to insert the invitation into their Calendars.

---

## Sharing Calendars

You can share your Calendar so that your supervisor or assistant can see it (as long as everyone is using the Exchange server). First, you must give the person permission to access your Calendar.

With your Calendar view open:

1. **Choose Share My Calendar in the Navigation pane.**
   
   The Permissions In Calendar Properties dialog box appears.

2. **Click the Add button to open the Add Users dialog box.**
3. Select the person who you want to access your Calendar and click OK. The Permissions page reappears.

4. Select the Permission level for the selected people.
   Permission levels include Reader, which means people can only read the Calendar, and Editor, which means they can read and edit your Calendar.

5. Click OK to enable the sharing.

To open a shared Calendar:

1. Select Open A Shared Calendar in the Navigation Pane.
   The Open A Shared Calendar dialog box appears.

2. Type the name of the person whose Calendar you’re sharing.
   The Calendar appears in Outlook.

**Viewing the Calendar**

The most frequently used Calendar view is the Day/Week/Month view, which displays your Calendar like a daily, weekly, or monthly planner. You have the option to move from one view to another by clicking the appropriate button in the toolbar. Other views are useful for seeing only certain events, such as active appointments, annual events, recurring appointments, and categories. Use the Calendar View options to see information quickly by just changing the view.

The Calendar’s amazing features remind you about meetings and appointments, allow you to check your free and busy times, make creating invitations faster, and all in less time. Use these features, and you just may find you have more spare time.
Appendix B

Tasks Basics

In This Appendix
- Understanding tasks
- Assigning tasks
- Viewing the Tasks list

The Tasks list is your to-do list, and it helps you meet your obligations on or before a certain deadline. The time span in which you complete the job is your choice. Your list can be as simple as Grandma’s household chores, stuck to the refrigerator door, or as complicated as an international business executive’s schedule. Outlook’s Tasks list offers more than a paper list. You can determine the deadline of a job, assign its priority, and estimate the time you need to do it. These features help you plan and attack each task according to your own priorities. This appendix explores the available fields within the Tasks list to see how you may be able to use them.

Creating a New Task

The Tasks list’s many informational fields let you measure the status of each job and classify them in ways that are important to you. Familiarizing yourself with the default form helps you use the fields according to your own needs, not only for your own sake but also to prioritize tasks for your team.

To create a new task, follow these steps:

1. Click the Task button (or press Ctrl+4) to display the Tasks list.
2. Click the New button (or press Ctrl+Shift +K) to display a new task, as shown in Figure B-1.
3. **Complete the following fields:**

- The **Subject line** is where you type the job title or desired job action.
- The **Due date field** is where you indicate when you intend to finish the job.
- The **Start date field** is where you enter the date on which the job was written or accepted.
- The **Status drop-down list** is where you classify how the task is moving. You can pick from the following options: Not Started, Deferred, Waiting On Someone Else, In Progress, and Completed. The Status field is useful for analyzing all your tasks in one list. Perhaps you need to see how many tasks are waiting on someone else, for example.

- The **Priority drop-down list** offers three options: Normal, High, and Low. You can use this field to view your tasks by priority. The Tasks list view shows an ! sign for tasks with high priorities, a ↓ sign for tasks with low priorities, and no sign for tasks with normal priorities.
• The Reminder check box selection turns on a pop-up screen reminder and a sound on the date and time selected in the Reminder Date and Time box. By clicking the Reminder sound button, you can select a new sound file to play in the Reminder sound box.

• The Owner field displays the owner of the task. Does it belong to you, or did you send it to someone?

• The Contacts button allows you to link a contact to a task by clicking and selecting the contact from your Contacts list.

• The Categories button helps you classify and view the Tasks list by categories, such as internal or customer’s requests.

• The Private check box lets you keep the task private (not shared) when folders are shared on an Exchange server.

4. **If you want to repeat the same task on a certain period of time, click the Recurrence button.**

5. **Click the Save And Close button.**

   The task is saved in your Tasks list.

If you have a long Tasks list, you can select the Views command in the Navigation pane Current View window to help you decide how to attack your own priorities. See the next section, “Viewing the Tasks List,” for more information about the Tasks List view.

### Viewing the Tasks List

You can view the Tasks list in the Task pane in ten ways; each way has different advantages, depending on your needs, priorities, and work periods.

To view your Tasks list:

1. **With Outlook open on the Tasks list, select one of the views by choosing View in the Navigation Pane Current View.**

   The Simple List looks like Grandma’s list stuck to the refrigerator, with the subject and due date. The Detailed List displays the Subject, Status, Due Date, Percentage Complete, and Categories fields, as shown in Figure B-2. The Overdue Tasks option is helpful for managing delayed tasks and for evaluating what to do about them.
2. Explore the other views, including Active Tasks, Next Seven Days, Assignment, By Person Responsible, By Category, Completed Tasks, and Tasks Timeline.

Moving from one view to another can help you determine which task you need to finish at each moment. Read more in Chapter 2.

You can move from one Tasks List view to another at any time, to view your information in the most effective way possible for your work.

<table>
<thead>
<tr>
<th>Subject</th>
<th>Status</th>
<th>Due Date</th>
<th>% Complete</th>
<th>Categories</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year 2008 Goal One: Double the Company...</td>
<td>In Progress</td>
<td>Fri 12/31/2010</td>
<td>0%</td>
<td>Key Customer</td>
</tr>
<tr>
<td>Customer request #121</td>
<td>In Progress</td>
<td>Tue 7/16/2007</td>
<td>0%</td>
<td>Key Customer</td>
</tr>
<tr>
<td>Weekly report request for approval</td>
<td>Completed</td>
<td>Fri 6/16/2007</td>
<td>100%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Payment for lunch</td>
<td>Waiting</td>
<td>Fri 6/1/2007</td>
<td>25%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Weekly report</td>
<td>In Progress</td>
<td>Fri 5/19/2007</td>
<td>0%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Deliver the proposal to Gold Customer</td>
<td>In Progress</td>
<td>Tue 5/1/2007</td>
<td>0%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Best Company follow up Requested Proposal</td>
<td>Not Started</td>
<td>Mon 6/25/2006</td>
<td>0%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Proposal request</td>
<td>In Progress</td>
<td>Thu 10/12/2006</td>
<td>25%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Print and place on a plastic cover Proposal...</td>
<td>Not Started</td>
<td>Thu 9/18/2006</td>
<td>0%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Project file</td>
<td>Not Started</td>
<td>Mon 8/22/2005</td>
<td>0%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Sales report</td>
<td>Not Started</td>
<td>Wed 8/23/2006</td>
<td>0%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Import procedures confirmation</td>
<td>Not Started</td>
<td>Fri 8/18/2006</td>
<td>0%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Three years loan term ends</td>
<td>Not Started</td>
<td>Fri 8/18/2006</td>
<td>0%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Car insurance</td>
<td>Not Started</td>
<td>Sun 7/23/2006</td>
<td>0%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Dream Product Team Alignment</td>
<td>In Progress</td>
<td>Thu 7/25/2006</td>
<td>25%</td>
<td>Strategic</td>
</tr>
<tr>
<td>Platinum: Open Phone Inc. Touch base review</td>
<td>Completed</td>
<td>Sat 6/5/2006</td>
<td>100%</td>
<td>Platinum</td>
</tr>
<tr>
<td>Leadtime for Product ABC in a special package...</td>
<td>Waiting</td>
<td>Fri 2/18/2006</td>
<td>0%</td>
<td>Gods/Objects</td>
</tr>
<tr>
<td>Develop new training presentation</td>
<td>Not Started</td>
<td>Fri 1/16/2005</td>
<td>0%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Donald's Kim dessert opportunity</td>
<td>In Progress</td>
<td>Thu 12/1/2005</td>
<td>0%</td>
<td>Proposal</td>
</tr>
<tr>
<td>Lloyd's dinner</td>
<td>Not Started</td>
<td>Mon 10/2/2005</td>
<td>0%</td>
<td>Proposal</td>
</tr>
</tbody>
</table>

Requesting and Supervising Tasks

Sometimes asking someone to complete a task, or even sending them an e-mail about it, isn’t enough to ensure that the person will do the job. The great thing about Outlook’s Tasks list is that assignees have to click the button to accept responsibility for it, and then clicking the Accept button copies the task into the assignee’s Tasks list. You then immediately receive a confirmation, which makes it much harder for an assignee to forget about his commitments.

Requesting and confirming tasks

Besides sending coworkers task requests, you can also send task requests to your suppliers or customers (if they use Outlook’s tasks). Since Outlook 2002,
any Outlook user can accept tasks and invitations with no problems at all. The following steps show you how to request a task.

1. **With your task open, click the Assign Tasks button.**
   

2. **On the To line, type the address of the recipient of the task. This person will receive the task as an e-mail.**
   
   Two new options are available to link the requester (task creator) to the assignee (task recipient), enabling you to supervise the task without phone calls or personal meetings. Steps 3 and 4 show these two options.

3. **Select the check box Keep An Updated Copy Of This Task On My Tasks List to receive an e-mail notice each time the assignee updates the task.**

4. **Select the check box Send Me A Status Report When This Task Is Complete to receive an e-mail update when the task is complete.**

5. **Click Send to send the task request to the assignee.**

In order to receive updates about assigned tasks, you have to assign the task to only one person at a time. In order to receive an update from more than one person, you have to open and assign the task to each individual separately. For example, in a sales environment, you may want to request a weekly report from each salesperson individually, rather than one from the whole group. This technique makes each salesperson responsible for his or her own status report.

**Accepting or declining tasks**

Outlook sends task requests as e-mails. The assignee receives and opens the e-mails. The task has two buttons:

- ✅ The Accept button sends the assignee’s response and updates the requestor’s Tasks list.

- ✅ The Decline button declines the task. Assignees typically edit the response to explain why they can’t accept the task and perhaps propose a new agreement.

When the assignee clicks one of the buttons, he or she can also type a comment with the response before Outlook sends it.
Supervising a task

When you request and supervise a task the old-fashioned way, you give the task to the assigned person and record in your planner a reminder to check in with the person on a certain date. Then you often call the assignee to see how the work is going. This approach is time consuming for both people and requires many unnecessary interruptions. Outlook’s supervising options update the information for you when you selected the check box *Keep an updated copy of this task on my tasks list* before assigning and sending the task (see the previous section). Every time the assignee opens her task and updates it, Outlook automatically sends an e-mail to the task requester and updates the requester’s Tasks list, thus saving you many potential phone calls. When the assignee completes the task, the requester’s Tasks list is also updated and appears as complete.

Task supervision only works when the assignee updates the tasks in his own Tasks list, of course.

Sharing your tasks

You can also share tasks and allow your team to view your Tasks list when Outlook is connected through an Exchange server. Your supervisor can view your current list without interrupting you, and your assistant can remind you to change a task priority when necessary.

Giving permission to someone to share your Tasks list and the procedure to open a third-party list are the same as for the Calendar. See Appendix A for more information.
Appendix C

Contact Basics

In This Appendix

- Understanding the Contact record
- Using the Actions menu

The Contact is the most versatile item within Outlook due to its quantity of ready-made fields available for recording data. The Contact record includes fields for professional data, such as names and contact information for coworkers, and for personal information like anniversaries, personal contacts, people’s hobbies, and spouse’s and children’s names. Exploring a contact in this Appendix shows you some of the fields available for recording this information.

Exploring a Contact

The Contact fields appear in the General page, as well as the Details page of each record. The All Fields tab shows you 20 groups of fields. To explore these fields, start with the main page.

1. In Outlook, click the Contacts button in the Navigation Pane (or press Ctrl+3) to display the Contacts list.

2. Click New (or press Ctrl+Shift+C) to display a new contact (see Figure C-1).

3. Click the Full Name button.

   The Check Full Name dialog box appears with the Title, First, Middle, Last, and Suffix fields available for all parts of the name. You can also choose the Show This Again When Name Is Incomplete Or Unclear option in order to have this dialog box pop up whenever you type a name into the Full Name field that doesn’t have all the parts. Correct the name in the appropriate fields.

4. Click OK to return to the Contact window.

5. Type the job title, such as Manager or Salesperson, in the Job Title field.
6. Type the company name in the Company field.

7. Select the way to file your contact in the File As list box.

   You can file by the name, company, or both. The idea is to file the contact by the field that you’re most likely to use when you’re searching for the contact. If you’re more likely to remember the company name, file the contact by company. If you’ll remember the person’s name, file by that.

   The Phone Numbers area has four buttons and four fields: Business, Business Fax, Home, and Mobile. You can also change the button name and the phone number by using a list of 19 options.

8. Click the arrow button next to the Business button.

   A list of 19 phone number titles appears, including telex and radio. You can even save the contact’s boat radio number in the Radio field or the telex number of a ship. Select one of the options and numbers to be displayed on the contact’s screen.

9. Type the phone number in the desired phone number fields.

   The Check Phone Number dialog box appears when the number isn’t properly typed within the following fields: Country/Region, City/Area Code, Local Number. If this dialog box appears, fix the field and click OK.
10. Click the arrow button next to the Business button below the Addresses frame.

Three address fields are available: Business, Home, and Other. Select the one you need to fill in, such as Business.

11. Type the Address in the text box and click OK.

The Check Address dialog box appears when the address is incomplete, showing the following fields: Street, City, State/Province, ZIP/Postal Code, and Country/Region.

12. Check the This Is The Mailing Address box if the current address is the mailing address.

This option tells the Actions menu to use the selected address for mailing purposes, such as when creating letters or labels.

13. Click the picture icon to open the Add Contact Picture dialog box.

The Contact Picture dialog box displays the Folders list, where you select the picture to be inserted. Adding a picture helps you remember a customer’s face, which can be especially helpful when it has been a long time since you’ve seen the person.

14. Double-click the picture to insert it into the contact frame.

The picture is copied into the contact frame.

15. Type the e-mail address or select it from the address book by clicking the Address Book icon on the right side of the E-Mail field.

Three e-mail addresses are available to use.

16. Click the arrow beside the E-Mail field to select an address or to add more than one e-mail address.

The Display As field shows by default the name of the person and the associated e-mail addresses. You can edit them if needed.

17. Type the person’s Web address in the Web Page Address field.

18. Type an Instant Message address in the IM Address field.

19. Click the Contacts button in the lower-left corner to link a relative or another person by choosing the contact in the Select Contacts dialog box and clicking OK.

Read more about Contacts in Chapter 4.

20. Click the Categories button in the lower-right corner, select one of them to classify your contact, and click OK.

You can find out more about classifying your contact in Chapter 4.

You can use the data you’ve entered in the Contacts fields for performing automatic dialing or sending invitations (see Chapters 3 and 16).
Exploring the Details page

The Details page in the Contact record has additional fields where you can record professional and family information. Open the Details page to see the available fields.

With your contact open:

1. Click the Details tab.
   
   The Details page appears (see Figure C-2).

2. Type the professional information into the appropriate fields.
   
   The available professional fields are Department, Office, Profession, Manager’s Name, and Assistant’s Name. These fields are useful for keeping in contact with the whole team.

3. Type the personal information into the appropriate fields.
   
   The Nickname, Title, and Suffix fields are the same ones the Full Name field uses in the General tab. You can make note of any titles or special additions, such as when a person is a Ph.D. or if you’re talking with the Jr. or Sr. The Spouse’s Name field is also useful for remembering social obligations.

4. Select the contact’s birthday and anniversary in the Birthday and Anniversary drop-down lists.
   
   When you use the Birthday and Anniversary fields, Outlook inserts a reminder into the Calendar.

5. Set the Online Net Meeting settings.
   
   These settings are used in corporations for instant messaging, conferences, and remote desktop maintenance.

Exploring the Activities page

The Activities page records every action related to a contact and creates a history file. You can record the details manually or automatically by using the Journal and its link commands. You can link all Outlook activities, including meetings, appointments, sent and received messages, and Office documents. Read Appendix D and Chapter 14 for detailed information.
Automating Actions

You can automate several actions by using the contact data, which eliminates the need to retype or dial a phone. You can use the Actions drop-down menu list or the four shortcuts available in the toolbar.

- Follow Up reminds you to follow up with a contact.
- Display Map of Address shows an Internet map of the contact’s address.
- New Message to Contact opens a new e-mail addressed to your contact.
- AutoDialer calls the contact’s phone number.

Flagging for follow-up

The flag for follow-up dialog box reminds you to take an action related to the contact, including calling, sending an e-mail, sending a letter, and arranging a meeting.
With your contact open:

1. **Click the Follow Up button.**
   
   The Flag for Follow Up dialog box appears. You can select the date and time of the reminder and have Outlook remind you about one of the following actions: Follow Up, Arrange Meeting, Send E-Mail, Call, and Send Letter.

2. **Select Follow Up from the Flag list box.**

3. **Select the Date and Time in the Date box.**

4. **Click OK to return to the Contact screen.**
   
   The Follow Up reminder page pops up as scheduled.

5. **Click the Clear button in the Follow Up reminder page after you’ve completed the task.**

---

### Displaying maps

The Display Map of Address option simply displays an area map of your contact. Outlook uses the MSN Map site to create this map, so be sure that you’re connected to the Internet when you use this option.

Simply click the Display Map of Address button. Internet Explorer opens and displays the MSN page with a map to your contact’s address.

### Sending e-mails

The shortcut for sending e-mails presents you with a new e-mail form containing the customer’s e-mail address in the To line, which saves you a bit of time on each new e-mail you send.

### Autodialing phone calls

How much time do you waste reading a contact’s phone number, pressing the buttons on the phone, and waiting for a voice to say hello? A few seconds if you’re young and fast and minutes when you’re older and slower. Release yourself from this unworthy job by using the autodialing feature. Read more in Chapter 3.
More automation actions

Almost 20 options are available from the Actions menu, including New Contact From The Same Company, New Distribution List, New Letter To Contact, New Meeting Request, New Task For Contact, New Journal Entry For Contact, Link, Call Contact, and Forward As vCard.

Many users aren’t aware of the following commands, so the detailed explanations can help you understand the advantage of using them for your own work.

- **New Contact From The Same Company** saves time by creating additional contacts that have the same address. Just fill in the contact’s name, job title, and phone and e-mail information, and the rest is done.

- **New Distribution List** opens the Distribution list box, where you can create a group of contacts. You can name it Sales Team and include all the sales team members in the group, for example. You can then send messages and perform other actions on preestablished groups of contacts, instead of sending e-mails to each contact individually.

- **New Letter To Contact** opens the Letter Wizard and inserts the contact information into a Word letter.

- The **New Journal Entry** and **Link** commands link information related to your contact in the Activities tab. Appendix D explains this process.

- **Forward As vCard** creates an e-mail with an attachment called vCard that contains the contact information. Receiving an e-mail with a vCard allows anyone with Outlook to click and open the contact to read it or drag and drop the vCard into his or her Contacts list so that you can add the new contact without having to type any data. You can create and forward any vCard from your Contacts list.

Using a vCard as your message signature

You can create a Contact record with your personal contact information and use it as your mail signature. First, you have to create your own contact record to send as a vCard, because it’s unlikely you have your own information saved as a contact in your own list. After saving the new record, you can use the following procedure to add it as your e-mail signature:

1. **With Outlook open, choose Tools ➪ Options.**

   The Options dialog box appears.
2. Click the Mail Format tab.
   The Mail Format page appears.

3. Click the Signatures button.
   The Create Signature dialog box appears.

4. Click the New button.
   The Create New Signature dialog box appears.

5. Type your name as the signature name in the Enter A Signature Name text box.
   You can have more than one signature; each one must have a unique identification name. You can create a professional and a personal signature.

6. Choose Start With A Blank Signature and click Next.
   The Edit Signature dialog box appears (see Figure C-3).

7. Click the New vCard From Contact button.
   The Select Contact As vCards export list appears.

8. Select your own vCard.

9. Click OK to return to the Mail Format option box.

10. Select the signature you want to use for new messages in the list box.

11. Select the signature you want to use for replies and forwards in the list box.

12. Click Apply and then OK.
    Every e-mail you create or forward now includes your vCard as a signature.
Printing for your planner

You can print your Contacts for your planner or black book. Just open the Contacts list to the Address Card or Detail Address Cards views.


   Five formats are available: Cards Style, Small Booklet, Medium Booklet, Memo Style, and Phone Directory Style.

2. Select Small Booklet.

   The Page Setup Small Booklet box appears.

3. Click the Paper tab.

   The Paper page appears.

4. Select your desired type of paper, such as Avery, Filofax, or Daytimer, or any other from the Paper tab (see figure).

5. Select the page size in the Size list box.

6. Click the Print button and follow the wizard's steps.

   The Contacts list is printed in your planner's format.
Appendix D

Journal Basics

In This Appendix
- Linking an Item or a Journal
- Automating the Journal
- Using the Journal information

In the dictionary, journal is defined as “a personal record of occurrences, experiences, and reflections kept on a regular basis; a diary.” The meaning of journal in an accounting or bookkeeping context is “a book listing all transactions and indicating the accounts to which they belong with a time stamp.” In keeping with these ideas, the Outlook Journal is a kind of diary in which you record your personal work history and retrieve it in an organized way.

In this appendix, you find out how to manually link an Outlook item to a contact and how to display all linked items. You also discover how to explore the Journal entry form for your professional use.

Introducing the Journal

To understand the Outlook Journal, you need to understand some other terms as well. An Item, for example, is any Outlook occurrence, such as an e-mail, appointment, meeting, task, or contact. Linking an Item is recording the item in the Activities list found in any contact record. The Journal entry form is where you record non-Outlook items, such as phone call comments or files from other programs. The Journal also records (or maintains links to) all your Office document activities, recording a time stamp when you open and when you save each file and listing them in Journal view.

The Journal lists all your contact information in an organized way in the Activities page and displays all your Microsoft Office activities in the Journal.
view. You can record any occurrence manually or use the Journal’s automation to do the work for you.

The most common Journal activity is inserting a time stamp on Outlook Items and Microsoft Office files. You can use this feature to list each of your contact’s activities on the Activities page, thus creating a contact history. You can also list the time you spend working with each Microsoft Office file.

Outlook records Journal entries based on when the action occurs. For example, a Word document is linked to the timeline on the date it’s created or modified. You can set the Journal view to By Type on the timeline to see entries listed by activities such as e-mail messages, meetings, and phone calls. These views allow you to quickly locate information, such as a proposal sent last month or an e-mail sent two weeks ago.

Creating a Contact History

The Activities page for each contact contains the contact history with all related activities, each appearing with a time stamp. The “activities” shown in the list are Outlook items, such as e-mails, tasks, appointments, meetings, and related occurrences for the contact recorded into the Journal entry form. A Journal form records the information you type, links to other items in Outlook, and links to documents created in Microsoft Office programs.

Linking items to a contact manually

Do you remember the details of your last phone call with your best customer? When was your last meeting before the phone call? When did you send the last proposal? All this sort of information is spread out in different folders on your computer. Wouldn’t it be easier if you had an index listing all your activities with each customer when opening the contact record? The Activities page of each contact serves just this purpose — to index and provide links to all customer information.

With any contact record open, click the Activities tab. The Activities page appears. All your linked items, files, and Journal entries are listed on this page.

The purpose of linking items to a contact is so that you can list them in the Activities page. To list an activity in the Activities page, you have to create a
link between the activity and the contact. Linking any Outlook item to a contact’s Activities page is as easy as the following steps:

1. **With your contact open, choose Actions ➪ Link ➪ Items.**
   The Link Items To Contact dialog box appears.

2. **Double-click an item, such as a task, e-mail, or calendar.**
   The item is linked to the selected contact.

**Retrieving the linked information**

Finding the recorded information for each contact is now very simple and easy. With the Contact open, click the Activities tab. The Activities page opens with all items displayed in the Show drop-down box (see Figure D-1). Understanding the concept of linking and retrieving items is the first step toward using the Journal and Outlook in general.

![Figure D-1: Reading the All Items Activities list reveals your customers’ histories.](image)

**Linking Items Automatically**

Outlook can automatically link all items related to each contact in the Activities page, thus eliminating the need to record each item manually. The next steps show you how to set up Outlook automation to automatically link items related to a contact:
1. With Outlook open, choose Tools➪Options➪Journal Options.

The Journal Options dialog box appears (see Figure D-2). You can decide which items Outlook will automatically record in the Journal, including meeting requests, e-mail, and tasks.

2. Select any item to be recorded in the Automatically Record These Items check boxes.

You can also select each contact to link and automatically list their items in their own Activities list.

3. Select each desired contact in the For These Contacts check boxes.

The selected contacts now maintain links in their Activities pages, as specified by your settings.

4. Select the Opens The Item Referred To By The Journal Entry radio button in the Double-Clicking A Journal Entry frame.

This option lets you open a Word document without having to open the Journal form that links to it.

5. Click OK.

The Journal now creates a history in the Activities page for each chosen contact and links all the related items to the page.

Using Journal automation with Microsoft Office files creates a log for each file indicating when it was opened and when it was saved and closed. These logs can help you measure the time you spend on certain files, such as when working on a proposal or an Excel cost sheet.
Add Microsoft Office documents to your Journal entries only if you have a real need for this type of automation, because it slows down your system. It can take Outlook up to a minute to create these Journal links while it saves the file upon exiting. To avoid this delay, you can create manual entries.

To link Microsoft Office files to a Journal:

1. Choose Tools ➪ Options ➪ Journal Options to display the Journal Options dialog box.
2. Select the Office programs you want to create logs for in the Also Record Files From check boxes.
3. Click OK.

The Journal now logs the use of Microsoft Office programs.

Retrieving Journals

You can retrieve your Journals in two ways: by reading the Journal list in the Activities page of each contact or by searching using the Journal views. I recommend using the Activities page in the customer’s history because it’s a personalized list for each contact. The Journal views provide an excellent way to retrieve any document by type and are better as generic lists that let you see all phone calls, for example, no matter who the contact is.

Viewing the Journal list by contact

The Activities list displays the items linked to a contact including the Journal. You can find any file or item linked to a specific contact by using these steps:

1. With the contact record open, click the Activities tab.
   The Activities page is shown with all linked items listed, including the Journal items. To list only the Journal items, proceed to Step 2.
2. Select Journal from the Show drop-down list.
   The Journal list related to this contact now appears.

Using the Journal views

The Journal views list all activities and occurrences by type and time stamp. The six views let you list and retrieve any record easily.
To change the Journal view, open Outlook and click the Journal button in the Navigation Pane. The Journal list is displayed by type in the timeline; this view shows each type of recorded item and its files. You can double-click any of these items to open them.

You can arrange the timeline view by day, week, or month by using the toolbar buttons. The Day view is an excellent way to search for a file when you remember more or less when you worked on it. Just visit the appropriate date and look for the file among the Journal entries at that time.

If the Journal button doesn’t appear in the Navigation Pane, click the arrow icon (the Configure buttons) in the lower-right corner of the Navigation Pane. From the drop-down list that appears, choose the Add Or Remove Buttons command and then choose the Journal button. Outlook adds the Journal button to the Navigation Pane.
Appendix E

Shifting from Outlook Express to Outlook 2003

In This Appendix
- Moving from Outlook Express to Outlook 2003
- Copying Outlook Express data from another PC

Outlook Express is a free basic e-mail program that doesn’t allow you to manage your appointment and tasks. Outlook Express users often install the Office 2003 package without using the wizard to move all their Outlook Express content, thus arriving in Outlook 2003 automatically and painlessly. This appendix covers the basic steps for upgrading to Outlook 2003 while keeping your data intact.

Moving from Outlook Express to Outlook 2003

If you’ve been working with Outlook Express as your mail program for some time and finally decided to move to Outlook 2003 so that you can benefit from the Calendar, Tasks, and other features, you may be wondering how you can transfer your Outlook Express data to Outlook 2003 without losing any information. The Outlook 2003 Import and Export Wizard enables you to move all your Outlook Express data, including the mail account, all mailboxes, the address book, and rules into Outlook 2003, in a few easy steps.
Importing Internet Mail account settings

Outlook 2003 Importing wizard detects the Outlook Express data installed on the same PC. To migrate from Outlook Express to Outlook 2003, you first need to import your Internet Mail account settings:

1. In Outlook 2003, choose File ➪ Import and Export.

   The Import and Export Wizard appears.

2. Select Import Internet Mail Account Settings from the list box.

3. Click Next and follow the wizard until the end.

   The Internet settings are installed in your Outlook 2003.

Before importing your older mail to Outlook 2003, clean out all undesired mail from all your mail folders so that you can start a new application without junk mail.

Importing mail folders and other data

If you’ve been running Outlook Express for some time, you probably created mail folders, an address book, and maybe even some mail rules. Don’t worry. You can import all your data with the Import And Export Wizard. Follow these steps to import your mailboxes, address book, and mail rules:

1. In Outlook 2003, choose File ➪ Import And Export.

2. Click Outlook.

   The Import And Export Wizard appears.

3. Select Import Internet Mail And Addresses from the list box and click Next.

   The Outlook Import tool moves to the next page (see Figure E-1).

4. Select the Internet mail application you want to import from.

   In this case, choose Outlook Express.

5. Check the Import Mail check box to import all your e-mails.

6. Check the Import Address Book check box to import your address book.

7. Check the Import Rules check box if you want to import your older Outlook Express rules and click Next.

   The Import Addresses page appears. If you’re already using the Outlook contacts folder, you may have some duplicate addresses after you import from an external source.
8. Select one of three options: Replace your duplicates with items you import, allow the duplicates to be created, or don't import any duplicate items.

9. Click Finish.

At the end of the import procedure, you're running Outlook 2003 with all your previous Outlook Express data.

Changing your default mail system

Even though you've imported your Internet account settings and your date, your computer's Internet Explorer settings still selects Outlook Express to create a new message. To change the default mail system from Outlook Express to Outlook 2003, follow these steps:

1. In Internet Explorer, choose Tools ➤ Internet Options.
   The Internet Options dialog box appears.
2. Click the Programs tab (see Figure E-2).
3. Select Microsoft Outlook from the E-Mail list box.
4. Select Microsoft Outlook from the Newsgroups list box.
5. Click Apply and then OK.
   Your Internet settings are now linked to Outlook 2003.
Copying Outlook Express
Data from Another PC

If you’re running Outlook Express on a different PC, you have to export the
Internet accounts, mailboxes, address books, and rules data files to your cur-
rent PC and enable Outlook 2003 to import them. Here are the basic steps:

1. Locate and copy the Outlook Express files to a portable media such as
   a CD-ROM, floppy disk, or memory drive.
2. Copy the files to your current PC.
3. Use Outlook Express on your current PC to read the copied data and
   then enable Outlook 2003 to import the data.
4. Import the files by using the method described in the section “Moving
   from Outlook Express to Outlook 2003,” earlier in this chapter.
Index

A

AC power, Europe, 192
Accept button, 145, 152–153, 183, 297
Account Financial Information area,
Account form, 86
Account form
Account History frame, 231–232
as alternative to Outlook Contacts, 83
Categories button, 86
content, 83
details tab, 86–87
duplicate information with Business
Contact form, 85
entering information, 85–87
New button, 85, 86
Opportunity form linkages, 82
Account History frame, Account form,
231–232
Account History Items, 235
Account History list, 86
Account list, 85, 231
accounts
neglected, 101
overdue, 100, 102, 107–109
Accounts by Category report, 101
Accounts by Rating report, 100–101
Accounts by Status report, 100, 107–109
Accounts History report, 102
Accounts List with Business Contacts
report, 102
Accounts Neglected report, 101
ACT!, 117
Actions drop-down menu, Contacts
AutoDialer, 303, 304
Display Map of Address, 303, 304
Follow Up, 303, 304
Forward As vCard, 305
Link command, 305
New Contact From Same Company, 305
New Distribution List, 305
New Journal Entry, 305
New Letter To Contact, 305
New Message to Contact, 303
Active Appointments command, 27
Active Sync, Microsoft, 83
Activities page, Contacts, 35, 212, 230, 302,
310–313
Add A Fax command, 36
Add Address Or Domain dialog box, 137
Add Contact Picture dialog box, 301
Add Holidays button, 202
Add Item dialog box, 233
Add List dialog box, 157
Add New Item, 148
Add Or Edit dialog box, Product And
Service Items List, 93
Add The Items in This File To The Existing
List option, 94
Add To List button, 248
Add Users dialog box, 262, 290–291
Address Block option, 242, 246
Address Book button, 37
Address Cards view, Contacts, 58
Advanced E-Mail Options button, 263
Advanced E-Mail Options dialog box,
263–264
Advanced filter option, 248, 249, 271
agenda, 187
Agenda Wizard, 187
agreement
management, 144, 151–154
player rules, 152–154
alarm, reminder, 9, 11
aligning columns, 77
All Attendees list, 180
All Contact fields option, 56–57
All Day Event check box, 287
All Folders, 276
All Items option, 230
All Mail Folders list, 15, 260
All Tasks Fields option, 58
antiphishing.org (Web site), 141
anti-spam filters, 122
Apply Color button, 217
appointment
categories, 177
Free/Busy scheduling, 172, 288–289
linking to prospect account, 231
meeting invitations, 289–290
recurring, 21, 287–288
setting up, 285–287
in shared calendars, 172
viewing active, 27
Appointment command, Account History
list, 86
Appointment form
All Day Event check box, 287
Categories button, 177, 287
Contacts button, 199, 287
creating an appointment entry, 285–287
date time, 285–286
Label list box, 286–287
Location text box, 286
Reminder, 287
Scheduling tab, 172, 288–290
start time, 285–286
Subject text box, 286
Appointment Recurrence dialog box, 288
Archive Folder, 139
archiving
e-mail, 30, 136, 138–140
Outlook data file, 39
Are There Any Exceptions? dialog box, 129
Arrange By Categories option, 220
Arrange Meeting (flag option), 208
Assign Task button, 28, 154, 228, 297
Attach Original Message option, 131
audience
knowing, 237–238
selecting, 239–240
Author (permission level), 157
AutoArchive button, 138, 139
AutoArchive dialog box, 30, 139–140
AutoDialer option, Contacts, 303, 304
Automatic Formatting command, 218
Automatic Formatting dialog box, 218
Automatically Accept Meeting Request And
Process Cancellations check box, 185
Automatically Decline Conflicting Meeting
Requests check box, 186
Automatically Decline Recurring Meeting
Requests check box, 186
Automatically Record These Items list box,
211, 312
Automatically Starts Windows Media With
Reminder check box, 189
automation
archiving, 39
backing up, 40–42
call, 33–35
data management, 39–42
fax, 36–37
integrating communication, 37–38
synchronizing, 39
AutoMergeField, 249
AutoPick Next button, 180, 183, 289
Available Fields list, 65, 112, 208
Avanquest (Phone Tools), 276, 277

• B •
Backup Options dialog box, 41
Backup The File Selected Above To This
Location option, 196
Backup These Personal Folders Files
option, 41
Backup tool
Backup The File Selected Above To This
Location option, 196
creating file with, 40–42
downloading, 40
installing, 40
uploading information with, 196
B2B (Business To Business) customer, 99–100
B2C (Business To Consumer) customer, 99–100
bcc e-mail, 281
BCM. See Business Contact Manager
BlackBerry, 83, 195
Blocked Senders list, 30, 136
broadcasting e-mails, 250, 273–274, 281
Business button, 300, 301
business cards, scanning, 48
Business Contact form
  as alternative to Outlook Contacts, 83
  Business Contact History area, 88
Contact Preferences area, 88
description, 84
Details tab, 88–89
duplicate information with Account form, 85
entering information, 88–89
Opportunity form linkages, 82
Business Contact History area, Business Contact form, 88
Business Contact Manager (BCM)
  account information, 83, 85–87
  business contacts, 84, 88–89
  Business Services, 250
description, 81–83
direct-mail marketing and, 240, 241
disappearing commands, 84
downloading update, 82
E-Mail Marketing, 250
following up on proposal, 234–235
installing, 82
integration, 117
limitations, 96–98
mapping client location, 225–226
opportunities, 84, 90–92, 96
for Pocket PC, 83
Product And Service Items list, 84, 92–96, 97
updating, 82
using to prospect a new customer, 231–235
value of, 114
view options, 110–113
Business Contact Manager (BCM) reports
  Accounts by Category, 101
  Accounts by Rating, 100–101
  Accounts by Status, 100, 107–109
  Accounts History, 102
  Accounts List with Business Contacts, 102
  Accounts Neglected, 101
  Business Contacts by Category, 102
  Business Contacts by Rating, 102
  Business Contacts by Status, 102
  Business Contacts History, 102–103
  Business Contacts Neglected, 102
  Business Contacts phone list, 102
  Business Tasks, 105
in Excel, 114–117
filtering, 109–110
Modify Report dialog box, 107–108
Opportunity by Product and Service, 105, 109–110
Opportunity Forecast, 105, 106
Opportunity Funnel, 105, 106, 110–111
Past Due Opportunities, 105
Quick Accounts List, 102
refining, 107–109
saving formats, 108, 114
Source of Leads, 104
value of, 114
views, using, 110–113
Business Contacts by Category report, 102
Business Contacts by Rating report, 102
Business Contacts by Status report, 102
Business Contacts History report, 102–103
Business Contacts Neglected report, 102
Business Contacts phone list report, 102
Business Data Import And Export Wizard, 117
Business Note, 86, 231
business opportunities, tracking, 90–92
Business Services, Business Contact Manager (BCM), 250
Business Tasks report, 105
Business To Business (B2B) customer, 99–100
Business To Consumer (B2C) customer, 99–100
Business Tools button, 88, 94, 100, 102, 104
buttons, for form design, 70–72
Calendar
Appointments view, 19, 20
for collaborating on time commitments, 288–291
creating an appointment entry, 285–287
creating an recurring appointment, 287–288
Events list, 19, 20
invitations, 145–146, 154
Month view, 21
One Day view, 18
organizing with, 17–21
permissions, 290–291
publishing on family home computer, 200–201
publishing online, 201
reminders, 18, 19
time zone coordination, 197–198
view options, 18–21, 291
viewing Tasks list with, 27–28
Calendar By Categories, 176
Calendar Options dialog box
Add Holidays button, 202
Free/Busy Options, 182
Meeting Room Calendar Options, 185
Planner Options button, 181
Time Zone button, 197
Calendar Properties dialog box, 157, 158
Calendar Title area, 201
call automation, 33–35
Call Contact option, 34
Call Date field, 208
Call (flag option), 208
Call Status line, 35
Captions font, 75
card scanner, 48
categories
Accounts by Category report, 101
Business Contacts by Category report, 102
creating, 67–68
customer, 67–68, 206
meeting, 176–178
Categories button
Account form, 86
Appointment form, 177, 287
Contacts, General page, 67, 301
Tasks list, 229, 287
Categories dialog box, 67, 163, 177
Categories list
appointment classification, 287
default list, 54
selecting categories, 56, 219
cc e-mail, 123, 124, 281
cell phone
password protection, 276
protecting contacts, 277
receiving Outlook messages on, 221
receiving reminders on, 275–276
turning off during meeting, 187
use abroad, 193
Change Password option, 276
Change The Document Layout option, 246
Chart Wizard, 115
charts, designing BCM with Excel, 114–116
Check Address dialog box, 301
Check Full Name dialog box, 299
Check Messages When They Arrive option, 219
Check Phone Number dialog box, 300
CheckBox button, 70
checklist
building from customer perspective, 272
Day After, 252
Mailing Form, 240–241
meeting, developing, 179
travel, developing, 191–192
Choose A File dialog box, 210
Choose A Folder dialog box, 129
Choose Folders button, 17
Choose profile dialog box, 242
clients. See also customers
keeping, 205–212
mapping location, 225–226
Close Date field, Opportunity form, 90, 233
collaborative tools
agreement management, 144, 151–154
delegation, 145, 156–157
SharePoint server, 147–151, 159, 199
sharing, 145, 157–160
supervising, 154–155
value of, 11
coloring messages, 216–218
columns, aligning, 77
ComboBox button, 70
comma delimited files, 50
comma separated values (.CSV), 94
CommandButton, 70
commitment
  Accept or Decline buttons, 145
  letter of understanding, 269
  meeting, 290
time, 13, 259–265
to-do, 14
communication, integrating, 37–38
company information database, 64
company profile
description, 62
developing your own, 64
researching, 63–64
for sales, 65–66
Competitors field, Opportunity form, 91
completion time, estimating, 24–25
Condition button, 218
Condition list box, 248
Confidential (message option), 31
confirmation list, 184
confirmation requests, 165
contact
  automatic links to, 211
  frequency, scheduling, 206–207
  linking an item to, 210
  plan, 206
Contact form
  building customer sales profile, 72–77
cleaning up standard, 73
default, 78
fields, 72–73
frames, 74–77
opening, 70
publishing, 77
toolbox buttons, 70–71
Contact Picture dialog box, 301
Contact Preferences dialog box, 78
Contact Properties dialog box, 78
Contacts
  Actions drop-down menu, 303–305
  Activities page, 212, 302, 310–313
  adding picture to, 301
  Address Cards view, 58
  All Fields tab, 264
categories, 54–56, 67–68
coloring messages, 216–218
company profile, 62–66
compatible files, 48–49
creation new, 53–56
custom fields, 59–60
customer profile, 62, 64–65
customers, categorizing, 67–68
details, 56–58, 302, 303
Display Map of Address option, 303, 304
displaying, 304
fields sequence, 61
flagging for follow-up, 303–304
follow-up flag, 207
Follow Up option, 208, 303, 304
importing from existing files, 48–52
linking appointment to, 287
linking related, 54
list as customers and suppliers
database, 162
little black book compared, 52
New Distribution List option, 305
New Letter to Contact option, 305
New Message to Contact option, 303
noncompatible files, 50–52
personal information, adding, 48
Phone list view, 58–59, 61, 66
photos, 54
printing, 307
Private button, 55
profiles, 62–66
protecting cell phone, 277
views, 58–59
ways of using, 47–48
Contacts button
  Appointment form, 199, 287
  Contacts, General page, 301
  Navigation page, 49, 52–53, 299
  Navigation pane, 34
  Tasks, 229, 295
Contacts Folder, 242, 246
Contacts, General page
Address Book icon, 301
Business button, 300
Categories button, 301
Company field, 300
Contacts button, 301
e-mail field, 301
File As list box, 300
Full Name button, 299
IM Address field, 301
Job Title field, 299
Phone Numbers area, 300
Web Page Address field, 301
Contacts list
By Category, 244, 253
customizing by category, 213–214
merging for direct-mail marketing, 241–248
Miscellaneous Fields, 264–265
New button, 264
Phone List view, 253
synchronizing phone contacts with, 277
Telemarketing forms, 254
Control panel, Windows, 36, 37
Copy View dialog box, 26, 254
copying file message, 42
Create New Folder dialog box, 127
Create New Journal Entry When Starting New Call option, 34
Create Signature dialog box, 306
Create Your Own command, 233
.CSV (comma separated values), 94
cultures, identifying meeting, 176
Current View dialog box, 18
Custom View Organizer, 21, 26, 254
customer profile
building with forms, 69–79
description, 62
developing your own, 64–65
loading new, 223–225
customer support, organizing, 168–169
customers
BCM account information, 85–87
BCM business contact information, 88–89
Business To Business (B2B), 99–100
Business To Consumer (B2C), 99–100
categorizing, 9, 67–68, 206
classifying messages from, 216–220
contact frequency, scheduling, 206–207
contact plan, 206
events, planning, 250–253
financial information, 86
flagging a contact, 208–209
forgotten, 68, 101, 102
hidden, 68
history, recording and reading, 230
information, 223–225, 231
keeping, 205–212
keeping tabs on, 268–269
knowing your audience, 237–238
linking appointment to account, 231–232
mapping location, 225–226
proposal, following up on, 229–230
proposal, sending, 228–229
quotes, analysis of, 215–216
receiving messages on cell phone, 221
relationships with, developing, 9, 10
requests, working on, 226–230, 232–233
sales targets, creating, 213–215
tracking history, 209–212
uniform customers and suppliers list, creating, 161–163
using BCM to prospect new, 231–235
vision of, understanding, 268
Customize Current View By Category dialog box, 177
Customize Current View By Company dialog box, 248
Customize Current View option, 27, 61, 112, 213, 248
Customize Fields dialog box, 213
Customize Outlook Today screen, 16–17
Customize View dialog box
Fields button, 208
Filter button, 271
Customize View Phone List, 59, 61, 65
data protection, 276
database
  company information, 64
  Microsoft Accounting 2006, 117
  sharing, 98
  uniform customers and suppliers list, 161–163
Day After checklist, 252
Decision Maker field, Show Fields dialog box, 61
Decline button, 145, 152–153, 183, 297
Default Reminder option, 183–184
Delegate Permissions, 156–157
delegation, 145, 156–157, 262
deleted item, recovering, 278–279
Deleted Items folder, 139
Design Form dialog box, 70, 73
designating a task, 28–29
Detailed Tasks list, 153
details page, Contacts, 56, 302, 303
details tab
  Account form, 86–87
  Business Contact form, 88–89
  Task form, 25
dialup connection, travel and, 192
Direct Inward Dial (DID), 38
direct-mail marketing
  audience, selecting, 239–240
  balancing with e-mail campaigns, 273–274
  content, planning, 239
  feedback, selecting, 240–241
  history of, 238
  labeling the mailing, 245–247
  merging all contacts with letter, 242–243
  merging selected contacts with letter, 243–245
  planning, 238–241
  printing, 241–245
Disabled Items button, 84
Display Map of Address option, Contacts, 303, 304
Do Not Forward option, 279, 280
Do Not Import Duplicate Items option, 49, 50
Document library, 149
Double-Clicking A Journal Entry area, 211
Download Wizard, 40
downloading
  Business Contact Manager updates, 82
  Outlook add-in tool, 40
  Rights Management add-in, 280
  your memory, 13–14
Due By list box, 208, 229
Dun & Bradstreet (company information database), 64
Duration field, Show Fields dialog box, 177–178
Edit Signature dialog box, 306
Editor (permission level), 157, 262
e-mail. See also messages
  archiving, 30, 136, 138–140
  art of sending, 133–134
  attaching previous messages, 131–132
  behaviors of senders, 123–124
  Blocked Senders list, 30, 136
  broadcasting e-mails, 250, 273–274, 281
  cc messages, 123, 124, 281
  classifying messages, 125
  confirmation request, 165
  emptying Deleted Items folder, 139
  flagging, 163–165
  folder, creating, 127–128
  Inbox management, 132–133
  inserting a follow-up reminder in, 229
  junk, 122, 136–137
  Mailbox Cleanup, 138
  marketing, 249–250
  options, 30
  organizing, 30–31, 126
  phishing, 140–141
  proposal, 228–229
  protecting addressee’s mail address, 281
  read receipt, 134
  rule, creating, 128–131
e-mail (continued)
- Safe Recipients list, 136
- Safe Senders list, 136–137
- sending from Contacts page, 304
- Sent Items folder, 136
- task request, 297
- tips, 145–146
- tracking, 167
- Unified Messages system, 37–38
- unwanted, 122–125
- using rules to eliminate, 127–131
- vCard, 162, 305–306
- voting, 165–167

E-Mail Marketing, Business Contact Manager (BCM), 250
- E-Mail Options button, 131, 263
- E-Mail Options dialog box, 132
- End date dialog box, 200
- Enterprise Resource Planning (ERP) systems, 7–8, 50
- Entry Type list box, 224
- e-office cleaner, 138–140
- evaluation form, 173–174
- event
  - content, 250–251
  - convincing customers to come, 251
  - Day After checklist, 252
  - following up on, 252–253
  - Guest Material and Printing Worksheet, 251
  - mingling during, 252
  - name badges, 251, 252
  - planning, 250–253
  - sales and marketing tips, 272–273
- Event Address field, 189
- Event Planner Worksheet, 251

Excel
- comma separated values, 94
- designing BCM charts with, 114–116
- importing files, 50, 51
- saving BCM reports in Excel format, 108, 114
- telemarketing report, 256
- workbook for passwords, 278
- Exchange server, 159, 194–195

Exclude This Recipient button, 246
- Expected Revenue field, Opportunities list, 90
- expiration dates, remembering, 196–197

• F •

- family, keeping in contact with, 199–201
- fax, 36–37, 38
- Fax icon, 36
- Fax Wizard, 36, 37
- feedback, direct-mail marketing, 240–241
- Field Chooser, 72, 169
- fields
  - creating custom, 59–60
  - creating in Task form, 169
  - for customer sales profile form, 72–73
  - inserting into frames, 75–77
  - sequence, 61
  - splitting into categories, 74–75
- Fields button
  - Customize Current View By Category dialog box, 177
  - Customize View dialog box, 112, 208, 214
  - Customize View Phone List dialog box, 59, 61, 65
- Filter dialog box, 248
- Fields to Merge option, 245
- File command, Account History list, 86
- files
  - importing to Outlook Contacts, 48–52
  - inserting, 230
  - opening shared, 159
- filter
  - customer base for marketing purposes, 271
- junk e-mail, 30, 137
- messages, 218
- reports, 107–110
- selecting customers for direct-mail marketing, 248–249
- Filter button, 59, 248, 271
- Filter dialog box, 218, 248, 271
- Find button, 138
- Finish Rule Setup dialog box, 130
Flag button, 163, 228
Flag To list box, 208, 229
Flag wizard, 163–164
flagging
  a contact, 208–209
  contacts for follow-up, 303–304
  as a reminder, 235
  request, 163–165
folder
  creating, 127–128
  opening shared, 263
  sharing, 263
Folder Size dialog box, 196
Follow Up (flag option), 208, 235, 254
Follow Up option, Contacts, 208, 303, 304
Font button, 75
For These Contacts list box, 211
Form library, 168
forms. See also specific forms
  building customer sales profile, 72–77
  cleaning up standard, 73
  default, 78
  fields, 72–73
  frames, 74–77
  opening, 70
  publishing, 77
  toolbox buttons, 70–71
Forward As vCard option, Contacts, 305
Frame button, 70, 74
Frame Properties dialog box, 74–75
frames
  creating in Contact form, 74–75
  creating in Task form, 169
  inserting fields into, 75–77
Free/Busy scheduling, 172, 182–183, 288–289
Full Name button/field, 61, 299

• G •
Get Data button, 247
Get Directions button, 225
goals
  business, 11
  planning, 14
  recording as tasks with reminders, 260
  sales, 213
Gold (customer category), 206
Google (search engine), 224
Greeting Line Wizard, 243
Group Schedule dialog box, 172
Guest Material and Printing Worksheet, 251

• H •
Help, 38, 63, 84
history
  Accounts History report, 102
  Business Contact History report, 102–103
  tracking customer, 209–212
holidays, adding foreign to Outlook, 202

• I •
icons, used in text, 4
Image button, 71
Import A File Wizard, 49, 50
Import And Export Wizard, 48–50, 117, 316
Import button, 94
Import Product And Service Items Wizard, 94
importing
  compatible files, 48–49
  contacts from existing files, 48–52
  Excel files, 50, 51
  Internet Mail account settings, 316
  mail folders, 316–317
  noncompatible files, 50–52
  product and service items list, 93–95
Inbox
  cleaning, 30
  fax in, 38
  management, 132–133
Inbox Properties dialog box, 194–195
Include Appointment Details check box, 200
innovation, 10–11
Insert Address Block dialog box, 242, 246
Insert button, 228
inserting files, 230
Instant Messaging, 189
integrating communication, 37–38
internal support, requesting, 227–228
Internet Explorer, 63, 268, 280
Internet Options dialog box, 317–318
invitation
agenda forms, 187
Calendar, 145–146, 154
confirmation list, 184
finalizing time, 183–184
for online training or conferences, 189
opening, 189
scheduling meeting, 181, 289–290
tracking, 184
Invitation form
Accept button, 183
Date, Time, and Place, 179
Decline button, 183
Equipment required, 179
Guest confirmation, 179
Guest Invitation, 179
Meeting Workspace button, 149
opening, 181
Propose New Time button, 183
Requirements, 179
Send button, 181
Subject, 179
Tentative button, 183
Invite Attendee button, 154, 189, 289
iPod, 196
item
deleted, recovering, 278–279
disabled, 84
linking automatically, 211, 311–312
linking to contact manually, 210, 310–311
John Wayne rule, 277
Journal
contact history, creating, 310–311
description, 309–310
time form, 34, 224
linking items automatically, 311–312
linking items to contact manually, 310–311
linking Microsoft Office files to, 313
note, 224–225, 269
retrieving, 313–314
viewing by contact, 313
views, 313–314
Journal button, navigation pane, 314
Journal Entry form
Entry Type list box, 224
Phone Call, 34
Subject, 224
Journal Options dialog box, 211, 312, 313
junk e-mail, 122, 136–137
Junk E-Mail filter, 30
Junk E-Mail Options dialog box, 137
Keep An Updated Copy Of This Task On My Tasks List option, 28, 228
Label button, 70
Label list box, Appointment form, 286–287
Label Options dialog box, 246, 247
labeling
direct-mail marketing, 245–247
Time Zone, 197–198
LAN connection, travel and, 192
leadership, 144
letter of understanding, 269
Letters And Mailing option, 242, 245, 247, 249
life balance, 42–43
Link Button, 150
Link command, 305
Link File dialog box, 96, 234
Link Items To Contact dialog box, 210, 311
Link To An Existing Workspace option, 150
Link To field, Opportunity form, 90
linking
appointment to prospect account, 231
items automatically, 211, 310–311
items to contact manually, 210, 310–311
Microsoft Office files to Journal, 313
opening a linked document, 212
proposal to a Task, 229–230
proposals, 95–96
retrieving linked information, 311
to track customer history, 210
ListBox button, 70
Listbuilder service, Microsoft, 117

• M •

Mail button, Navigation Pane, 260
Mail command, 15
Mail Format list box, 250
Mail Format page, 306
Mail Merge Helper, 247
Mail Merge option, 242, 244, 245, 247, 249
Mail Merge Recipients dialog box, 242,
244, 246
Mail Merge Task pane, 247
Mail Merge toolbar, 249
Mail Message command, 235
mailbox
  cleaning Inbox, 30, 138, 196
  organizing, 30–31
Mailbox Cleanup, 30, 138, 196
Mailing Form Checklist, 240–241
Manage Attendees, 148
Map Custom Fields dialog box, 50–52
mapping client location, 225–226
marketing
  content, 239
  description, 10
  direct-mail, 238–249
  e-mail, 249–250
  knowing your audience, 237–238
  messages, 123
  planning events, 250–253
  telemarketing, 253
Master Category List button, 55, 67–68, 177
Master Category Wizard, 55
medicine, reminder for, 43
meeting
  agenda, 187
  categories, 176–178
  checklist, developing, 179
  commitment, 290
  confirmation list, 184
  finalizing time for, 183–184
  identifying meeting cultures, 176
  invitation, 289–290
  mapping client location, 225–226
  preparing for, 178–179
  reserving resources, 185–186
  scheduling, 179–185
  time zone, 176
  tracking form, 188
  video and Web conferences, 189
Meeting Room Calendar Options dialog box, 185
Meeting Workspace button, 149
Merge To E-Mail dialog box, 249
Merge To list box, 245, 247
Merge To Printer dialog box, 243, 246
merging
  all contacts with letter, 242–243
  selected contacts with letter, 243–245
Message Options dialog box
  Request A Read Receipt Of This Message checkbox, 165
  Use Voting Buttons check box, 166
messages
  anti-spam filters, 122
  archiving, 30
  art of sending, 133–134
  attaching previous, 131–132
  behaviors of senders, 123–124
  broadcasting, 250, 273–274, 281
  classifying, 125, 216–220
  coloring, 216–218
  deleted item, recovering, 278–279
  e-mail cleanup, 135–140
  filtering, 218
  folder, creating, 127–128
  Inbox management, 132–133
  mailbox, organizing, 30–31
  marketing, 123
  options, 30
  organizing, 126
  prioritizing, 278
  protecting addressee’s mail address, 281
  read receipt, 134
messages (continued)
with restricted reading permission, 279–280
rule, creating, 128–131
selecting arriving messages by subject, 218–220
sending, 31
sensitivity, 31
SMS, 221
in Tasks list, 133
Unified Messages system, 37–38
unsolicited, 122
wanted, classifying, 125
why people send, 121–125
Microsoft Accounting 2006 database, 117
Microsoft Active Sync, 83
Microsoft Fax console, 36, 37
Microsoft IRM service, 279
Microsoft Listbuilder service, 117
Microsoft MarketPlace (Web site), 159, 194
Microsoft Office Online, 187
Microsoft Small Business Accounting, 92
Microsoft Small Business Web site, 117
mi8.com (Web site), 159, 194, 195
Mobile Phone Tools (Avanquest), 276, 277
Modify Report button, 107, 109
Modify Report dialog box, 107–108
Move Message From Someone To A Folder option, 129
Move To The Specified Folder option, 129
MP3 devices, 196
MS Office Online (Web site), 173, 194, 239
MSN Map site, 304
MSN Maps & Directions site, 225, 226
MSN .NET Passport, 279, 280
MSN.com (Web site), 159
MultiPage button, 71
My Calendars window, 157
My Tasks window, 229

name badges, 251, 252
Name button, 155
Name Of New View text box, 26, 254
neglected customers, 101, 102
negotiation, 144
.NET Passport, 279, 280
New Account form, 231, 232
New button, Calendar, 189
New Call dialog box, 34
New Category text box, 55, 67, 177
New Contact From Same Company option, Contacts, 305
New Distribution List option, Contacts, 305
New Field button, 59, 65, 208, 214
New Field dialog box, 59–60, 214
New Folders tab, Ways To Organize Inbox dialog box, 126
New Journal Entry For Contacts option, 224, 269
New Journal Entry option, Contacts, 305
New Letter To Contact option, Contacts, 305
New Message to Contact option, Contacts, 303
New Rule button, 128, 219, 221
New vCard From Contact button, 306
Note, Outlook, 195–196
note taking, meeting, 186
Notes button, Navigation pane, 196
Notify Me When New Messages Arrive option, 263
Number list box, 34

objective, business, 11
OCR (Optical Character Recognition) software, 48
offline folders, 39, 194
OMA (Outlook Mobile Access), 195–196
One Day Calendar view, 17–18
Online meeting setup, 189–190
Open A Shared Calendar dialog box, 291
Open Other User’s dialog box, 263
Open Other User’s Folder dialog box, 155, 159
Open Outlook Data File list box, 42
Opens The Item Referred To By The Journal Entry option, 211

Opportunities list
- Expected Revenue field, 90
  using to control prospects, 215
Opportunity by Product and Service report, 105, 109–110
Opportunity command, Account History list, 86
Opportunity Forecast report, 105, 106
Opportunity form
  as alternative to Tasks, 83
Close Date field, 90, 233
Competitors field, 91, 233
completing, 90–91
description, 84
Initiated By field, 91
Link To field, 90
linkage to Account form, 82
linkage to Business Contact, 82
Opportunity Title text box, 90, 232
Probability field, 90, 233
Product And Service Items, 91
Sales Stage field, 90
Source of Lead field, 91
Status area, 90
for tracking business opportunities, 90–92
updating, 234
Opportunity Funnel report, 105, 106, 110–111
Opportunity History, 233
Opportunity History Items list, 91, 233, 234
Opportunity Title text box, 90, 232
Optical Character Recognition (OCR) software, 48
OptionButton, 70
Options button, e-mail, 31
Options dialog box
  AutoArchive button, 139
  Calendar Options button, 202
  Default Reminder, 184
  Delegates tab, 156
  E-Mail Options button, 131, 263
e-Office Cleaner options, 139
  Journal Options, 211
  Mail Format tab, 305–306
  Other tab, 139
  Security tab, 278
Oracle, 8
organization
  Calendar, 17–21
  messaging, 29–31
  Outlook Today, 15–17
  Tasks list, 21–29
Organize Pane, 30, 216–218
Other User’s Folder option, 263
Outlook Data File, 39–40, 42, 194, 196, 276
Outlook Express
  changing default mail system, 317–318
  copying data from another PC, 318
  importing Internet Mail account settings, 316
  importing mail folders, 316–317
  moving to Outlook 2003, 315–318
Outlook Mobile Access (OMA), 195–196
Outlook Research, 63
Outlook Today
  commitments listed in, 260
  customizing, 16–17
  opening, 15
Outlook Web Access (OWA), 194–195
overdue accounts
  Accounts by Status report, 100, 107–109
  Business Contacts by Status report, 102

Palm OS devices, 195
Palm Pilot, 83
password, 276, 278
Password To Open text box, 278
Past Due Opportunities report, 105
Peachtree, 8
performance, measuring, 269–270
Permission in Calendar Properties dialog box, 290–291
Permission Level, 157, 262, 291
Permission List, 262
permissions
  Calendar, 290–291
deleagating, 156–157
  levels, 157–159, 262, 291
Personal Fields list, 58
Personal Folder Backup dialog box, 40–42, 196
Personal Folders command, 15, 260, 276
Personal Folders Properties dialog box, 276
personal information, adding to Contact profiles, 48
personal information management (PIM), 194
pfbackup.exe software, 40
phishing, 140–141
Phone Call Journal, 34, 35
phone calls
  autodialing phone calls, 303, 304
  follow-up, 252
  receiving Outlook messages on cell phones, 221
telemarketing, 253–256
turning cell phones off during meeting, 187
Phone list, Navigation page, 61
Phone list view, Contacts, 58–59, 61, 66
Phone Log command, Account History list, 86
Phone Tools (Avanquest), 276, 277
photo, contact, 54
picture, adding to Contacts, 54, 301
PIM (personal information management), 194
Place Chart option, 116
Planner Options dialog box, 181
planner, printing, 307
planning
  direct-mail marketing, 238–241
  events, 250–253
  productive meetings, 178–179
Platinum (customer category), 206
Pocket PC, 83, 195, 276
preparation, for meetings, 178–179
presentations, tips for, 272–273
Primary Business Contact area, Account form, 85–86
Primary Contact field, 86
Print dialog box, 36
Printer and faxes folder, 36, 37
Printers And Fax devices list, 36
printing
  Contacts, 307
direct-mail marketing, 241–245
  name badges, 251, 252
  reminder list, 13
priorities, organizing, 21–23, 261
prioritizing messages, 278
Priority button, 22–23
Private button, 55
Probability field, Opportunity form, 90
procurement, 12
Product And Service Items List
  accessing, 92
  Add Or Edit dialog box, 93
  adding to, 91, 93
  description, 84
  importing an existing list, 93–95
  limitations, 97–98
  linking proposal, 95–96
  Opportunity value in, 233
  uses of, 82
profile
  building with forms, 69–79
  creating for sales, 65–66
  description, 62
  developing your own, 64–65
  researching, 63–64
  projects, managing, 169–171
Properties dialog box, 74
proposal
  following up on, 229–230, 234–235
  linking, 95–96
  sending, 228–229
Proposal category, 214, 219
Propose New Time button, 183
prospects, 231–235
Publish at my location check box, 182
Publish button, 77, 169
Publish Form dialog box, 77
publishing a profile form, 77
Quick Accounts List report, 102
QuickBooks, 117
quick-learning program, 146
quotes, analyzing to help close orders, 215–216

rating
Accounts by Rating report, 100–101
Business Contacts by Rating report, 102
read receipt, 134
Reader (permission level), 262
Reading Pane option, 255
reading permission, restricted, 279–280
Recently Modified view, 111
Recover Deleted Items option, 279
recovering deleted item, 278–279
Recurrence button, 288, 295
recurring appointment list, 21
setting up, 287–288
recurring Tasks, 207
Remember icon, 4
Remind Me To Backup Every X Days option, 41
reminder
alarm, 9, 11
for appointments, 287
for customer contact, 207, 208–209
for customer follow-up, 48
default option, 183–184
of expiration dates, 197
for financial and organizational control, 12
flagging as, 235
Follow Up option, Contacts, 303, 304
importance/value of, 9, 11
inserting a follow-up reminder in e-mail, 229
medicine, 43
new task as Task reminder, 235
printing list, 13
receiving on cell phone, 275–276
recurring, 12
for sales and fulfillment activities, 12
setting up, 184
as SMS messages, 221
sound selection, 287, 295
subfolders and, 173
synchronizing, 13, 276
for taking a break, 261
for tasks, 18, 19, 295
time, 23, 208, 209
Reminder Selection Box, 235
Reminder Sound selection box, 287
Replace Existing List With Items In This File option, 94
report
Accounts by Category, 101
Accounts by Rating, 100–101
Accounts by Status, 100, 107–109
Accounts History, 102
Accounts List with Business Contacts, 102
Accounts Neglected, 101
Business Contacts by Category, 102
Business Contacts by Rating, 102
Business Contacts by Status, 102
Business Contacts History, 102–103
Business Contacts Neglected, 102
Business Contacts phone list, 102
Business Tasks, 105
filtering, 109–110
Modify Report dialog box, 107–108
Opportunity by Product and Service, 105, 109–110
Opportunity Forecast, 105, 106
Opportunity Funnel, 105, 106, 110–111
Past Due Opportunities, 105
Quick Accounts List, 102
refining, 107–109
Source of Leads, 104
telemarketing, 256
request
e-mail confirmation, 165
flagging, 163–165
request (continued)
   for internal support, 227–228
   Task, 261, 296–297
   using BCM, 232–233
   working on customer’s, 226–230, 232–233
Request A Read Receipt Of This Message
   check box, 165
reserving resources, 185–186
Reset Current View command, 27
Resource Scheduling dialog box, 185
resources, reserving, 185–186
restricted reading permission, 279–280
retirement plan, 43
Reviewer (permission level), 157
Rights Management add-in, 279, 280
RS Outlook, 209, 276
rsoutlook.com (Web site), 221, 276
rules
   agreement, 152–154
   creating e-mail, 128
Rules And Alerts dialog box, 128, 131, 220
Rules For This View list box, 218
Rules Wizard, 30, 126, 128–130, 219, 221
Run This Rule Now On Messages Already
   In “Inbox” check box, 130

S
Safe Recipients list, 136
Safe Senders list, 136–137
sales
   keeping a client, 205–212
   Outlook help with, 10
   prospects, 231–235
   quotes, analyzing, 215–216
   targets, creating, 213–215
   tracking customer history, 209–212
Sales Stage field, Opportunity form, 90
sales tips
   balancing mail and e-mail campaigns, 273–274
   checklist, building from customer
   perspective, 272
   customer’s vision, understanding, 268
   events and presentations, maximizing, 272–273
   keeping tabs on customers, 268–269
   letter of understanding, 269
   marketing productivity, increasing, 270
   performance, measuring, 269–270
   questions for brainstorming, 267
   target markets, working with, 270–271
   tracking opportunities with tasks, 268
   SAP, 8
Save as Web Page dialog box, 200
Save Backup button, 196
scanning business cards, 48
scheduling
   customer contact frequency, 206–207
   meetings, 179–185
   reserving resources, 185–186
   Scheduling tab, Appointment form, 180–181, 288–290
   script, telemarketing, 255–256
ScrolBar button, 71
search engines, 224
Search For A Download text box, 40
Search Text dialog box, 219
Searching For The Words text box, 218
security
   cell phone contacts, protecting, 277
   data protection, 276
   password, 276, 278
   protecting addressee’s mail address, 281
   restricted reading permission, 279–280
   training as protection tool, 277
Select Action(s) List, 219
Select Available Fields From list box, 26, 112, 208
Select Contact Folder list, 242, 246
Select contacts dialog box, 199
Select Enterprise Form dialog box, 112
Select From Outlook Contacts option, 242
Select Objects button, 70
Select When Messages Should Be Checked
   options, 219
Select Where To Place The Folder list, 128
Selected Destination Folder list, 49, 50
Index

Send An Alert To My Mobile Device When I Get Messages From Someone option, 221
Send E-mail (flag option), 208
Send Fax Wizard, 37
Send Letter (flag option), 208
Send Me A Status Report When The Task Is Complete option, 28
Send Me A Status Report When This Is Complete option, 228
Sensitivity list box, 31
Sent Items folder, 136, 229
Service Sign Up wizard, 279–280
Set Permissions button, 186
Setup button, 247
Share My Calendar option, 157
SharePoint server, 147–151, 159, 199
sharepointtrial.com (Web site), 147
sharing
database, 98
folders, 263
Outlook properties, 145
permissions, 262
Tasks, 157, 262, 298
tool service suppliers, 159
Sharing Wizard, 98
Short Messages Service (SMS), 221, 275–276
Show An Additional Time Zone check box, 197
Show Fields dialog box
Business Contacts Entry Form fields, 112
Decision Maker field, 61
Duration field, 177–178
New Field button, 59, 214
Select Available Fields From list box, 26, 112
Show List list box, 230
Show Mail Merge Toolbar, 249
Show Names From The list box, 262
Show These Fields box, 26
Show These Fields In This Order list, 65, 208, 214
Signatures button, 306
Silver (customer category), 206
Sites And Workspaces hyperlink, 148
Smartphone, 83, 195
SMS (Short Messages Service), 221, 275–276
Sort button, 59
sounds, reminder, 287, 295
Source of Lead field
BCM Recently Modified view, 112–113
Opportunity form, 91
Source of Leads report, 104
Specify A Name For This Rule text box, 220
Specify Words Or Phrases To Search For text box, 219
Sperry software (Web site), 276
SpinButton, 71
Standard (customer category), 206
Start Call button, 35
Start Creating A Rule From A Template option, 129
Start date dialog box, 200
Start From A Blank Rule option, 219
Start Searching button, 63
Start Time date box, 224
State field, 248
supervising, 154–155, 261, 298
suppliers list, creating, 161–163
surveys, conducting, 165–167
Synchronization tab, 194–195
synchronizing
cell phone with tasks and calendar, 276
description, 39
offline folders and, 39
reminders, 276

T

Tab Separated Values (DOS) option, 50
table, adding to Task, 170–171
TabStrip button, 71
target markets, working with, 270–271
targets, creating sales, 213–215
Task button, 229, 293
Task command, Account History list, 86
Task form
- Categories button, 229, 295
- Contacts button, 229, 295
- customizing, 168–169
- Due date field, 23, 227, 230, 294
- Owner field, 295
- Priority list, 23, 227, 294
- Private check box, 295
- Start date field, 23, 294
- Status field, 227, 294
- Subject line, 227, 294
- Task Items list, 210
- Task Pane Wizard, 249
- Task Request, 261
- Taskpad, 27

Tasks
- accepting or declining, 152–153, 297
- adding table to, 170–171
- for assigning internal support, 227–228
- business goals and objectives, 11
- creating recurring, 207
- for customer support, 168–169
- customizing form, 168–169
- evaluation form, 173–174
- new, 197
- in Opportunity History Items list, 233
- for procurement activities, 12
- for remembering expiration dates, 197
- requesting, 296–297
- sharing, 298
- supervising, 298
- tracking opportunities with, 268
- updates, receiving, 297
- vacation requests, 174

Tasks folder, 262

Tasks list
- accepting a task, 29
- accessing, 16
- agreement management with, 152–154
- completion time, estimating, 24–25
- creating new, 293–295
- declining a task, 29
- designating tasks, 28–29
- Details page, 25
- displaying, 293
- messages in, 133

- organizing with, 21–29
- prioritizing, 21–23
- reminders, 23
- rules, 152–154
- saving a view, 26–27
- scheduling a task, 23
- selecting open proposals, 214
- sharing, 157, 262
- sorting, 152
- Start Date, 23
- supervising with, 29, 154–155
- Total Work field, 25
- viewing, 27
- viewing Calendar with, 27–28
- viewing fields, 25–26
- views, 261, 295–296
- Tasks List By Person Responsible, 154, 155
- Tasks View By Categories, 229

teamwork
- agreement management, 144, 151–154
- Calendar, promoting use of, 145–147
- Calendar, sharing, 171–172
- collaborative tools, 144–145, 151–160
- commitment, 145
- customer support, organizing, 168–169
- customers and suppliers list, creating uniform, 161–163
- delegation, 145, 156–157
- e-mail tips, 145–146
- evaluation form, 173–174
- leadership, 144
- maintaining team commitment, 143–145
- negotiation, 144
- projects, managing, 169–171
- quick-learning program, 146
- requests, following up on, 163–165
- SharePoint server, 147–151
- sharing, 145, 157–160
- supervising, 154–155
- surveys, conducting, 165–167
- vacation requests, 174
- Technical Stuff icon, 4
- technical support, 264–265
- telemarketing
- forms, 254
- report, 256
success, ensuring, 253–256
view title, creating, 254
telephone. See phone calls
Tentative button, 183
TextBox button, 70
This Folder, Visible To Everyone option, 254
This Is An Online Meeting Using box, 189
This Is The Mailing Address box, 301
Thomson Gale (company information database), 64
time commitments
boss-imposed, 261–263
description, 13
self-imposed, 259–261
system-imposed, 263–265
time perceptions, 176
time zone, 176, 197–198
Tip icon, 4
To Here command, 225
to-do commitments, 14
ToggleButton, 70
Total Work field, 25
tracking
business opportunities, 90–92, 268
customer history, 209–212
Tracking tab
e-mail, 167
invitation, 184
Traffic Sign button, 225
training
importance of, 144
online, 189
as protection tool, 277
travel
AC power, 192
Calendar appointments, 199
cell phone use abroad, 193
checklist, developing, 191–192
connecting through Outlook Mobile Access (OMA), 195–196
connecting through Outlook Web Access (OWA), 194–195
dialup connection, 192
expiration dates, remembering, 196–197
family contact and, 199–201
foreign holidays, adding to Outlook, 202
LAN connection, 192
opening files from memory card or CD-ROM, 193–194
publishing agenda on family home computer, 200–201
publishing agenda online, 201
time zone coordination, 197–198
wireless connection, 192
Traveldrive device, 196
Treo Smartphone, 195
Turn On This Rule check box, 130

• U •
Unified Messages system, 37–38
Untitled Contact dialog box, 53–54
updating an opportunity, 234
usability, 272
Use The Current Document option, 242
Use Voting Buttons check box, 166
Using Colors option, 217

• V •
vCard, 162, 305–306
Verify Password option, 276
video conferences, 189
View button, Calendar, 17
View Deleted Items Size button, 138
View Group Schedules command, 172
View Mailbox Size button, 138, 196
views, refining Business Contact Manager, 111–113
voice mail, 37–38
voting, e-mail, 165–167

• W •
vacation requests, 174
vCard, 162, 305–306
Waiting On Someone Else option, 227
Warning! icon, 4
Ways To Organize Inbox dialog box, 126, 128
Web conferences, 189
Web site
antiphishing.org, 141
Avanquest, 276, 277
Microsoft MarketPlace, 159, 194
Microsoft Small Business, 117
mi8.com, 159, 194
MS Office, 173, 194, 239
MSN Maps & Directions, 225, 226
MSN.com, 159
rsoutlook.com, 221, 276
sharepointtrial.com, 147
Sperry software, 276
When Posting To This Folder, Use list, 78
When Replying To A Message drop-down list, 131
Where My Name Is Not In The To Box option, 129
Windows Media Services, 189
Windows Rights Management (RM) Client, 279, 280
wireless connection, travel and, 192
Word
direct-mail marketing use, 242–243
telemarketing script, 255–256
Word Mail Merge Task pane, 245
Workspace Wizard, 149

Yahoo! (search engine), 224
### BUSINESS, CAREERS & PERSONAL FINANCE

**Also available:**
- Accounting For Dummies † 0-7645-5314-3
- Business Plans Kit For Dummies † 0-7645-5365-8
- Cover Letters For Dummies 0-7645-5224-4
- Frugal Living For Dummies 0-7645-5403-4
- Leadership For Dummies 0-7645-5176-0
- Managing For Dummies 0-7645-1771-6
- Marketing For Dummies 0-7645-5600-2
- Personal Finance For Dummies * 0-7645-2590-5
- Project Management For Dummies 0-7645-5283-X
- Resumes For Dummies † 0-7645-5471-9
- Selling For Dummies 0-7645-5363-1
- Small Business Kit For Dummies † 0-7645-5093-4

### HOME & BUSINESS COMPUTER BASICS

**Also available:**
- ACT! 6 For Dummies 0-7645-2645-6
- iLife '04 All-in-One Desk Reference For Dummies 0-7645-7347-0
- iPAQ For Dummies 0-7645-6769-1
- Mac OS X Panther Timesaving Techniques For Dummies 0-7645-5812-9
- Macs For Dummies 0-7645-5656-8
- Microsoft Money 2004 For Dummies 0-7645-4195-1
- Office 2003 All-in-One Desk Reference For Dummies 0-7645-3883-7
- Outlook 2003 For Dummies 0-7645-3759-8
- PCs For Dummies 0-7645-4074-2
- TiVo For Dummies 0-7645-6923-6
- Upgrading and Fixing PCs For Dummies 0-7645-1665-5
- Windows XP Timesaving Techniques For Dummies 0-7645-3748-2

### FOOD, HOME, GARDEN, HOBBIES, MUSIC & PETS

**Also available:**
- Bass Guitar For Dummies 0-7645-2487-9
- Diabetes Cookbook For Dummies 0-7645-5230-9
- Gardening For Dummies * 0-7645-5130-2
- Guitar For Dummies 0-7645-5106-X
- Holiday Decorating For Dummies 0-7645-2570-0
- Home Improvement All-in-One For Dummies 0-7645-5680-0
- Knitting For Dummies 0-7645-5395-X
- Piano For Dummies 0-7645-5105-1
- Puppies For Dummies 0-7645-5255-4
- Scrapbooking For Dummies 0-7645-7208-3
- Senior Dogs For Dummies 0-7645-5818-8
- Singing For Dummies 0-7645-2475-5
- 30-Minute Meals For Dummies 0-7645-2589-1

### INTERNET & DIGITAL MEDIA

**Also available:**
- 2005 Online Shopping Directory For Dummies 0-7645-7495-7
- CD & DVD Recording For Dummies 0-7645-5956-7
- eBay For Dummies 0-7645-5654-1
- Fighting Spam For Dummies 0-7645-5965-6
- Genealogy Online For Dummies 0-7645-5964-8
- Google For Dummies 0-7645-4420-9
- Home Recording For Musicians For Dummies 0-7645-1634-5
- The Internet For Dummies 0-7645-4173-0
- iPod & iTunes For Dummies 0-7645-7772-7
- Preventing Identity Theft For Dummies 0-7645-7336-5
- Pro Tools All-in-One Desk Reference For Dummies 0-7645-5714-9
- Roxio Easy Media Creator For Dummies 0-7645-7131-1

* Separate Canadian edition also available  
† Separate U.K. edition also available

Available wherever books are sold. For more information or to order direct: U.S. customers visit www.dummies.com or call 1-877-762-2974. U.K. customers visit www.wileyeurope.com or call 0800 243407. Canadian customers visit www.wiley.ca or call 1-800-567-4797.
## SPORTS, FITNESS, PARENTING, RELIGION & SPIRITUALITY

### Also available:
- Adoption For Dummies  
  0-7645-5488-3  
- Basketball For Dummies  
  0-7645-5248-1  
- The Bible For Dummies  
  0-7645-5296-1  
- Buddhism For Dummies  
  0-7645-5359-3  
- Catholicism For Dummies  
  0-7645-5391-7  
- Hockey For Dummies  
  0-7645-5228-7  
- Judaism For Dummies  
  0-7645-5299-6  
- Martial Arts For Dummies  
  0-7645-5358-5  
- Pilates For Dummies  
  0-7645-5397-6  
- Religion For Dummies  
  0-7645-5264-3  
- Teaching Kids to Read For Dummies  
  0-7645-4043-2  
- Weight Training For Dummies  
  0-7645-5168-X  
- Yoga For Dummies  
  0-7645-5117-5

### TRAVEL

### Also available:
- Alaska For Dummies  
  0-7645-1761-9  
- Arizona For Dummies  
  0-7645-6938-4  
- Cancun and the Yucatán For Dummies  
  0-7645-2437-2  
- Cruise Vacations For Dummies  
  0-7645-6941-4  
- Europe For Dummies  
  0-7645-5456-5  
- Ireland For Dummies  
  0-7645-5455-7  
- Las Vegas For Dummies  
  0-7645-5448-4  
- London For Dummies  
  0-7645-4277-X  
- New York City For Dummies  
  0-7645-6945-7  
- Paris For Dummies  
  0-7645-5494-8  
- RV Vacations For Dummies  
  0-7645-5443-3  
- Walt Disney World & Orlando For Dummies  
  0-7645-6943-0

### GRAPHICS, DESIGN & WEB DEVELOPMENT

### Also available:
- Adobe Acrobat 6 PDF For Dummies  
  0-7645-3760-1  
- Dreamweaver MX 2004 For Dummies  
  0-7645-4342-3  
- FrontPage 2003 For Dummies  
  0-7645-3882-9  
- HTML 4 For Dummies  
  0-7645-1995-6  
- Illustrator cs For Dummies  
  0-7645-4084-X  
- Macromedia Flash MX 2004 For Dummies  
  0-7645-4358-X  
- Photoshop 7 All-in-One Desk Reference For Dummies  
  0-7645-4277-X  
- Photoshop cs Timesaving Techniques For Dummies  
  0-7645-6782-9  
- PHP 5 For Dummies  
  0-7645-4166-8  
- PowerPoint 2003 For Dummies  
  0-7645-3908-6  
- QuarkXPress 6 For Dummies  
  0-7645-2593-X

### NETWORKING, SECURITY, PROGRAMMING & DATABASES

### Also available:
- A+ Certification For Dummies  
  0-7645-4187-0  
- Access 2003 All-in-One Desk Reference For Dummies  
  0-7645-3988-4  
- Beginning Programming For Dummies  
  0-7645-4997-9  
- C For Dummies  
  0-7645-7068-4  
- Firewalls For Dummies  
  0-7645-4048-3  
- Home Networking For Dummies  
  0-7645-42796  
- Network Security For Dummies  
  0-7645-1679-5  
- Networking For Dummies  
  0-7645-1677-9  
- TCP/IP For Dummies  
  0-7645-1760-0  
- VBA For Dummies  
  0-7645-3989-2  
- Wireless All-In-One Desk Reference For Dummies  
  0-7645-7496-5  
- Wireless Home Networking For Dummies  
  0-7645-3910-8
Do More with Dummies
Products for the Rest of Us!

From hobbies to health, discover a wide variety of fun products

DVDs/Videos • Music CDs • Games
Consumer Electronics • Software
Craft Kits • Culinary Kits • and More!

Check out the Dummies Specialty Shop at www.dummies.com for more information!